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1 Introduction

This Manual contains information on Network Analyzer remote control and its
data communication by means of user programs written with COM/DCOM
technology.

COM technology is used when a user program runs together with an external
measurement instrument program on one PC. DCOM technology is used when a
user program runs on a PC connected with the measurement instrument by LAN.

Methods and techniques for writing of user programs are same for the both
technologies. The only difference between the technologies is that the DCOM
technology requires additional LAN setting performed by the LAN administrator.

Before reading this Manual, familiarize yourself with Analyzer Operating Manual.

2 Scope of Manual

This programmer’'s manual covers the 2-port and 4-port models of the CMT
network analyzers listed below.

The 2-port network analyzers controlled by the S2VNA softwar are:
Planar 304/1

Planar 804/1

Planar 814/1

S5048

S5065

S5085

S7530

S5180

C1209

C1220

C2220

C2209

C4209

C4220

The 4-port network analyzers controlled by the S4VNA software are:
e Planar 808/1
e (1409
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o (1420
o (2409
o (4409

Except where specifically noted, all commands and descriptions apply across all
models covered by this document.

5 Registering COM Server

To register COM server of the analyzer run the executable module from command
prompt with the /regserver keyword. To unregister COM server of the analyzer run
the executable module from command prompt with the /unregserver keyword.
Administrative rights is required to register/unregister COM server. Also user has
ability to register COM server during the software installation procedure.

Example of the COM server registration command:

S2VNA.exe /regserver

S4VNA.exe /regserver

4 COM Technology Overview

COM stands for Component Object Model. This programming technology was
developed by Microsoft for two purposes:

e the model provides the specification for interaction of binary modules created
in different programming languages;

e the model defines the interfacing between a client application and a server
application running either on the same PC or on two different PCs. In the latter
case, the technology has DCOM abbreviation - Distributed COM.

5 Automation Server

The network analyzer executable module contains a built-in COM server that
enables other programs to access its functionality. The COM server was developed
in conformity with the COM automation specification. COM automation is a
technology allowing control over the COM server by the programs written in both
traditional compiling programming languages and interpreting programming
languages, such as VBScript. This enables the server applications to make their
functionality accessible to many more clients.
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6 Automation Controllers

Automation controllers are client programs, which use internal functionality of COM
servers. Automation controller programs are developed by users for writing their
own add-ons for the system.

User programs can be written in different languages:

e programming languages with built-in COM support, such as Visual Basic®,
Delphi, Java;

e universal programming languages, such as C, C++;

e Microsoft Excel and Word office applications as they include built-in
programming language Visual Basic for Applications®;

e program generators, such as National Instruments LabVIEW®, MathWorks
MATLAB®.

Examples written in VBA (Excel) , C++, MATLAB, Python, and other languages are
available at www.coppermountaintech.com; source code of examples are also
located in the Examples\COM\ folder of the application installation folder.

A Labview Driver is also included in the Labview subfolder of the Examples\COM\
folder, and can be downloaded separately from www.coppermountaintech.com.
The Labview Driver contains examples of its use.

7 Local and Remote Server

The network analyzer executable module can function either as a local server or as
a remote server of COM automation.

Local server runs on the same PC with the automation controller and each of the
programs is executed as an individual application in a separate window. COM
technology is used in this case (Figure 1).

Remote server and the automation controller run on different PCs connected by
LAN. DCOM (Distributed COM) technology is used in this case (Figure 2). When
using DCOM it is necessary to configure the local network by means of DCOM
Windows tools.

The same automation controller is used for the both COM and DCOM technology.
Some changes to the user program may be required in operators, which establish
connection with the server. Moreover, DCOM technology requires additional
settings of the LAN performed by the LAN administrator.
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S2VNA and S4VNA

User
Program

COM/DCOM Programming manual

S2VNA.exe
S4VNA.exe
Figure 1. COM technology
S2VNA.exe pcom _ User
S4VNAexe [[C~- 777777 *|  Program
USB Ethernet

Figure 2. DCOM technology
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8 Structure of COM Objects

COM server contains several objects, which provide different functionality of the
server. The COM objects of the network analyzer executable module are organized
in a hierarchical structure. Figure 3 shows the main COM objects, which comprise
the first three levels of the hierarchical structure of the COM server. COM objects
provide various methods and properties, which allow access to the server functions;
besides, they allow access to the objects of the lower levels, which are not shown
in Figure 3.

Application
SCPI

|

[ CALCulate ][ DISPlay ] [ IEEE4882 ][ INITiate ]

MMEMory ] SENSe ] [ STATus [ SOURce

(o) o] oo ) (e ) o

Figure 3. The structure of COM objects

The Object Application is in the top of the hierarchy of the COM server. Access to
the lower level objects is implemented via higher level objects.
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The hierarchy of COM objects and their names are
borrowed from the SCPlI command system, an alternative
remote control technology of the analyzer. Commands in

SCPI have a chain hierarchical structure, for example:
Note
CALCulate:PARameter:DEFine S11

The same command in COM is as follows:

app.SCPI.CALCulate.PARameter.DEFine = "S11"

9 Accessing the Application Object

To establish connection with the COM server application, create an object
reference in the client program. In COM programming the object reference needs
to be acquired preliminarily, to be used later to access the object functionality. To
define an object perform the following:

1) Declare a variable as an object.

2) Create a COM Object and assign it to this variable.

To declare a variable, use Dim operator or other declaration statement (Public,
Private or Static). The variables used for references should of the types Variant,
Object, or a type of a specific object. For example, the following three operators
declare app variable:

Dim app
Dim app as Object
Dim app as S2VNA.Application

Use Set operator and CreateObject (ObjectName, HostName) function to assign a
specific object to a variable.

ObjectName Object name is always equal to “S2VNA.Applcation” or
“S4VNA.Applcation”

HostName Network name of the PC hosting the COM server. This parameter is
not specified in case of a local server.

For example, the following operators create Application object and assign it to app
variable:

Set app = CreateObject("S2VNA.Applcation")

CreateObject("S2VNA.Applcation", "Analyzer Name")

Set app
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Set app = CreateObject("S2VNA.Applcation", "192.168.1.149")
Set app = CreateObject("S4VNA.Applcation")
Set app = CreateObject("S4VNA.Applcation"”, "Host_Name")
Set app = CreateObject("S4VNA.Applcation", "192.168.1.149")
The first form of the operator is used to create the
Note reference to the local COM server, the second and third

forms are used to create the reference to the remote DCOM
server.

To allow access to the objects of a lower level of the hierarchy, these objects are
specified after the reference to the higher level object and separated from it by a
dot. For example:

Dim SystObj
Set SystObj = app.SCPI.SYSTem

COM objects can have indices. For example, CALCulate, INITiate, SENSe, SOURce
objects represent various aspects of the 16 measurement channels of the
Analyzer. Therefore, it is necessary to write the channel index from 1 to 16 to
acquire the data of these objects. For example:

Set SensObjl
Set SensObj2

app.SCPI.SENSe(1)
app.SCPI.SENSe(2)

Visual Basic allows omitting of such indices; in this case the indices are considered
as equal to 1. For example, the following VB operators are equivalent:

Set SensObj
Set SensObj

app.SCPI.SENSe(1)
app.SCPI.SENSe

Note: The models of vector network analyzers working with the S2VNA executable
module share the same COM object. The name of COM object is S2ZVNA.Application

The models of vector network analyzers working with the S4VNA executable
module share the same COM object. The name of COM object is S4VNA.Application
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For example, the commands for creating a COM server for 2-port an analyzer is:
Set app = CreateObject("S2VNA.Applcation")

For the backward compatibility the old name is preserved for creating COM object
for each model. The user can use the old and new name of the COM object
interchangeably, since they all create the same COM object. For example: :

Set app = CreateObject("S2VNA.Applcation")
Set app = CreateObject("Planar3e4.Applcation")
Set app = CreateObject("Planar804.Applcation")
Set app = CreateObject("S5048.Applcation™)
Set app = CreateObject("S7530.Applcation™)
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10 Object Methods

Objects have methods. Methods are actions that can be applied to objects. The
object methods are specified after the object name and separated from it by a dot.

The following example shows the PRESet method of SYSTem object. This method
performs setting of the Analyzer to the preset condition:

app.SCPI.SYSTem.PRESet

11 Object Properties

Along with methods, objects have properties. Properties are object characteristics
that can be set or read out. The object properties are specified after the object
name and separated from it by a dot.

To modify an object characteristic, write the value of the corresponding property.
To define an object characteristic, read out the value of its property. The following
example show the setting of the POINts property of SWEep object, i.e. the number
of sweep points:

app.SCPI.SENSe.SWEp.POINts = 201

Some object properties cannot be written, and some object
Note properties cannot be read. In such cases, the properties are
indicated as “read only” or “write only”.
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12 Error Handling

You can use different approaches to error handling in VB program:

e check the value of Err.Number variable after execution of VB operator, which
contains the call to the COM server object;

e use On Error goto VB operator.

These approaches are represented in the examples below. The following operator
causes an error in VB program as "S13" value of the DEFine property is incorrect.

app.SCPI.PARameter.DEFine = "S13"

In the first example, the value of the Err.Number variable is checked after
execution of the VB operator, which contains the call to the COM server object. On
Error Resume Next directive instructs VB not to interrupt the program execution
when the error is detected but to pass control to the next operator in natural
order.

Dim app

Public Sub HandleErrorl()

Set app = CreateObject("S4VNA.Application")

On Error Resume Next

app.SCPI.PARameter.DEFine = "S13"

If Err.Number <> @ Then
Msg = "Error # " & Str(Err.Number) & " was generated by " &
Err.Source & Chr(13) & Err.Description

MsgBox Msg,,"Error'
End If

End Sub
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In the second example, On Error GoTo ErrHandler directive instructs VB to interrupt
the program execution when the error is detected and to pass control to
ErrHandler label.

Dim app

Public Sub HandleError2()

Set app = CreateObject("S4VNA.Applcation")
On Error GoTo ErrHandler
app.SCPI.PARameter.DEFine = "S13"

Exit Sub

ErrHandler:
Msg = "Error # " & Str(Err.Number) & " was generated by " &
Err.Source & Chr(13) & Err.Description
MsgBox Msg,,"Error"

End Sub
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13 COM Automation Data Types

In COM automation, there are the following data types, which can be used for
client-to-server communication:

Long 32-bit  signed integer, value range from -2147483648 to
2147483647
Double 64-bit double-precision floating point, value range from

1.79769313486232E308 to -4.94065645841247E-324 for
negative values, and from 4.94065645841247E-324 to
1.79769313486232E308 for positive values

Boolean 16-bit integer, two values O - false, 1 - true
String Variable-length string
Variant Can be either a value of arbitrary type or an array of values of

arbitrary type. In this case, the term “arbitrary type” means any
allowed type of COM automation. A variable contains information
about its type and array size (if it is an array). It is used for
communication of data arrays between a client and a server.
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14 Measurement Data Arrays

Measurement data can be either complex values or real values. This depends on
the format selected by the user. For example, the data is real in logarithmic
magnitude format and the data is complex in polar format.

The measurement data is transferred in a Variant type variable, which represents
an array of Double type. To transfer one complex measurement, two adjacent array
cells are used. To transfer one real measurement two adjacent array cells are used
as well but the second cell is always equal to 0. Thus, measurement data array
size is a double number of the measurement points.

Measurement 1 Measurement 2 Measurement N

Real Imag Real Imag Real Imag

Figure 4. Array of complex measurements

Measurement 1 Measurement 2 Measurement N

Value 0 Value 0 Value 0

Figure 5. Array of real measurements
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15 COM Server Commands

NAME
Description Reads out the Analyzer identification string.
Type String (read only)
Syntax StrName = app.NAME
The identification string in format: <manufacturer>, <model>, <serial
number>, <software version>/<hardware version>.
Reply
For example: CMT, C1209, 08080188, 16.2/01
Equivalent Softkeys None
READy
Reads out the Ready state of the analyzer. The state is True when
Description analyzer hardware is connected, powered and the boot process is
completed (about 10 sec).
Type Boolean (read only)
Syntax State = app.READy
Equivalent Softkeys None
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SCPI.ABORt

Aborts the sweep. The channels in the Single trigger initiation
mode transit to the Hold state. The channels in the Continuous

Description trigger initiation mode transit to the trigger waiting state, if the
trigger source is set to Internal, the channel immediately starts a
new sweep.

Type Method

Syntax app.SCPI.ABORt

Equivalent Softkeys | Stimulus > Trigger > Restart

SCPIL.CALCulate(Ch).FSIMulator.BALun.CZConversion.STATe

Turns ON/OFF the common port impedance conversion function
when the fixture simulator function is ON, for all the balance ports

Description of selected channel (Ch).
(S4VNA only)
Type Boolean (read/write)

parame True: ~ common port impedance conversion function is ON
arameter . . . .

False: common port impedance conversion function is OFF
Preset Value False

Target Channel Ch from 1 to 16
Status = app.SCPI.CALCulate(Ch).FSIMulator.BALun.CZConversion.STATe
Syntax
app.SCPI.CALCulate(Ch).FSIMulator.BALun.CZConversion.STATe = True
_ Analysis > Fixture Simulator > Cmn ZConversion > Cmn ZConversion [
Equivalent Softkeys

ON | OFF ]
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SCPI.CALCulate(A).FSIMulator.BALun.CZConversion.BPORt(Bp#).Z0.R

Sets the impedance value for the common port impedance
conversion function, for the balance ports 1 or 2 (Bpt) of the

Description selected channel (Ch).
(S4VNA only)
Type Double (read/write)
Range from le-3to 1le7
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value 25

Unit Q (Ohm)
Balanced Port Bpt of channel Ch,

— Ch:  channel number 1-16

! Bpt: balanced port number 1 or 2 for the Bal-Bal topology,
always 1 for the SE-Bal, SE-SE-Bal and Bal topology.

Value =

Syntax app.SCPI.CALCulate(Ch).FSIMulator.BALun.CZConversion.BPORt(Bpt).Z0.R
app.SCPI.CALCulate(Ch).FSIMulator.BALun.CZConversion.BPORt(Bpt).ZO.R = 20

Equivalent Softkeys Analysis > Fixture Simulator > Cmn ZConversion > Bal Port 1 or 2
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SCPI.CALCulate(Ch).FSIMulator.BALun.DEVice

Selects the type of the balanced device for the fixture simulation
function.

Description
(S4VNA only)
Type String (read/write)
"SBALanced" : Specifies the unbalance-balance (3 ports)
"BBALanced" : Specifies the balance-balance (4 ports)
Parameter "SSBalanced” : Specifies the unbalance-unbalance-balance (4
ports)
"BALanced" : Specifies the unbalance (2 ports)
Preset Value "BBAL"

Target Channel Ch from 1 to 16
Param = app.SCPI.CALCulate(Ch).FSIMulator.BALun.DEVice
Syntax
app.SCPI.CALCulate(Ch).FSIMulator.BALun.DEVice = "SBAL"
_ Analysis > Fixture Simulator > Topolgy > Device [SE-Bal | Bal-Bal | SE-SE-
Equivalent Softkeys

Bal|Bal ]
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SCPI.CALCulate(#).FSIMulator.BALun.DMCircuit.BPORt(Bpf).PARameters.C

Sets the capacitance value of the C element of the differential
matching circuit of the fixture simulation function.

Description
(S4VNA only)
Type Double (read/write)
Range from 1le-18 to 1e18
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value 0

Unit F (Farad)
Balanced Port Bpt of channel Ch,

Tarcet Ch:  channel number 1-16

I Bpt: balanced port number 1 or 2 for the Bal-Bal topology,
always 1 for the SE-Bal, SE-SE-Bal and Bal topology.

Value =
app.SCPI.CALCulate(Ch).FSIMulator.BALun.DMCircuit.BPORt(Bpt).PARameters.C

Syntax
app.SCPI.CALCulate(Ch).FSIMulator.BALun.DMCircuit.BPORt(Bpt).PARameters.C =
le-12

Equivalent Softkeys Analysis > Fixture Simulator > Diff Matching > Bal Port n > C
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SCPI.CALCulate(#).FSIMulator.BALun.DMCircuit.BPORt(Bpt).PARameters.G

Sets the conductance value of the G element of the differential
matching circuit of the fixture simulation function.

Description
(S4VNA only)

Type Double (read/write)

Range from 1le-18 to 1e18

Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value 0
Unit S (Siemens)
Balanced Port Bpt of channel Ch,
rarget Ch:  channel number 1-16
Bpt: balanced port number 1 or 2 for the Bal-Bal topology,
always 1 for the SE-Bal, SE-SE-Bal and Bal topology.
Value =
app.SCPI.CALCulate(Ch).FSIMulator.BALun.DMCircuit.BPORt(Bpt).PARameters.G
Syntax
app.SCPI.CALCulate(Ch).FSIMulator.BALun.DMCircuit.BPORt(Bpt).PARameters.G =
0.1
Equivalent Softkeys Analysis > Fixture Simulator > Diff Matching > Bal Portn > G
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SCPI.CALCulate((A).FSIMulator.BALun.DMCircuit.BPORt(Bpt).PARameters.L

Sets the inductance value of the L element of the differential
matching circuit of the fixture simulation function.

Description
(S4VNA only)
Type Double (read/write)
Range from 1le-18 to 1e18
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value 0
Unit H (Henry)
If both elements L and R are equal to zero, then L and R elements are
Note omited in the sheme. If any element L or R is not zero, then zero value of
the rest element means short circuit.
Balanced Port Bpt of channel Ch,
rarget Ch:  channel number 1-16
Bpt: balanced port number 1 or 2 for the Bal-Bal topology,
always 1 for the SE-Bal, SE-SE-Bal and Bal topology.
Value =
app.SCPI.CALCulate(Ch).FSIMulator.BALun.DMCircuit.BPORt(Bpt).PARameters.L
Syntax
app.SCPI.CALCulate(Ch).FSIMulator.BALun.DMCircuit.BPORt(Bpt).PARameters.L =
12e-9
Equivalent Softkeys | Analysis > Fixture Simulator > Diff Matching > Bal Port n > L
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SCPI.CALCulate(A).FSIMulator.BALun.DMCircuit.BPORt(Bpt).PARameters.R

Sets the resistance value of the R element of the differential
matching circuit of the fixture simulation function.

Description
(S4VNA only)
Type Double (read/write)
Range from 1le-18 to 1e18
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value 0
Unit Q (Ohm)
If both elements L and R are equal to zero, then L and R elements are
Note omited in the sheme. If any element L or R is not zero, then zero value of
the rest element means short circuit.
Balanced Port Bpt of channel Ch,
rarget Ch:  channel number 1-16
Bpt: balanced port number 1 or 2 for the Bal-Bal topology,
always 1 for the SE-Bal, SE-SE-Bal and Bal topology.
Value =
app.SCPI.CALCulate(Ch).FSIMulator.BALun.DMCircuit.BPORt(Bpt).PARameters.R
Syntax
app.SCPI.CALCulate(Ch).FSIMulator.BALun.DMCircuit.BPORt(Bpt).PARameters.R =
100
Equivalent Softkeys | Analysis > Fixture Simulator > Diff Matching > Bal Port n > L
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SCPI.CALCulate(Ch).FSIMulator.BALun.DMCircuit.BPORt(Bpt). TYPE

Description

Selects the type of the differential matching circuit for the
specified balanced port number Bpt of the channel Ch.

(S4VNA only)

Type

String (read/write)

"NONE" : Specifies no-circuit
Parameter "PLPC" : Specifies Shunt L — Shunt C circuit

"USER” : Specifies user defined circuit by touchstone file
Preset Value "NONE"

Balanced Port Bpt of channel Ch,
Ch: channel number 1-16

Target
e Bpt: balanced port number 1 or 2 for the Bal-Bal topology,
always 1 for the SE-Bal, SE-SE-Bal and Bal topology.
Param = app.SCPI.CALCulate(Ch).FSIMulator.BALun.DMCircuit.BPORt(Bpt). TYPE
Syntax
app.SCPI.CALCulate(Ch).FSIMulator.BALun.DMCircuit.BPORt(Bpt).TYPE = "PLPC"
_ Analysis > Fixture Simulator > Diff Matching > Bal Port n > { None |
Equivalent Softkeys

Shunt L - Shunt C | User }
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SCPI.CALCulate(A).FSIMulator.BALun.DMCircuit.BPORt(Bpt).USER.FILename

Specifies a file defining the 2-port network which is used in the
differential matching circuit, for the specified balanced port
number Bpt of the channel Ch. The *.s2p file contains the circuit S-

Description .
parameters in Touchstone format.
(S4VNA only)
Type String (read/write)
Parameter File Name
Balanced Port Bpt of channel Ch,
rarget Ch:  channel number 1-16
Bpt: balanced port number 1 or 2 for the Bal-Bal topology,
always 1 for the SE-Bal, SE-SE-Bal and Bal topology.
File =
Syntax app.SCPI.CALCulate(Ch).FSIMulator.BALun.DMCircuit.BPORt(Bpt).USER.FILename

app.SCPI.CALCulate(Ch).FSIMulator.BALun.DMCircuit.BPORt(Bpt).USER.FILename
= "circuit.s2p”

Notes

If the full path to the file is not specified, the \FixtureSim subdirectory of
the main directory will be searched for the file.

Related Commands

SCPI.CALCulate(Ch).FSIMulator.BALun.DMCircuit.BPORt(Bpt). TYPE

Equivalent Softkeys

Analysis > Fixture Simulator > Diff Matching > Bal Port n > User File
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SCPI.CALCulate(Ch).FSIMulator.BALun.DMCircuit.STATe

Description

Turns ON/OFF the differential matching circuit function.
(S4VNA only)

Type

Boolean (read/write)

Parameter

True: differential matching ON
False:  differential matching OFF

Preset Value False
Target Channel Ch from 1 to 16
Status = app.SCPI.CALCulate(Ch).FSIMulator.BALun.DMCircuit.STATe
e app.SCPI.CALCulate(Ch).FSIMulator.BALun.DMCircuit.STATe = True
Equivalent Softkeys Analysis > Fixture Simulator > Diff Matching > Diff Matching [ ON | OFF ]

SCPI.CALCulate(Ch).FSIMulator.BALun.DZConversion.STATe

Turns ON/OFF the differential port impedance conversion function
when the fixture simulator function is ON, for all the balance ports

Description of selected channel (Ch).
(S4VNA only)
Type Boolean (read/write)

Parameter

True:  differential port impedance conversion function is ON
False:  differential port impedance conversion function is OFF

Preset Value

False

Target Channel Ch from 1 to 16
Status = app.SCPI.CALCulate(Ch).FSIMulator.BALun.DZConversion.STATe
Syntax
app.SCPI.CALCulate(Ch).FSIMulator.BALun.DZConversion.STATe = True
_ Analysis > Fixture Simulator > Diff ZConversion > Diff ZConversion [ ON |
Equivalent Softkeys

OFF ]

34



mk:@MSITStore:D:/PDF/Agilent/ENA_Series/E5071C/ENA_C_Help.chm::/Measurement/Fixture_Simulator/Determining_the_Characteristics_that_Result_from_Adding_a.htm
mk:@MSITStore:D:/PDF/Agilent/ENA_Series/E5071C/ENA_C_Help.chm::/Measurement/Fixture_Simulator/Determining_the_Characteristics_that_Result_from_Adding_a.htm
javascript:BSSCPopup('../link/Val_Ch.htm');
mk:@MSITStore:D:/PDF/Agilent/ENA_Series/E5071C/ENA_C_Help.chm::/Measurement/Fixture_Simulator/Determining_the_Characteristics_that_Result_from_Adding_a.htm
mk:@MSITStore:D:/PDF/Agilent/ENA_Series/E5071C/ENA_C_Help.chm::/Measurement/Fixture_Simulator/Determining_the_Characteristics_that_Result_from_Adding_a.htm

SCPI.CALCulate((#).FSIMulator.BALun.DZConversion.BPORt(Bp#).Z0.R

Sets the impedance value for the differential port impedance
conversion function, for the balance ports 1 or 2 (Bpt) of the

Description selected channel (Ch).
(S4VNA only)
Type Double (read/write)
Range from le-3to 1le7
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value 100

Unit Q (Ohm)
Balanced Port Bpt of channel Ch,

— Ch:  channel number 1-16

! Bpt: balanced port number 1 or 2 for the Bal-Bal topology,
always 1 for the SE-Bal, SE-SE-Bal and Bal topology.

Value =

Syntax app.SCPI.CALCulate(Ch).FSIMulator.BALun.DZConversion.BPORt(Bpt).Z0.R
app.SCPI.CALCulate(Ch).FSIMulator.BALun.DZConversion.BPORt(Bpt).Z0.R = 200

Equivalent Softkeys Analysis > Fixture Simulator > Diff ZConversion > Bal Port 1 or 2
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SCPI.CALCulate(#).FSIMulator.BALun.PARameter( 77).BALanced.DEFine

Sets/gets the measurement parameter when the balance-
unbalance conversion function is ON and the balance device type

Description is "BALanced", for the selected trace (Tr) of the selected channel
(Ch).
(S4VNA only)

Type String (read/write)
"SDD11" : Specifies Sdd11
"SCD11" : Specifies Scd11

P

rometer "SDC11" : Specifies Sdcl1

"SCC11” : Specifies Sccll

Out of Range An error occurs. Error code: 214.

Preset Value

"SDD11"

Trace Tr of channel Ch,

Target Ch:  channel number 1-16
Tr: trace number 1-16
Param =
app.SCPI.CALCulate(Ch).FSIMulator.BALun.PARameter(7r).BALanced.DEFine
Syntax
app.SCPI.CALCulate(Ch).FSIMulator.BALun.PARameter(7Tr).BALanced.DEFine=
"SDD11"
, Analysis > Fixture Simulator > Measurement [ SDD11 | SCD11 | SDC11 |
Equivalent Softkeys

SCC11]
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SCPI.CALCulate(#).FSIMulator.BALun.PARameter( 77).BBALanced.DEFine

Sets/gets the measurement parameter when the balance-
unbalance conversion function is ON and the balance device type

Description is "BBALanced", for the selected trace (7r) of the selected channel
(Ch).
(S4VNA only)

Type String (read/write)
"SDD11" : Specifies Sdd11 "SDC12" : Specifies Sdc12
"SDD21" : Specifies Sdd21 "SDC22" : Specifies Sdc22
"SDD12" : Specifies Sdd12 "SCC11" : Specifies Sccll
"SDD22" : Specifies Sdd22 "SCC21” : Specifies Scc21

Parameter "SCD11" : Specifies Scd11 "SCC12” : Specifies Sccl12
"SCD21" : Specifies Scd21 "SCC22" : Specifies Scc22
"SCD12" : Specifies Scd12 "IMB1" : Specifies Imbalancel
"SCD22" : Specifies Scd22 "IMB2" : Specifies Imbalance2
"SDC11" : Specifies Sdcl11 "CMRR" : Specifies CMRR
"SDC21" : Specifies Sdc21 (Sdd21/Scc21)

Preset Value "SDD11"

Trace Tr of channel Ch,

Target Ch:  channel number 1-16
Tr: trace number 1-16
Param =
app.SCPI.CALCulate(Ch).FSIMulator.BALun.PARameter(7r).BBALanced.DEFine
Syntax
app.SCPI.CALCulate(Ch).FSIMulator.BALun.PARameter(7r).BBALanced.DEFine =
"SDD11"
, Analysis > Fixture Simulator > Measurement [ SDD11 | SDD21 | ... |
Equivalent Softkeys

CMRR |

37


javascript:BSSCPopup('../link/Val_Tr.htm');

SCPI.CALCulate(#).FSIMulator.BALun.PARameter( 77).SBALanced.DEFine

Sets/gets the measurement parameter when the balance-
unbalance conversion function is ON and the balance device type

Description is "SBALanced", for the selected trace (Tr) of the selected channel
(Ch).
(S4VNA only)

Type String (read/write)
"SSS11” : Specifies Sss11 "'SDC22" : Specifies Sdc22
"SDS21" : Specifies Sds21 "SCC22" : Specifies Scc22
"SSD12" : Specifies Ssd12 "IMB" : Specifies Imbalance

Parameter "SCS21" : Specifies Scs21 "CMRR1"  :Specifies CMRR1
"SSC12° : Specifies Ssc12 (Sds21/Scs21)
"SDD22"  :Specifies Sdd22 "CMRR2"  :Specifies CMRR2
"SCD22"  :Specifies Scd22 (Ssd12/Ssc12)

Preset Value " §SS11”

Trace Tr of channel Ch,

Target Ch:  channel number 1-16
Tr: trace number 1-16
Param =
app.SCPI.CALCulate(Ch).FSIMulator.BALun.PARameter(Tr).SBALanced.DEFine
Syntax
app.SCPI.CALCulate(Ch).FSIMulator.BALun.PARameter(Tr).SBALanced.DEFine =
"SSS1”
_ Analysis > Fixture Simulator > Measurement [ SSS11 | SDS21 | ... |
Equivalent Softkeys

CMRR2 ]
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SCPI.CALCulate(#).FSIMulator.BALun.PARameter( 77).SSBalanced.DEFine

Sets/gets the measurement parameter when the balance-
unbalance conversion function is ON and the balance device type

Description is "SSBalanced", for the selected trace (Tr) of the selected channel
(Ch).
(S4VNA only)

Type String (read/write)
"SSS11” : Specifies Sss11 "SDD33" : Specifies Sdd33
"SSS21° : Specifies Sss21 "SCD33" : Specifies Scd33
"SSS12° : Specifies Sss12 "SDC33" : Specifies Sdc33
"SSS22° : Specifies Sss22 "SCC33" : Specifies Scc33
"SDS31" : Specifies Sds31 "IMB1" : Specifies Imbalancel

Parameter "SDS32" : Specifies Sds32 "IMB2" : Specifies Imbalance2
"SSD13" : Specifies Ssd13 "IMB3" : Specifies Imbalance3
"SSD23" : Specifies Ssd23 "IMB4" : Specifies Imbalance4
"SCS31” : Specifies Scs31 "CMRR1" : Specifies CMRR1
"SCS32° : Specifies Scs32 (Sds31/Scs31)
"SSC13” : Specifies Sscl13 "CMRR2" : Specifies CMRR2
"SSC23" : Specifies Ssc23 (Sds32/Scs32)

Preset Value " SSS11”

Trace Tr of channel Ch,

Target Ch:  channel number 1-16
Tr: trace number 1-16
Param =
app.SCPI.CALCulate(Ch).FSIMulator.BALun.PARameter(7r).SSBalanced.DEFine
Syntax
app.SCPI.CALCulate(Ch).FSIMulator.BALun.PARameter(Tr).SSBalanced.DEFine =
"SSS1”
_ Analysis > Fixture Simulator > Measurement [ SSS11 | SSS21 | ... |
Equivalent Softkeys

CMRR2 ]
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SCPI.CALCulate(Ch).FSIMulator.BALun.PARameter(Tr).STATe

Turrns ON/OFF the state of the balance-unbalance conversion

Description function.
(S4VNA only)
Type Boolean (read/write)
Parameter True: balance-unbalance conversion function ON
False:  balance-unbalance conversion function OFF
Preset Value False

Trace Tr of channel Ch,
Target Ch: channel number 1-16
Tr: trace number 1-16

Status = app.SCPI.CALCulate(Ch).FSIMulator.BALun.PARameter(7r).STATe
app.SCPI.CALCulate(Ch).FSIMulator.BALun.PARameter(7r).STATe = True

Syntax

Equivalent Softkeys Analysis > Fixture Simulator > Balun [ ON | OFF ]
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SCPI.CALCulate(Ch).FSIMulator.BALun.TOPology.PROPerty.STATe

Description

Turns ON/OFF the state of the property display for the topology
setting when using the balance-unbalance conversion.

(S4VNA only)

Type

Boolean (read/write)

Parameter

True: property display ON
False:  property display OFF

Preset Value

False

Target Channel Ch from 1 to 16

Status = app.SCPI.CALCulate(Ch).FSIMulator.BALun.TOPology.PROPerty.STATe
Syntax

app.SCPI.CALCulate(Ch).FSIMulator.BALuUn.TOPology.PROPerty.STATe = True
Equivalent Softkeys Analysis > Fixture Simulator > Topolgy > Property [ ON | OFF ]
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SCPI.CALCulate(Ch).FSIMulator.BALun.TOPology.BALanced.PPORts

Assigns each port when the balance device type is "BALanced" and
the balance-unbalance conversion function is ON.
The array contains 2 elements:

Data(0) specifies port number assigned to port a of
Description balanced device;
Data(1) specifies port number assigned to port b of
balanced device.
(S4VNA only)
Type Variant: array of long (read/write)
Port number from 1 to 4. The array elements can not contain the same
Parameter
port numbers.
Out of Range If an incorrect port number is specified, an error occurs (error code: 222).
If the same port numbers are specified, an error occurs (error code: 220).
Target Channel Ch from 1 to 16
app.SCPI.CALCulate(Ch).FSIMulator.BALun.TOPology.BALanced.PPORts =
Syntax Array(1,2)

Ports = app.SCPI.CALCulate(Ch).FSIMulator.BALun.TOPology.BALanced.PPORts

Related Commands

SCPI.CALCulate(Ch).FSIMulator.BALun.DEVice

Equivalent Softkeys

Analysis > Fixture Simulator > Topolgy > Port 1 (bal)
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SCPI.CALCulate(Ch).FSIMulator.BALun.TOPology.BBALanced.PPORts

Assigns each port when the balance device type is "BBALanced"
and the balance-unbalance conversion function is ON.
The array contains 4 elements:

Data(0) specifies port number assigned to port a of
balanced device;
Data(1) specifies port number assigned to port b of
Description balanced device.
Data(2) specifies port number assigned to port c of
balanced device.
Data(3) specifies port number assigned to port d of
balanced device.
(S4VNA only)
Type Variant: array of long (read/write)
Port number is 1 to 4. The array elements can not contain the same port
Parameter
numbers.
If an incorrect port number is specified, an error occurs (error code: 222).
Out of Range .
If the same port numbers are specified, an error occurs (error code: 220).
Target Channel Ch from 1 to 16
app.SCPI.CALCulate(Ch).FSIMulator.BALuUn.TOPology.BBALanced.PPORts =
Syntax Array(1,2,3,4)

Ports = app.SCPI.CALCulate(Ch).FSIMulator.BALun.TOPology.BBALanced.PPORts

Related Commands

SCPI.CALCulate(Ch).FSIMulator.BALun.DEVice

Equivalent Softkeys

Analysis > Fixture Simulator > Topolgy > Port 1 (bal), Port 2 (bal)
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SCPI.CALCulate(Ch).FSIMulator.BALun.TOPology.SBALanced.PPORts

Assigns each port when the balance device type is "SBALanced"
and the balance-unbalance conversion function is ON.
The array contains 3 elements:

Data(0) specifies port number assigned to port a of
balanced device;
Description Data(1) specifies port number assigned to port b of
balanced device.
Data(2) specifies port number assigned to port c of
balanced device.
(S4VNA only)
Type Variant: array of long (read/write)
Port number is 1 to 4. The array elements can not contain the same port
Parameter
numbers.
Out of Range If an incorrect port number is specified, an error occurs (error code: 222).
I If the same port numbers are specified, an error occurs (error code: 220).
Target Channel Ch from 1 to 16
app.SCPI.CALCulate(Ch).FSIMulator.BALun.TOPology.SBALanced.PPORts =
Syntax Array(1,2,3)

Ports = app.SCPI.CALCulate(Ch).FSIMulator.BALun.TOPology.SBALanced.PPORts

Related Commands

SCPI.CALCulate(Ch).FSIMulator.BALun.DEVice

Equivalent Softkeys

Analysis > Fixture Simulator > Topolgy > Port 1 (se), Port 2 (bal)
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SCPI.CALCulate(Ch).FSIMulator.BALun.TOPology.SSBalanced.PPORts

Assigns each port when the balance device type is "SSBalanced”
and the balance-unbalance conversion function is ON.
The array contains 3 elements:

Data(0) specifies port number assigned to port a of
balanced device;
Data(1) specifies port number assigned to port b of
Description balanced device.
Data(2) specifies port number assigned to port c of
balanced device.
Data(3) specifies port number assigned to port d of
balanced device.
(S4VNA only)
Type Variant: array of long (read/write)
Port number is 1 to 4. The array elements can not contain the same port
Parameter
numbers.
If an incorrect port number is specified, an error occurs (error code: 222).
Out of Range .
If the same port numbers are specified, an error occurs (error code: 220).
Target Channel Ch from 1 to 16
app.SCPI.CALCulate(Ch).FSIMulator.BALuUn.TOPology.SSBalanced.PPORts =
Syntax Array(1,2,3,4)

Ports = app.SCPI.CALCulate(Ch).FSIMulator.BALun.TOPology.SSBalanced.PPORts

Related Commands

SCPI.CALCulate(Ch).FSIMulator.BALun.DEVice

Equivalent Softkeys

Analysis > Fixture Simulator > Topolgy > Port 1 (se), Port 2 (se), Port 3
(bal)
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SCPI.CALCulate(Ch).FSIMulator.EMBed.NETWork(Nwk).FILename

Specifies a file defining the 4-port network which is used in the 4-
port network embedding/de-embedding function. The file is a 4-
port touchstone file with the ".s4p" extension. The network

Description number (Nwk) is 1 or 2 depending on the selected topology:
SCPI.CALCulate(Ch).FSIMulator.EMBed.TYPE
(S4VNA only)

Type String (read/write)

Parameter File Name

Target Channel Ch from 1 to 16
File = app.SCPI.CALCulate(Ch).FSIMulator.EMBed.NETWork(Nwk).FILename

Syntax

app.SCPI.CALCulate(Ch).FSIMulator.EMBed.NETWork(Nwk).FILename=
"network.s4p”

Notes

If the full path to the file is not specified, the \FixtureSim subdirectory of
the main directory will be searched for the file.

Related Commands

SCPI.CALCulate(Ch).FSIMulator.EMBed.TYPE

Equivalent Softkeys

Analysis > Fixture Simulator > De-Embedding s4p > File (Nwk1), File
(Nwk2)
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SCPI.CALCulate(Ch).FSIMulator.EMBed.NETWork(Nwk).TYPE

Description

Sets/gets the processing type for network (Nwk), for the 4-port
network embedding/de-embedding feature. The network number
(Nwk) is 1 or 2 depending on the selected topology:
SCPI.CALCulate(Ch).FSIMulator.EMBed.TYPE

(S4VNA only)

Type

String (read/write)

"NONE" : Specifies no-processing
Parameter "EMBed” : Specifies embedding
"DEEMbed" : Specifies de-embedding
Preset Value "NONE"
Target Channel Ch from 1 to 16
Param = app.SCPI.CALCulate(Ch).FSIMulator.EMBed.NETWork(Nwk).TYPE
Syntax

app.SCPI.CALCulate(Ch).FSIMulator.EMBed. NETWork(Nwk).TYPE = "EMBed"

Related Commands

SCPI.CALCulate(Ch).FSIMulator.EMBed.TYPE

Equivalent Softkeys

Analysis > Fixture Simulator > De-Embedding s4p > Type (Nwk1), Type
(Nwk2)
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SCPI.CALCulate(Ch).FSIMulator.EMBed.STATe

Description

Turns ON/OFF the state of the 4-port network embedding/de-
embedding feature when the fixture simulator feature is ON.

(S4VNA only)

Type

Boolean (read/write)

Parameter

True: 4-port network embedding/de-embedding feature ON
False:  4-port network embedding/de-embedding feature OFF

Preset Value

False

Target

Channel Ch from 1 to 16

Syntax

Status = app.SCPI.CALCulate(Ch).FSIMulator.EMBed.STATe
app.SCPI.CALCulate(Ch).FSIMulator.EMBed.STATe = True

Related Commands

SCPI.CALCulate(Ch).FSIMulator.STATe

Equivalent Softkeys

Analysis > Fixture Simulator > De-Embedding s4p > De-Embedding s4p
[ ON | OFF ]
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SCPI.CALCulate(Ch).FSIMulator.EMBed.TOPology.A.PORTs

embedding feature.
The array contains 2 elements:

Sets/gets the test port assignment when the connection type
(Topology) is set to A, for the 4-port network embedding/de-

Description Data(0) Port number assigned to port a;
Data(1) Port number assigned to port b.
(S4VNA only)
Type Variant: array of long (read/write)

Parameter

Port number is 1 to 4. The array elements can not contain the same port

numbers.

If an incorrect port number is specified, an error occurs (error code: 222).
Out of Range .

If the same port numbers are specified, an error occurs (error code: 220).
Target Channel Ch from 1 to 16

app.SCPI.CALCulate(Ch).FSIMulator.EMBed.TOPology.A.PORTs = Array(1,2)
Syntax

Ports = app.SCPI.CALCulate(Ch).FSIMulator.EMBed.TOPology.A.PORTs

Related Commands SCPI.CALCulate(Ch).FSIMulator.EMBed.TYPE

Equivalent Softkeys Analysis > Fixture Simulator > De-Embedding s4p > Ports
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SCPI.CALCulate(Ch).FSIMulator.EMBed.TOPology.B.PORTs

Sets/gets the test port assignment when the connection type
(Topology) is set to B, for the 4-port network embedding/de-
embedding feature.
The array contains 3 elements:
Data(0) Port number assigned to port a;
Description
Data(1) Port number assigned to port b;
Data(2) Port number assigned to port c.
(S4VNA only)
Type Variant: array of long (read/write)
Port number is 1 to 4. The array elements can not contain the same port
Parameter
numbers.
Out of Range If an incorrect port number is specified, an error occurs (error code: 222).
I If the same port numbers are specified, an error occurs (error code: 220).
Target Channel Ch from 1 to 16
app.SCPI.CALCulate(Ch).FSIMulator.EMBed.TOPology.B.PORTs = Array(1,2,3)
Syntax
Ports = app.SCPI.CALCulate(Ch).FSIMulator.EMBed.TOPology.B.PORTs
Related Commands SCPI.CALCulate(Ch).FSIMulator.EMBed.TYPE
Equivalent Softkeys Analysis > Fixture Simulator > De-Embedding s4p > Ports
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SCPI.CALCulate(Ch).FSIMulator.EMBed.TOPology.C.PORTs

Sets/gets the test port assignment when the connection type
(Topology) is set to C, for the 4-port network embedding/de-
embedding feature.

The array contains 3 elements:

Data(0) Port number assigned to port a;
Description Data(1) Port number assigned to port a;
Data(2) Port number assigned to port b;
Data(3) Port number assigned to port c.
(S4VNA only)
Type Variant: array of long (read/write)

Port number is 1 to 4. The array elements can not contain the same port

Parameter

numbers.

If an incorrect port number is specified, an error occurs (error code: 222).
Out of Range .

If the same port numbers are specified, an error occurs (error code: 220).
Target Channel Ch from 1 to 16

app.SCPI.CALCulate(Ch).FSIMulator.EMBed.TOPology.C.PORTSs = Array(1,2,3,4)
Syntax

Ports = app.SCPI.CALCulate(Ch).FSIMulator.EMBed.TOPology.C.PORTs

Related Commands SCPI.CALCulate(Ch).FSIMulator.EMBed.TYPE

Equivalent Softkeys Analysis > Fixture Simulator > De-Embedding s4p > Ports
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SCPI.CALCulate(Ch).FSIMulator.EMBed.TYPE

Sets/gets the connection type (Topology), for the 4-port network
embedding/de-embedding feature

Description
(S4VNA only)
Type String (read/write)
"A : Specifies connection type A
Parameter : Specifies connection type B
"C : Specifies connection type C
Preset Value "A"

Target Channel Ch from 1 to 16
Param = app.SCPI.CALCulate(Ch).FSIMulator.EMBed.TYPE
Syntax
app.SCPI.CALCulate(Ch).FSIMulator.EMBed.TYPE = "A"
Equivalent Softkeys Analysis > Fixture Simulator > De-Embedding s4p > Topology [A|B | C]
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SCPI.CALCulate(CA).FSIMulator.SENDed.DEEMbed.PORT(P4.USER FiLename

Sets/gets the de-embedding network file (*.s2p). The file contains

Description : . .
the circuit S—parameters in Touchstone format.

Type String (read/write)

Parameter File Name
Port Pt of channel Ch,

Target Ch:  channel number 1-16

Pt: port number 1-2 (4 for S4VNA)

File =

Syntax app.SCPI.CALCulate(Ch).FSIMulator.SENDed.DEEMbed.PORT(Pt).USER.FILename
app.SCPI.CALCulate(Ch).FSIMulator.SENDed.DEEMbed.PORT(Pt).USER.FILename
= "network.s2p"

Notes If the full path to the file is not specified, the \FixtureSim subdirectory of
the main directory will be searched for the file.

Equivalent Softkeys | Analysis > Fixture Simulator > De-Embedding > User File
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SCPI.CALCulate(Ch).FSIMulator.SENDed.DEEMbed.PORT(Pt).STATe

Description Turns ON/OFF the state of the 2-port network de-embedding
function for specified port (s2p).
Type Boolean (read/write)
True: De-embedding function ON
Parameter . .
False:  De-embedding function OFF
Preset Value False
Port Pt of channel Ch,
Target Ch:  channel number 1-16
Pt: port number 1-2 (4 for S4VNA)
Status = app.SCPI.CALCulate(Ch).FSIMulator.SENDed.DEEMbed.PORT(Pt).STATe
Syntax
app.SCPI.CALCulate(Ch).FSIMulator.SENDed.DEEMbed.PORT(Pt).STATe = True
Equivalent Softkeys | Analysis > Fixture Simulator > De-Embedding > Port n

SCPI.CALCulate(Ch).FSIMulator.SENDed.DEEMbed.STATe

Description Turns ON/OFF the state of the 2-port network de-embedding
function.
Type Boolean (read/write)
True: De-embedding function ON
Parameter . .
False: De-embedding function OFF
Preset Value False
Target Channel Ch from 1 to 16
Status = app.SCPI.CALCulate(Ch).FSIMulator.SENDed.DEEMbed.STATe
Syntax
app.SCPI.CALCulate(Ch).FSIMulator.SENDed.DEEMbed.STATe = True
Equivalent Softkeys | Analysis > Fixture Simulator > De-Embedding > De-Embedding
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SCPI.CALCulate(C#).FSIMulator. SENDed.PMCircuit.PORT(P.USER FlLename

Description Sets/gets the embedding network file (*.s2p). The file contains the
circuit S—parameters in Touchstone format.
Type String (read/write)
Parameter File Name
Port Pt of channel Ch,
Target Ch:  channel number 1-16
pt: port number 1-2 (4 for S4VNA)
File =
app.SCPI.CALCulate(Ch).FSIMulator.SENDed.PMCircuit.PORT(Pt).USER.FILename
Syntax
app.SCPI.CALCulate(Ch).FSIMulator.SENDed.PMCircuit.PORT(Pt).USER.FILename
= "network.s2p"
Notes If the full path to the file is not specified, the \FixtureSim subdirectory of
the main directory will be searched for the file.
Equivalent Softkeys | Analysis > Fixture Simulator > Embedding > User File
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SCPI.CALCulate(Ch).FSIMulator.SENDed.PMCircuit.PORT(Pt).STATe

Description Turns ON/OFF the state of the 2-port network embedding function
for specified port.
Type Boolean (read/write)
True: Embedding function ON
Parameter . .
False:  Embedding function OFF
Preset Value False
Port Pt of channel Ch,
Target Ch:  channel number 1-16
Pt: port number 1-2 (4 for S4VNA)
Status = app.SCPI.CALCulate(Ch).FSIMulator.SENDed.DEEMbed.PORT(Pt).STATe
Syntax
app.SCPI.CALCulate(Ch).FSIMulator.SENDed.DEEMbed.PORT(Pt).STATe = True
Equivalent Softkeys | Analysis > Fixture Simulator > Embedding > Port n

SCPI.CALCulate(Ch).FSIMulator.SENDed.PMCircuit.STATe

Description Turns ON/OFF the state of the 2-port network embedding function.

Type Boolean (read/write)

True: Embedding function ON
False: Embedding function OFF

Parameter

Preset Value False

Target Channel Ch from 1 to 16

Status = app.SCPI.CALCulate(Ch).FSIMulator.SENDed.DEEMbed.PORT(Pt).STATe
app.SCPI.CALCulate(Ch).FSIMulator.SENDed.DEEMbed.PORT(Pt).STATe = True

Syntax

Equivalent Softkeys | Analysis > Fixture Simulator > Embedding > Embedding
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SCPI.CALCulate(Ch).FSIMulator.SENDed.ZCONversion.PORT(Pt).Z0.R

Sets/gets the value of the impedance for port impedance

Description . .

conversion function.
Type Double (read/write)
Range from 1le-6to 1e6
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 50
Unit Q (Ohm)

Port Pt of channel Ch,
Target Ch:  channel number 1-16

pt: port number 1-2 (4 for S4VNA)

Value = app.SCPI.CALCulate(Ch).FSIMulator.SENDed.ZCONversion.PORT(Pt).Z0.R
Syntax

app.SCPI.CALCulate(Ch).FSIMulator.SENDed.ZCONversion.PORT(Pt).Z0.R = 50
Equivalent Softkeys | Analysis > Fixture Simulator > Port Z Conversion > Port n Z0
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SCPI.CALCulate(Ch).FSIMulator.SENDed.ZCONversion.STATe

Turns ON/OFF the state of the port impedance conversion

Description .

function.
Type Boolean (read/write)

True: Port Z conversion function ON
Parameter

False:  Port Z conversion function OFF

Preset Value

False

Target Channel Ch from 1 to 16

Status = app.SCPI.CALCulate(Ch).FSIMulator.SENDed.ZCONversion.STATe
Syntax

app.SCPI.CALCulate(Ch).FSIMulator.SENDed.ZCONversion.STATe = True
Equivalent Softkeys | Analysis > Fixture Simulator > Port Z Conversion > Port Z Conversion

SCPI.CALCulate(Ch).FSIMulator.STATe

Turns ON/OFF the state of the fixture simulator function for

Description .

specified channel.
Type Boolean (read/write)

True: fixture simulator function ON
Parameter

False: fixture simulator function OFF

Preset Value

False

Target Channel Ch from 1 to 16

Status = app.SCPI.CALCulate(Ch).FSIMulator.STATe
Syntax

app.SCPI.CALCulate(Ch).FSIMulator.STATe = True
Equivalent Softkeys | Analysis > Fixture Simulator > Fixture Simulator
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SCPI.CALCulate(Ch).PARameter(1).COUNt

Description Sets/gets the number of traces in the channel.

Type Long (read/write)

Range from 1 to 16

Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 1

Target Channel Ch from 1 to 16

TraceNum = app.SCPI.CALCulate(Ch).PARameter.COUNt
app.SCPI.CALCulate(Ch).PARameter.COUNt = 2

Syntax

Object PARameter has an index of 1, which can be omitted in Visual Basic

Warning . . . .
but it cannot be omitted in other programming languages.

Equivalent Softkeys | Display > Num of Traces
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SCPI.CALCulate(Ch).PARameter(Tr).DEFine

Description Sets/gets the measurement parameter of the trace.
Type String (read/write)
"S11", "S12","S13", "S14",
"S21","S22","S23", "S24",
"S31", "S32", "S33", "S34",
"S41", "S42", "S43", "S44" :S - parameter
Parameter
"T1","T2","T3", "T4" : Test receiver
"R1","R2", "R3", "R4" : Reference receiver
"A", "B, "C", D" :Alias for T1, T2, T3, T4

Related Commands

SCPI.CALCulate(Ch).PARameter(Tr).SPORt

Target

Trace Tr of channel Ch,
Ch: channel number 1-16
Tr: trace number 1-16

Syntax

StrMeas = app.SCPI.CALCulate(Ch).PARameter(7r).DEFine
app.SCPI1.CALCulate(Ch).PARameter(Tr).DEFine = "S11"

Equivalent Softkeys

(S2VNA)

Measurement >S11|S21|S12|S22

Measurement > Absolute > { A(1) | B(1) | R1(1) | A(2) | B(2) | R2(2) }
(S4VNA)

Measurement > S-parameter > S11|S12| ... S44

Measurement > Test Receiver > T1(1) | T1(2) | ... T4(4)
Measurement > Reference Receiver > R1(1) | R1(2) | ... R4(4)
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SCPI.CALCulate(Ch).PARameter(Tr).SELect

Description Sets the active channel and trace.
Type Method
Trace Tr of channel Ch,
Target Ch:  channel number 1-16
Tr: trace number 1-16
Syntax app.SCPI.CALCulate(Ch).PARameter(Tr).SELect
If the channel number is greater than the number of the channels
Notes displayed, an error occurs and the command is ignored. If the trace
number is greater than the number of the traces displayed in the
channel, an error occurs and the command is ignored.
, Display > Active Trace/Channel > Active Channel
Equivalent Softkeys

Display > Active Trace/Channel > Active Trace
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SCPI.CALCulate(Ch).PARameter(Tr).SPORt

Sets/gets the number of the source port for absolute

Deseripion measurements.

Type Long (read/write)

Parameter Port number from 1 to 2 (4 for S4VNA)
Out of Range An error occurs. Error code: 208.

Preset Value

Target

Trace Tr of channel Ch,
Ch: channel number 1-16
Tr: trace number 1-16

Syntax

StimPort = app.SCPI.CALCulate(Ch).PARameter(7r).SPORt
app.SCPI.CALCulate(Ch).PARameter(Tr).SPORt = 1

Equivalent Softkeys

(S2VNA)

Measurement > Measurement > Absolute > A(1) | B(1) | R1(1) | A(2) |
B(2) IR2(2)

(S4VNA)

Measurement > Test Receiver > T1(1) | T1(2) | ... T4(4)

Measurement > Reference Receiver > R1(1) | R1(2) | ... R4(4)
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SCPI.CALCulate(Ch).SELected.CONVersion.FUNCtion

Description Sets/gets the S—-parameter conversion function type.
Type String (read/write)
"ZREFlection” : Reflection equivalent impedance
"ZTRansmit" : Transmission equivalent impedance
"YREFlection” : Reflection equivalent admittance
"YTRansmit" : Transmission equivalent admittance
Parameter .
"INVersion” :Inverse S—parameter
"ZTSHunt" : Shunt equivalent impedance
"YTSHunt" : Shunt equivalent admittance
"CONJugation” : S—-parameter conjugate
Preset Value "ZREF"

The active trace of channel Ch,

Target
e Ch: channel number 1-16
Param = app.SCPI.CALCulate(Ch).SELected.CONVersion.FUNCtion
Syntax
app.SCPI.CALCulate(Ch).SELected.CONVersion.FUNCtion = "ZTR"
, Analysis > Conversion > Zr | Zt | Yr | Yt| 1/S | Z Trans-Shunt |
Equivalent Softkeys

Y Trans-Shunt | Conjugation
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SCPI.CALCulate(Ch).SELected.CONVersion.STATe

Description Turns ON/OFF the state of the S-parameter conversion function.
Type Boolean (read/write)

True: S—-parameter conversion function ON
Parameter

False:  S-parameter conversion function OFF

Preset Value

False

Target

The active trace of channel Ch,
Ch: channel number 1-16

Syntax

Status = app.SCPI.CALCulate(Ch).SELected.CONVersion.STATe
app.SCPI.CALCulate(Ch).SELected.CONVersion.STATe = true

Related Commands

SCPI.CALCulate(Ch).SELected.CONVersion.FUNCtion

Equivalent Softkeys

Analysis > Conversion > Conversion
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SCPI.CALCulate(Ch).SELected.CORRection.EDELay.TIME

Description Sets/gets the value of the electrical delay.
Type Double (read/write)
Range from -10 to 10
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 0
Unit s (second)

The active trace of channel Ch,
Target

Ch: channel number 1-16

Value = app.SCPI.CALCulate(Ch).SELected.CORRection.EDELay.TIME
Syntax

app.SCPI.CALCulate(Ch).SELected.CORRection.EDELay.TIME = 1e-9
Equivalent Softkeys Scale > Electrical Delay
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SCPI.CALCulate(Ch).SELected.CORRection.OFFSet.PHASe

Description Sets/gets the value of the phase offset.
Type Double (read/write)
Range from =360 to 360
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 0
Unit ° (degree)

The active trace of channel Ch,
Target

Ch:  channel number 1-16

Value = app.SCPI.CALCulate(Ch).SELected.CORRection.OFFSet.PHASe
Syntax

app.SCPI.CALCulate(Ch).SELected.CORRection.OFFSet.PHASe = 360
Equivalent Softkeys Scale > Phase Offset
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SCPI.CALCulate(Ch).SELected.CORRection.STATus

Description Gets the active trace correction status.
Type String (read only)
If active trace represents a S-parameter:
"COR" : Correction is enabled.
" : Correction is enabled. Interpolation is applied.
"cl” : Correction is enabled. Extrapolation is applied.
: Correction is disabled.
Parameter .
If active trace represents an Absolute measurement:
"RC" : Correction is enabled.
"RC?" : Correction is enabled. Interpolation is applied.
"RC!" : Correction is enabled. Extrapolation is applied.
: Correction is disabled.
The active trace of channel Ch,
Target
Ch:  channel number 1-16
Syntax Param = app.SCPI.CALCulate(Ch).SELected.CORRection.STATus
Equivalent Softkeys None
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SCPI.CALCulate(Ch).SELected.DATA.FDATa

Gets/sets the formatted data array. The array elements contain
measurements in the current format, for example, in logarithmic
magnitude format (Log Mag). Also, see section 14

The array size is 2N, where N is the number of measurement
points.

Description
For the n-th point, where n from 1 to N:
Data(Z2n-2)  real number in rectangular format, real part in
polar and Smith chart formats;
Data(2n-1) 0 in rectangular format, imaginary part in polar
and Smith chart formats.
Type Variant: array of double (read/write)
The active trace of channel Ch,
Target
Ch:  channel number 1-16
Data = app.SCPI.CALCulate(Ch).SELected.DATA.FDATa
Syntax
app.SCPI.CALCulate(Ch).SELected.DATA.FDATa = Data
Equivalent Softkeys None
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SCPI.CALCulate(Ch).SELected.DATA.FMEMory

Gets/sets the formatted memory array. The array elements contain
saved measurements in the current format, for example, in
logarithmic magnitude format (Log Mag). Also, see section 14.

The array size is 2N, where N is the number of measurement
points.

Description
For the n-th point, where n from 1 to N:
Data(Z2n-2)  real number in rectangular format, real part in
polar and Smith chart formats;
Data(2n-1) 0 in rectangular format, imaginary part in polar
and Smith chart formats.
Type Variant: array of double (read/write)
The active trace of channel Ch,
Target
Ch:  channel number 1-16
Data = app.SCPI.CALCulate(Ch).SELected.DATA.FMEMory
Syntax
app.SCPI.CALCulate(Ch).SELected.DATA.FMEMory = Data
Equivalent Softkeys None
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SCPI.CALCulate(Ch).SELected.DATA.SDATa

Gets/Sets the corrected data array. The corrected measurements
are complex numbers. Also, see section 14.

The array size is 2N, where N is the number of measurement
points.

Description
For the n—-th point, where n from 1 to N:
Data(Zn-2)  the real part of corrected measurement;
Data(Zn-1) the imaginary part of corrected measurement.
Type Variant: array of double (read/write)
The active trace of channel Ch,
Target
Ch:  channel number 1-16
Data = app.SCPI.CALCulate(Ch).SELected.DATA.SDATa
Syntax
app.SCPI.CALCulate(Ch).SELected.DATA.SDATa = Data
Equivalent Softkeys None
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SCPI.CALCulate(Ch).SELected.DATA.SMEMory

Gets/sets the corrected memory array. The corrected
measurements are complex numbers. Also, see section 14.

The array size is 2N, where N is the number of measurement
points.

Description .
For the n—-th point, where n from 1 to N:
Data(Zn-2) the real part of corrected measurement memory;
Data(Zn-1) the imaginary part of corrected measurement
memory.
Type Variant: array of double (read/write)
The active trace of channel Ch,
Target
Ch:  channel number 1-16
Data = app.SCPI.CALCulate(Ch).SELected.DATA.SMEMory
Syntax
app.SCPI.CALCulate(Ch).SELected.DATA.SMEMory = Data
Equivalent Softkeys | None

SCPI.CALCulate(Ch).SELected.DATA.XAXis

Gets the X axis data array. The array size is N, where N is the
number of measurement points.

Description

For the n-th point, where n from 0 to N-1:

Data(n) the X axis value;

Type Variant: array of double (read only)

The active trace of channel Ch,
Target

Ch:  channel number 1-16

Syntax Data = app.SCPI.CALCulate(Ch).SELected.DATA.XAXis
Equivalent Softkeys None
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SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.CENTer

Description Sets/gets the gate center value of the gating function.
Type Double (read/write)
Range Varies depending on the frequency span and the number of points.
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 0
Unit s (second)

The active trace of channel Ch,
Target

Ch:  channel number 1-16

Value = app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.CENTer
Syntax

app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.CENTer = 1e-8
Equivalent Softkeys | Analysis > Gating > Center

72




SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.SHAPe

Description Sets/gets the gate shape of the gating function.
Type String (read/write)
"MAXimum" : Maximum shape
"WIDE" : Wide shape
Parameter
"NORMal” :Normal shape
"MINimum” : Minimum shape
Preset Value "NORM"

The active trace of channel Ch,

Target
Ch:  channel number 1-16
Param = app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.SHAPe
Syntax
app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.SHAPe = "MAX"
Equivalent Softkeys | Analysis > Gating > Shape > Maximum | Wide | Normal | Minimum
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SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.SPAN

Description Sets/gets the gate span value of the gating function.
Type Double (read/write)
Range Varies depending on the frequency span and the number of points.
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 2e-8
Unit s (second)

The active trace of channel Ch,
Target

Ch:  channel number 1-16

Value = app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.SPAN
Syntax

app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.SPAN = 1e-8
Equivalent Softkeys | Analysis > Gating > Span
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SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.STARt

Description Sets/gets the gate start value of the gating function.

Type Double (read/write)

Range Varies depending on the frequency span and the number of points.
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value -le-8

Unit s (second)

The active trace of channel Ch,

Target
Ch: channel number 1-16

Value = app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.STARt
app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.STARt = 1e-7

Syntax

Equivalent Softkeys | Analysis > Gating > Start

SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.STATe

Description Turns ON/OFF the state of the gating function.

Type Boolean (read/write)

True: Gating function ON
False:  Gating function OFF

Parameter

Preset Value False

The active trace of channel Ch,

Target
Ch: channel number 1-16

Status = app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.STATe
app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.STATe = Status

Syntax

Equivalent Softkeys Analysis > Gating > Gating




SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.STOP

Description Sets/gets the gate stop value of the gating function.

Type Double (read/write)

Range Varies depending on the frequency span and the number of points.
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value le-8

Unit s (second)

The active trace of channel Ch,

Target
Ch: channel number 1-16

Value = app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.STOP
app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.STOP = 1le-7

Syntax

Equivalent Softkeys | Analysis > Gating > Stop

SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.TYPE

Description Sets/gets the gate type of the gating function.
Type String (read/write)
"BPASs” : Bandpass type
Parameter
"NOTCh" : Notch type
Preset Value "BPAS"

The active trace of channel Ch,

Target
Ch: channel number 1-16

Param = app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.TYPE
app.SCPI.CALCulate(Ch).SELected.FILTer.GATE.TIME.TYPE = "bpas”

Syntax

Equivalent Softkeys | Analysis > Gating > Type




SCPI.CALCulate(Ch).SELected.FORMat

Description Sets/gets the data format for the trace.
Type String (read/write)
"MLOGarithmic” :Logarithmic magnitude
"PHASe" : Phase
"GDELay" : Group delay time
"SLINear” : Smith chart format (Lin)
"SLOGarithmic” : Smith chart format (Log)
"SCOMplex” : Smith chart format (Real/Imag)
"SMITh" : Smith chart format (R + jX)
"SADMittance”  :Smith chart format (G + jB)
Parameter A
"PLINear” : Polar format (Lin)
"PLOGarithmic" :Polar format (Log)
"POLar" : Polar format (Real/Imag)
"MLINear” : Linear magnitude
"SWR" : Voltage standing wave ratio
"REAL" :Real part
"IMAGinary” : Imaginary part
"UPHase" : Expanded phase
Preset Value "MLOG"
The active trace of channel Ch,
Target
Ch:  channel number 1-16
< Param = app.SCPI.CALCulate(Ch).SELected.FORMat
e app.SCPI.CALCulate(Ch).SELected.FORMat = "PHAS"
Format > Log Mag | Phase | Group Delay | Lin Mag | SWR | Real | Imag |
. Phase > 1
Equivalent Softkeys . . . .
Format > Smith > Log/Phase | Lin/Phase | Real/Imag | R+jX | G+jB
Format > Polar > Log/Phase | Ling/Phase | Real/Imag
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SCPI.CALCulate(Ch).SELected.FUNCtion.DATA

Gets the data array - result of analysis executed by the
SCPI.CALCulate(Ch).SELected.FUNCtion.EXECute method.

The array size is 2N, where N is the number of points defined by
the SCPI.CALCulate(Ch).SELected.FUNCtion.POINts command.

For the n—-th point, where n from 1 to N:

Descripti .
escription Data(Z2n-2) the response value in the n-th measurement
point;

Data(2n-1) the stimulus value in the n-th measurement
point. Always set to O for the analysis of mean
value, standard deviation, and peak-to-peak
value.

Type Variant: array of double (read only)
Tarcet The active trace of channel Ch,
! Ch:  channel number 1-16
Syntax Data = app.SCPI.CALCulate(Ch).SELected.FUNCtion.DATA
Equivalent Softkeys None
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SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.COUPle

Description

Turns ON/OFF the coupling state of the analysis range for the
SCPI.CALCulate(Ch).SELected.FUNCtion.EXECute method.

Type

Boolean (read/write)

Parameter

True: Coupling state ON
False:  Coupling state OFF

Preset Value

True

All traces of channel Ch,

Target
e Ch:  channel number 1-16
Status = app.SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.COUPLe
Syntax
app.SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.COUPLle = Status
Equivalent Softkeys None

SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.STARt

Sets/gets the start value of the analysis range set by the

Description .
SCPI.CALCulate(Ch).SELected.FUNCtion.EXECute method.

Type Double (read/write)

Range From the stimulus current start value to the stimulus current stop value.

Preset Value 0
Unit Hz|s | dBm

All traces of channel Ch (if the coupling is set to ON by the
Tarcet SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.COUPle command), the

! active trace of channel Ch (if otherwise),
Ch:  channel number 1-16

Value = app.SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.STARt
Syntax

app.SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.STARt = 1e9
Equivalent Softkeys None
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SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.STATe

Description

Turns ON/OFF the state of the arbitrary range when executing the
analysis by the SCPI.CALCulate(Ch).SELected.FUNCtion.EXECute
method.

Type

Boolean (read/write)

Parameter

True: Arbitrary range ON
False:  Arbitrary range OFF (entire sweep range)

Preset Value

False

All traces of channel Ch (if the coupling is set to ON by the
SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.COUPle command), the

Target . Rk i
active trace of channel Ch (if otherwise),
Ch:  channel number 1-16
Status = app.SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.STATe
Syntax
app.SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.STATe = true
Equivalent Softkeys None

80




SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.STOP

Sets/gets the stop value of the analysis range set by the

Description .
SCPI.CALCulate(Ch).SELected.FUNCtion.EXECute method.

Type Double (read/write)

Range From the stimulus current start value to the stimulus current stop value.

Preset Value 0
Unit Hz|s | dBm
All traces of channel Ch (if the coupling is set to ON by the
rarget SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.COUPle command), the
active trace of channel Ch (if otherwise),
Ch:  channel number 1-16
Value = app.SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.STOP
Syntax
app.SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.STOP = 2e9
Equivalent Softkeys None

SCPIL.CALCulate(Ch).SELected.FUNCtion.EXECute

Executes the analysis specified with the
SCPI.CALCulate(Ch).SELected.FUNCtion.TYPE command.

Description The analysis result can then be read out with the
SCPI.CALCulate(Ch).SELected.FUNCtion.DATA command.
Type Method
The active trace of channel Ch,
Target
Ch:  channel number 1-16
Syntax app.SCPI.CALCulate(Ch).SELected.FUNCtion.EXECute
Equivalent Softkeys None
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SCPI.CALCulate(Ch).SELected.FUNCtion.PEXCursion

Sets/gets the lower limit for the peak excursion value when

Description executing the peak search by the
SCPI.CALCulate(Ch).SELected.FUNCtion.EXECute method.

Type Double (read/write)

Range Varies depending on the trace format.

Preset Value 3
Unit dB|°|s

The active trace of channel Ch,
Target

Ch: channel number 1-16

Value = app.SCPI.CALCulate(Ch).SELected.FUNCtion.PEXCursion
Syntax

app.SCPI.CALCulate(Ch).SELected.FUNCtion.PEXCursion = 1.5
Equivalent Softkeys None

SCPI.CALCulate(Ch).SELected.FUNCtion.POINts

Gets the number of points (data pairs) of the analysis result by the
SCPI.CALCulate(Ch).SELected.FUNCtion.EXECute method.
Always equal to 1, when the search is executed for the maximum,

Description L. . L.
minimum, mean, standard deviation, peak, and peak-to-peak
values. The actual number of points is read out, when the search is
executed for all peaks or all targets.
Type Long (read only)
The active trace of channel Ch,
Target
Ch:  channel number 1-16
Syntax Value = app.SCPI.CALCulate(Ch).SELected.FUNCtion.POINts
Equivalent Softkeys None

82




SCPI.CALCulate(Ch).SELected.FUNCtion.PPOLarity

Sets/gets the polarity selection when performing the peak search

Description .
by the SCPI.CALCulate(Ch).SELected.FUNCtion.EXECute method.
Type String (read/write)
"POSitive” : Positive peaks
Parameter "NEGative"” : Negative peaks
"BOTH" : Both positive peaks and negative peaks
Preset Value "POS"

The active trace of channel Ch,

Target
e Ch:  channel number 1-16
Param = app.SCPI.CALCulate(Ch).SELected.FUNCtion.PPOLarity
Syntax
app.SCPI.CALCulate(Ch).SELected.FUNCtion.PPOLarity = "NEG"
Equivalent Softkeys None

83




SCPI.CALCulate(Ch).SELected.FUNCtion.TARGet

Sets/gets the target level when performing the search for the trace

Description and the target level crosspoints by the
SCPI.CALCulate(Ch).SELected.FUNCtion.EXECute method.
Type Double (read/write)
Range Varies depending on the trace format.
Preset Value 0
Unit dB|°|s
The active trace of channel Ch,
Target
Ch:  channel number 1-16
Value = app.SCPI.CALCulate(Ch).SELected.FUNCtion.TARGet
Syntax
app.SCPI.CALCulate(Ch).SELected.FUNCtion.TARGet = -10
Equivalent Softkeys None
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SCPI.CALCulate(Ch).SELected.FUNCtion.TTRansition

Sets/gets the transition type selection when performing the search

Description for the trace and the target level «crosspoints by the

SCPI.CALCulate(Ch).SELected.FUNCtion.EXECute method.
Type String (read/write)

"POSitive” : Positive peaks
Parameter "NEGative" : Negative peaks

"BOTH" : Both positive peaks and negative peaks
Preset Value "POS”

The active trace of channel Ch,
Target

Ch:  channel number 1-16

Param = app.SCPI.CALCulate(Ch).SELected.FUNCtion.TTRansition
Syntax

app.SCPI.CALCulate(Ch).SELected.FUNCtion.TTRansition = "both"
Equivalent Softkeys | None
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SCPI.CALCulate(Ch).SELected.FUNCtion.TYPE

Sets/gets the selection of the type of analysis executed by the

Description .
SCPI.CALCulate(Ch).SELected.FUNCtion.EXECute method.
Type String (read/write)
"PTPeak” . Peak-to-peak (difference between the maximum
value and the minimum value)
"STDEV" : Standard deviation
"MEAN" : Mean value
5 "MAXimum" : Maximum value
arameter
"MINimum” : Minimum value
"PEAK" : Search for the peak
"APEak” : Search for all the peaks
"ATARget” : Search for all targets
Preset Value "PTP"

The active trace of channel Ch,

Target
Ch:  channel number 1-16
Param = app.SCPI.CALCulate(Ch).SELected.FUNCtion.TYPE
Syntax
app.SCPI.CALCulate(Ch).SELected.FUNCtion.TYPE = "STDEV"
Equivalent Softkeys None

86




SCPI.CALCulate(Ch).SELected.LIMit.DATA

Sets/gets the data array, which is the Llimit line in the limit test
function. The array size is 1 + 5N, where N is the number of
measuring points.

For the n—-th point, where n from 1 to N:

Data(0) The number of limit line segments N is from O to
100. Setting O clears the limit line;

Data(5n-4)  type of the n-th limit line segment;

0: OFF
1: Upper limit
Description 2: Lower limit
3:Single point limit
Data(5n-3) the stimulus value in the start point of the n-th
segment;
Data(5n-2) the stimulus value in the end point of the n-th
segment;
Data(5n-1) the response value in the start point of the n-th
segment;
Data(5n-0) the response value in the end point of the n-th
segment.
Type Variant: array of double (read/write)
If the array size is not 1 + 5N, where N is Data(0), an error occurs (error
code 214). If Data(5n - 4) is less than 0 or more than 2, an error occurs
Notes (error code 214). When Data(5n-3), Data(5n-2), Data(5n-1) and Data(5n-
0) elements are out of allowable range, the value is set to the limit,
which is closer to the specified value.
The active trace of channel Ch,
Target
Ch:  channel number 1-16
Data = app.SCPI.CALCulate(Ch).SELected.LIMit.DATA
Syntax

app.SCPI.CALCulate(Ch).SELected.LIMit.DATA = Array(1,2,800,900,-10,-10)

Equivalent Softkeys

Analysis > Limit Test > Edit Limit Line
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SCPI.CALCulate(Ch).SELected.LIMit.DISPlay.STATe

Turns ON/OFF the state of the limit line display of the limit test

Description .

function.
Type Boolean (read/write)

True: Limit line display ON
Parameter

False:  Limit line display OFF

Preset Value

False

The active trace of channel Ch,

Target
e Ch:  channel number 1-16
Status = app.SCPI.CALCulate(Ch).SELected.LIMit.DISPlay.STATe
Syntax
app.SCPI.CALCulate(Ch).SELected.LIMit.DISPlay.STATe = true
Equivalent Softkeys Analysis > Limit Test > Limit Line

SCPI.CALCulate(Ch).SELected.LIMit.FAIL

Description Gets the limit test result.
Type Boolean (read only)

True: Fail
Parameter

False: Pass

The active trace of channel Ch,
Target

Ch: channel number 1-16

Syntax Status = app.SCPI.CALCulate(Ch).SELected.LIMit.FAIL
Equivalent Softkeys None
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SCPI.CALCulate(Ch).SELected.LIMit.OFFSet.AMPLitude

Description Sets/gets the value of the limit line offset along Y -axis.
Type Double (read/write)
Range Varies depending on the trace format.

Preset Value 0
Unit dB|°|s

The active trace of channel Ch,
Target

Ch:  channel number 1-16

Value = app.SCPI.CALCulate(Ch).SELected.LIMit.OFFSet. AMPLitude
Syntax

app.SCPI.CALCulate(Ch).SELected.LIMit.OFFSet. AMPLitude = -10
Equivalent Softkeys | Analysis > Limit Test > Limit Line Offsets > Response Offset

SCPI.CALCulate(Ch).SELected.LIMit.OFFSet.MARKer

Sets the value of the limit line offset along Y-axis to the active

Description

marker value.
Type Method

The active trace of channel Ch,
Target

Ch: channel number 1-16

Syntax app.SCPI.CALCulate(Ch).SELected.LIMit.OFFSet. MARKer
Equivalent Softkeys Analysis > Limit Test > Limit Line Offsets > Marker > Response Ofs
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SCPI.CALCulate(Ch).SELected.LIMit.OFFSet.STIMulus

Description Sets/gets the value of the limit line offset along X-axis.

Type Double (read/write)

Range From the stimulus current start value to the stimulus current stop value.
Preset Value 0

Unit Hz|s| dBm

The active trace of channel Ch,

Target
Ch: channel number 1-16

Value = app.SCPI.CALCulate(Ch).SELected.LIMit.OFFSet.STIMulus
app.SCPI.CALCulate(Ch).SELected.LIMit.OFFSet.STIMulus = 1e6

Syntax

Equivalent Softkeys | Analysis > Limit Test > Limit Lines Offsets > Stimulus Offset
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SCPI.CALCulate(Ch).SELected.LIMit.REPort.ALL

Gets the data array, which is the limit test results. The array size is
4N, where N is the number of measurement points.

For the n-th point, where n from 1 to N:
Data(4n-3)  the stimulus value in the n-th point
Data(4n-2) the limit test result in the n-th
point
Description -1: No limit
0: Fail
1. Pass

Data(4n-1)  the upper limit value in the n-th point (0 - if
there is no limit)

Data(4n-0)  the lower limit value in the n-th point (0 - if
there is no limit)

Type Variant: array of double (read only)

The active trace of channel Ch,

Target
Ch: channel number 1-16

Syntax Data = app.SCPI.CALCulate(Ch).SELected.LIMit.REPort. ALL

Equivalent Softkeys | None

SCPI.CALCulate(Ch).SELected.LIMit.REPort.DATA

Gets the data array, which is the stimulus values at all the
Description measurement points that failed the limit test. The array size is
defined by the SCPI.CALCulate(Ch).SELected.LIMit.REPort.POINts
command.
Type Variant: array of double (read only)
The active trace of channel Ch,
Target
Ch:  channel number 1-16
Syntax Data = app.SCPI.CALCulate(Ch).SELected.LIMit.REPort.DATA
Equivalent Softkeys None
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SCPI.CALCulate(Ch).SELected.LIMit.REPort.POINts

Gets the number of the measurement points that failed the limit
test.

Description
The array of stimulus values of the points can be read out by the
SCPI.CALCulate(Ch).SELected.LIMit.REPort. DATA command.
Type Long (read only)
The active trace of channel Ch,
Target
Ch:  channel number 1-16
Syntax Cnt = app.SCPI.CALCulate(Ch).SELected.LIMit.REPort.POINts
Equivalent Softkeys None

SCPI.CALCulate(Ch).SELected.LIMit.STATe

Description

Turns ON/OFF the state of the limit test function.

Type

Boolean (read/write)

Parameter

True: Limit test function ON
False: Limit test function OFF

Preset Value

False

The active trace of channel Ch,

Target
Ch:  channel number 1-16
Status = app.SCPI.CALCulate(Ch).SELected.LIMit.STATe
Syntax
app.SCPI.CALCulate(Ch).SELected.LIMit.STATe = true
Equivalent Softkeys Analysis > Limit Test > Limit Test
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).ACTivate

Sets the active marker. If a marker is OFF this function will turn it
ON.

Turning ON a marker with the number from 1 to 15 will turn ON

Description all the markers of smaller numbers. Turning ON the reference
marker with number 16 does not turn ON the markers with the
numbers from 1 to 15, but switches these markers to the relative
measurement mode.

Type Method
Marker Mk of the active trace of channel Ch,

Target Ch: channel number 1-16

Mk:  marker number 1-15, or reference marker number 16

Syntax app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).ACTivate
Markers > Select > Marker n

Equivalent Softkeys

Markers > Reference Marker
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).BWIDth.DATA

Description

Gets the bandwidth search result. The bandwidth search can be
performed relatively to the marker Mk, or relatively to the absolute
maximum value of the trace (in this case the marker number is
ignored), what is set by the
SCPI.CALCulate(Ch).SELected.MARKer(Mk).BWIDth.REFerence
command.

The array contains 4 elements:
Data(0) Bandwidth;
Data(1) Center frequency;
Data(2) Q value;

Data(3) Loss.

Type

Variant: array of double (read only)

Notes

If the bandwidth search is impossible, all the read out values are 0. If the
search is performed relatively to a maker, which is OFF, an error occurs
(error code 204).

Target

Marker Mk of the active trace of channel Ch,
Ch: channel number 1-16
Mk:  marker number 1-15, or reference marker number 16

Syntax

Data = app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).BWIDth.DATA

Equivalent Softkeys

None
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SCPI.CALCulate(Ch).SELected.MARKer(1).BWIDth.REFerence

Sets/gets the selection of the reference point for the bandwidth

Description search function: reference marker or absolute maximum value of
the trace.
Type String (read/write)
"MARKer" : Bandwidth search relative to the reference marker
Parameter "MAXimum" : Bandwidth search relative to the absolute maximum of

the trace

Preset Value

"MAX"

The active trace of channel Ch,

Target
Ch:  channel number 1-16
Param = app.SCPI.CALCulate(Ch).SELected.MARKer.BWIDth.REFerence
Syntax
app.SCPI.CALCulate(Ch).SELected.MARKer.BWIDth.REFerence = "marker”
Warning Object MARKer has an index of 1, which can be omitted in Visual Basic

but it cannot be omitted in other programming languages.

Equivalent Softkeys

Markers > Marker Math > Bandwidth Search > Search Ref To
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SCPI.CALCulate(Ch).SELected.MARKer(1).BWIDth.STATe

Description Turns ON/OFF the state of the bandwidth search function.

Type Boolean (read/write)

True: Bandwidth search function ON

Parameter . .
False:  Bandwidth search function OFF
Preset Value False
The active trace of channel Ch,
Target
Ch: channel number 1-16
Status = app.SCPI.CALCulate(Ch).SELected.MARKer.BWIDth.STATe
Syntax
app.SCPI.CALCulate(Ch).SELected.MARKer.BWIDth.STATe = true
Warning Object MARKer has an index of 1, which can be omitted in Visual Basic

but it cannot be omitted in other programming languages.

Equivalent Softkeys Markers > Marker Math > Bandwidth Search > Bandwidth Search
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SCPI.CALCulate(Ch).SELected.MARKer(1).BWIDth.THReshold

Sets/gets the bandwidth definition value for the bandwidth search

Description :
function.
Type Double (read/write)
Range Varies depending on the trace format.

Preset Value -3
Unit dB|°|s

The active trace of channel Ch,
Target

Ch:  channel number 1-16

Value = app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).BWIDth.THReshold
Syntax

app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).BWIDth.THReshold = -6.0
Warnin Object MARKer has an index of 1, which can be omitted in Visual Basic

I but it cannot be omitted in other programming languages.

Equivalent Softkeys Markers > Marker Math > Bandwidth Search > Bandwidth Value

SCPI.CALCulate(Ch).SELected.MARKer(1).BWIDth.TYPE

Description Sets/gets the type of the bandwidth search function.
Type String (read/write)
"BPASs" : Bandpass
Parameter
"NOTCh" : Notch
Preset Value "BPAS"

The active trace of channel Ch,

Target
Ch:  channel number 1-16
Param = app.SCPI.CALCulate(Ch).SELected.MARKer.BWIDth.TYPE
Syntax
app.SCPI.CALCulate(Ch).SELected.MARKer.BWIDth.TYPE = "notc”
Equivalent Softkeys Markers > Marker Math > Bandwidth Search > Type
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SCPI.CALCulate(Ch).SELected.MARKer(1).COUPle

Description Turns ON/OFF the state of the marker coupling between traces.
Type Boolean (read/write)

True: Marker coupling ON
Parameter

False:  Marker coupling OFF

Preset Value

True

All traces of channel Ch,

Target
e Ch:  channel number 1-16
Status = app.SCPI.CALCulate(Ch).SELected.MARKer.COUPle
Syntax
app.SCPI.CALCulate(Ch).SELected.MARKer.COUPLe = false
Equivalent Softkeys Marker > Properties > Marker Couple
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SCPI.CALCulate(Ch).SELected.MARKer(1).COUNt

Sets/gets the number of the turned ON markers. Writing value
from 1 to 15 will turn ON regular markers. Writing value 16 will

Description turn ON 15 regular markers and the reference marker. Turning ON
the reference marker switches all markers to the relative
measurement mode.

Type Long (read/write)

Range from O to 16

Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

The active trace of channel Ch,

Target
e Ch:  channel number 1-16
MarkerCnt = app.SCPI.CALCulate(Ch).SELected.MARKer.COUNt
Syntax
app.SCPI.CALCulate(Ch).SELected.MARKer.COUNt = 5
Warnin Object MARKer has an index of 1, which can be omitted in Visual Basic
I but it cannot be omitted in other programming languages.
Equivalent Softkeys None
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SCPI.CALCulate(Ch).SELected.MARKer(1).DISCrete

Description Turns ON/OFF the state of the marker discrete mode.
Type Boolean (read/write)

True: Marker discrete mode ON
Parameter

False:  Marker discrete mode OFF

Preset Value

False

All traces of channel Ch (if the coupling is set to ON by the
SCPI.CALCulate(Ch).SELected.MARKer(1).COUPle command), the active

Target . .
trace of channel Ch (if otherwise),
Ch:  channel number 1-16
Status = app.SCPI.CALCulate(Ch).SELected.MARKer.DISCrete
Syntax
app.SCPI.CALCulate(Ch).SELected.MARKer.DISCrete = false
Warning Object MARKer has an index of 1, which can be omitted in Visual Basic
but it cannot be omitted in other programming languages.
Equivalent Softkeys Marker > Properties > Discrete
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).DATA

Gets the response and stimulus value of the marker. If the
reference marker is turned ON, the values of the markers from 1 to
15 are read out as relative values to the reference marker.

The array includes 3 elements:

Description Data(0) real number in rectangular format, real part in
polar and Smith chart formats;
Data(1) 0 in rectangular format, imaginary part in polar
and Smith chart formats.
Data(2) Stimulus value at the marker position.
(S4VNA Only)
Type Variant: array of double (read only)
Marker Mk of the active trace of channel Ch,
Target Ch: channel number 1-16
Mk:  marker number 1-15, or reference marker number 16
Syntax Data = app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).DATA
Equivalent Softkeys None
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SCPI.CALCulate(Ch).SELected.MARKer(1).DATA

Gets the data array of all turned ON markers. The array size is 3N +
1, where N is the number of turned ON markers including the
reference marker. If reference marker is turned ON the last three
elements of array contain the reference marker data and the rest
elements of array contain the relative values.

For the n-th marker, where n from 1 to N:

Data(0) the number of turned ON markers including the
Description reference marker;
Data(3n-2)  the stimulus value of the n-th marker;
Data(3n-1) the real data in rectangular format, real part in
polar and Smith chart formats of the n-th
marker;
Data(3n-0) 0 in rectangular format, imaginary part in polar
and Smith chart formats of the n—-th marker;
(S2VNA only)
Type Variant: array of double (read only)
The active trace of channel Ch,
Target
Ch:  channel number 1-16
Syntax Data = app.SCPI.CALCulate(Ch).SELected.MARKer.DATA
Warning Object MARKer has an index of 1, which can be omitted in Visual Basic
but it cannot be omitted in other programming languages.
Equivalent Softkeys | None
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SCPI.CALCulate(Ch).SELected.MARKer(1).FUNCtion.DOMain.COUPle

Description Turns ON/OFF the state of the marker search range coupling for
different traces.
Type Boolean (read/write)
True: Marker search range coupling ON
Parameter .
False:  Marker search range coupling OFF
Preset Value True
All traces of channel Ch,
Target
Ch:  channel number 1-16
Status = app.SCPI.CALCulate(Ch).SELected.MARKer.FUNCtion.DOMain. COUPLle
Syntax
app.SCPI.CALCulate(Ch).SELected.MARKer.FUNCtion.DOMain.COUPLe = false
Warning Object MARKer has an index of 1, which can be omitted in Visual Basic
but it cannot be omitted in other programming languages.
Equivalent Softkeys Markers > Marker Search > Couple
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SCPI.CALCulate(Ch).SELected.MARKer(1).FUNCtion.DOMain.STARt

Description Sets/gets the start value of the marker search range.
Type Double (read/write)
Range From the stimulus current start value to the stimulus current stop value.

Preset Value

Minimum frequency

Unit Hz|s| dBm

All traces of channel Ch (if the marker search range coupling is set to ON
et by the SCPI.CALCulate(Ch).SELected.FUNCtion.DOMain.COUPLe

I command), the active trace of channel Ch (if otherwise),
Ch:  channel number 1-16

Value = app.SCPI.CALCulate(Ch).SELected.MARKer.FUNCtion.DOMain.STARt
Syntax

app.SCPI.CALCulate(Ch).SELected.MARKer.FUNCtion.DOMain.STARt = 1e6

. Object MARKer has an index of 1, which can be omitted in Visual Basic

Warning . . i .

but it cannot be omitted in other programming languages.
Equivalent Softkeys Markers > Marker Search > Search Start

104




SCPI.CALCulate(Ch).SELected.MARKer(1).FUNCtion.DOMain.STATe

Turns ON/OFF the state of the arbitrary range when executing the

Description

marker search.
Type Boolean (read/write)

True: Marker search range ON
Parameter

False:  Marker search range OFF (entire sweep range)

Preset Value

False

All traces of channel Ch (if the marker search range coupling is set to ON
by the SCPI.CALCulate(Ch).SELected.MARKer.FUNCtion.DOMain.COUPle

Target
e command), the active trace of channel Ch (if otherwise),
Ch:  channel number 1-16
Status = app.SCPI.CALCulate(Ch).SELected.MARKer.FUNCtion.DOMain.STATe
Syntax
app.SCPI.CALCulate(Ch).SELected.MARKer.FUNCtion.DOMain.STATe = true
Waring Object MARKer has an index of 1, which can be omitted in Visual Basic
but it cannot be omitted in other programming languages.
Equivalent Softkeys Markers > Marker Search > Search Range
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SCPI.CALCulate(Ch).SELected.MARKer(1).FUNCtion.DOMain.STOP

Description Sets/gets the stop value of the marker search range.
Type Double (read/write)
Range From the stimulus current start value to the stimulus current stop value.

Preset value

Maximum frequency

Unit Hz|s| dBm
All traces of channel Ch (if the marker search range coupling is set to ON
Target by the SCPI.CALCulate(Ch).SELected.MARKer.FUNCtion.DOMain.COUPLe
command), the active trace of channel Ch (if otherwise),
Ch:  channel number 1-16
Value = app.SCPI.CALCulate(Ch).SELected.MARKer.FUNCtion.DOMain.STOP
Syntax
app.SCPI.CALCulate(Ch).SELected.MARKer.FUNCtion.DOMain.STOP = 1e6
Warning Object MARKer has an index of 1, which can be omitted in Visual Basic
but it cannot be omitted in other programming languages.
Equivalent Softkeys Markers > Marker Search > Search Stop
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.EXECute

Executes the marker search according to the specified criterion.
The type of the marker search is set by the

Description .
SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.TYPE
command.

Type Method
Marker Mk of the active trace of channel Ch,

Target Ch: channel number 1-16

Mk:  marker number 1-15, or reference marker number 16

Syntax app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.EXECute
Markers > Marker Search > Maximum | Minimum
Markers > Marker Search > Peak > Search Peak | Search Max Peak |

Equivalent Softkeys Search Peak Left | Search Peak Right

Markers > Marker Search > Target > Search Target | Search Target Left |

Search Target Right
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.PEXCursion

Sets/gets the peak excursion value, when the marker search for
peak is performed by the

Descripti
e SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.EXECute
method.
Type Double (read/write)
Marker Mk of the active trace of channel Ch,
Target Ch:  channel number 1-16
Mk:  marker number 1-15, or reference marker number 16
Range Varies depending on the trace format.

Preset Value

Unit dB (decibel) | ° (degree) | s (second)

Value = app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.PEXCursion
Syntax

app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.PEXCursion = 3.0
Equivalent Softkeys Markers > Marker Search > Peak > Peak Excursion
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.PPOLarity

Sets/gets the peak polarity selection, when the marker search for
peak is performed by the

Description .
SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.EXECute
method.

Type String (read/write)

Parameter

"POSitive” : Positive polarity
"NEGative” : Negative polarity
"BOTH" : Both positive polarity and negative polarity

Preset Value

"POS”

Marker Mk of the active trace of channel Ch,

Target Ch: channel number 1-16
Mk:  marker number 1-15, or reference marker number 16
Param = app.SCPI.CALCulate(Ch).SELected. MARKer(Mk).FUNCtion.PPOLarity
Syntax
app.SCPI.CALCulate(Ch).SELected. MARKer(Mk).FUNCtion.PPOLarity = "neg"
, Markers > Marker Search > Peak > Peak Polarity > Positive | Negative |
Equivalent Softkeys

Both
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.TARGet

Sets/gets the target value, when the marker search for target is
performed by the

Description .
SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.EXECute
method.

Type Double (read/write)

Range Varies depending on the trace format.

Preset Value

Unit dB (decibel) | ° (degree) | s (second)

Marker Mk of the active trace of channel Ch,
Target Ch: channel number 1-16

Mk:  marker number 1-15, or reference marker number 16

Value = app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.TARGet
Syntax

app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.TARGet = -10
Equivalent Softkeys Markers > Marker Search > Target > Target Value
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.TRACking

Description Turns ON/OFF the state of the marker search tracking function.
Type Boolean (read/write)

True: Marker search tracking ON
Parameter

False:  Marker search tracking OFF

Preset Value

False

Marker Mk of the active trace of channel Ch,

Target Ch:  channel number 1-16
Mk:  marker number 1-15, or reference marker number 16
Status = app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.TRACking
Syntax
app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.TRACking = true
Equivalent Softkeys Markers > Marker Search > Tracking
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.TTRansition

Sets/gets the selection of the type of the target transition, when
the marker search for transition is performed by the

Description .
SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.EXECute
method.

Type String (read/write)

"POSitive” : Positive target transition
"NEGative” : Negative target transition

Parameter
"BOTH" :  Both positive target transition and negative target

transition

Preset Value "POS”

Marker Mk of the active trace of channel Ch,

Target Ch:  channel number 1-16
Mk:  marker number 1-15, or reference marker number 16
Param = app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.TTRansition
Syntax
app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.TTRansition = "neg”
Equivalent Softkeys | Marker > Marker Search > Target > Target Transition
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.TYPE

Sets/gets the selection of the type of the marker search, which is
performed by the

Descripti
e SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.EXECute
method.
Type String (read/write)
"MAXimum" : Maximum value search
"MINimum” : Minimum value search
"PEAK" . Peak search
Parameter "LPEak" . Peak search to the left from the marker
"RPEak" : Peak search to the right from the marker
"TARGet" : Target search
"LTARget" : Target search to the left from the marker
"RTARget" : Target search to the right from the marker
Preset Value "MAX"

Marker Mk of the active trace of channel Ch,

Target Ch: channel number 1-16
Mk:  marker number 1-15, or reference marker number 16

Param = app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.TYPE
Syntax

app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).FUNCtion.TYPE = "MIN"

Markers > Marker Search > Maximum | Minimum

Markers > Marker Search > Peak > Search Peak | Search Max Peak |
Equivalent Softkeys Search Peak Left | Search Peak Right

Markers > Marker Search > Target > Search Target | Search Target Left |
Search Target Right
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SCPI.CALCulate(Ch).SELected.MARKer(1).MATH.FLATness.DATA

Reads out the FLATNESS function data array. The FLATNESS
function is applied within the range determined by two markers

(see
SCPI.CALCulate(Ch).SELected.MARKer.MATH.FLATness.DOMain.STARt
and SCPI.CALCulate(Ch).SELected.MARKer.MATH.FLATness.DOMain.STOP

properties).

Description .
The array includes 4 elements:
Data(0) Span;
Data(1) Gain;
Data(2) Slope;
Data(3) Flatness.
Type Variant: array of double (read only)
The active trace of channel Ch,
Target
Ch:  channel number 1-16
Syntax Data = app.SCPI.CALCulate(Ch).SELected.MARKer.MATH.FLATness.DATA
) Object MARKer has an index of 1, which can be omitted in Visual Basic
Warning . . . .
but it cannot be omitted in other programming languages.
Equivalent Softkeys None
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SCPI.CALCulate((#).SELected.MARKer(1).MATH.FLATness.DOMain.STARt

Sets/gets the number of the marker, which specifies the start

pescrition frequency of the FLATNESS function range.

Type Long (read/write)

Range from 1 to 16

Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

The active trace of channel Ch,

Target
Ch: channel number 1-16
MkrNum =
Syntax app.SCPI.CALCulate(Ch).SELected. MARKer.MATH.FLATness.DOMain.STARt
app.SCPI.CALCulate(Ch).SELected. MARKer.MATH.FLATness.DOMain.STARt = 1
Waring Object MARKer has an index of 1, which can be omitted in Visual Basic
but it cannot be omitted in other programming languages.
Equivalent Softkeys Markers > Marker Math > Flatness > Flatness Start
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SCPI.CALCulate((#).SELected.MARKer(1).MATH.FLATness.DOMain.STOP

Sets/gets the number of the marker, which specifies the stop

Description .
frequency of the FLATNESS function range.

Type Long (read/write)

Range from 1 to 16

Out of Range

Sets the value of the limit, which is closer to the specified value.

Preset Value

The active trace of channel Ch,

Target
Ch:  channel number 1-16
MkrNum =
Syntax app.SCPI.CALCulate(Ch).SELected.MARKer.MATH.FLATness.DOMain.STOP
app.SCPI.CALCulate(Ch).SELected.MARKer.MATH.FLATness.DOMain.STOP = 1
Warning Object MARKer has an index of 1, which can be omitted in Visual Basic
but it cannot be omitted in other programming languages.
Equivalent Softkeys | Markers > Marker Math > Flatness > Flatness Stop
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SCPI.CALCulate(Ch).SELected.MARKer(1).MATH.FLATness.STATe

Description Turns ON/OFF the state of the FLATNESS function.
Type Boolean (read/write)

True: FLATNESS function ON
Parameter

False: FLATNESS function OFF

Preset Value

False

The active trace of channel Ch,

Target
e Ch:  channel number 1-16

Status = app.SCPI.CALCulate(Ch).SELected.MARKer.MATH.FLATness.STATe

Syntax
app.SCPI.CALCulate(Ch).SELected.MARKer.MATH.FLATness.STATe = true

Warning Object MARKer has an index of 1, which can be omitted in Visual Basic
but it cannot be omitted in other programming languages.

Equivalent Softkeys Markers > Marker Math > Flatness > Flatness

117




SCPI.CALCulate(Ch).SELected.MARKer(1).REFerence.STATe

Turns ON/OFF the state of the reference marker. When the

Description reference marker is turned ON, all the values of the other markers
turn to relative values.

Type Boolean (read/write)
True: Reference marker ON

Parameter

False: Reference marker OFF

Preset Value

False

The active trace of channel Ch,

Target
Ch:  channel number 1-16
Status = app.SCPI.CALCulate(Ch).SELected.MARKer.REFerence.STATe
Syntax
app.SCPI.CALCulate(Ch).SELected.MARKer.REFerence.STATe = true
Warning Object MARKer has an index of 1, which can be omitted in Visual Basic
but it cannot be omitted in other programming languages.
Equivalent Softkeys Markers > Reference Marker
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).SET

SCPI.CALCulate(Ch).SELected.MARKer(Mk).POSition

Sets the value of the specified item to the value of the position of

Description
the marker.
Type String (write only)
"STARt" : Sweep start value set to the stimulus value of the marker
position.
"STOP" : Sweep stop value set to the stimulus value of the marker
position.
Parameter "CENTer" : Sweep center value set to the stimulus value of the marker
position.
"RLEVel" : Reference value set to the response value of the marker
position.
"DELay" :Delay value set to the response value of the marker position.
Marker Mk of the active trace of channel Ch,
Target Ch:  channel number 1-16
Mk:  marker number 1-15, or reference marker number 16
app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).POSition = "STOP"
Syntax
app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).SET = "STOP"
, Markers > Marker Functions > Marker->Start | Marker->Stop |
Equivalent Softkeys

Marker ->Center | Marker->Ref Value | Marker->Delay
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).STATe

Turns ON/OFF the marker. Turning ON a marker with the number
from 1 to 15 will turn ON all the markers of smaller numbers.
Turning OFF a marker with the number from 1 to 15 will turn OFF

Description all the markers of greater numbers (except for the reference
marker). Turning ON/OFF the reference marker with number 16
does not turn ON/OFF the markers with the numbers from 1 to 15,
but switches these markers to the relative measurement mode.

Type Boolean (read/write)

Parameter

True: Marker ON
False: Marker OFF

Preset Value

False

Marker Mk of the active trace of channel Ch,

Target Ch: channel number 1-16
Mk:  marker number 1-15, or reference marker number 16
Status = app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).STATe
Syntax
app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).STATe = true
) Markers > Add Marker | Remove Marker
Equivalent Softkeys

Markers > Reference Marker
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).X

Description Sets/gets the stimulus value of the marker.

Type Double (read/write)

Range From the stimulus current start value to the stimulus current stop value.
Out of Value Sets the value of the limit, which is closer to the specified value.

Preset Value

Stimulus center value

Unit Hz|s| dBm
Marker Mk of the active trace of channel Ch,
Target Ch: channel number 1-16
Mk:  marker number 1-15, or reference marker number 16
Value = app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).X
Syntax
app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).X = 1e9
Equivalent Softkeys Markers > Edit Stimulus
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SCPI.CALCulate(Ch).SELected.MARKer(Mk).Y

Reads out the response value of the marker. If the reference
marker is turned ON, the values of the markers from 1 to 15 are
read out as relative values to the reference marker.

The array includes 2 elements:

Description
Data(0) real number in rectangular format, real part in
polar and Smith chart formats;
Data(1) 0 in rectangular format, imaginary part in polar
and Smith chart formats.
Type Variant: array of double (read only)
Marker Mk of the active trace of channel Ch,
Target Ch:  channel number 1-16
Mk:  marker number 1-15, or reference marker number 16
Syntax Data = app.SCPI.CALCulate(Ch).SELected.MARKer(Mk).Y
Equivalent Softkeys None

122




SCPI.CALCulate(Ch).SELected.MATH.FUNCtion

Sets/gets the selection of the math operation between the
measurement data and the memory trace data. The math result

Description .
replaces the data trace. If the data trace is not saved, the command
is ignored.
Type String (read/write)
"DIVide" : Division Data /Mem.
"MULTiply" : Multiplication Data x Mem.
Parameter "ADD" : Addition Data + Mem.

"SUBTract” : Subtraction Data — Mem.
"NORMal" : No math

Preset Value

"NORM”

The active trace of channel Ch,

Target
Ch: channel number 1-16
Param = app.SCPI.CALCulate(Ch).SELected.MATH.FUNCtion
Syntax
app.SCPI.CALCulate(Ch).SELected. MATH.FUNCtion= "DIV"
_ Display > Data Math > Data/Mem | Data*Mem | Data+Mem | Data-Mem |
Equivalent Softkeys

OFF

SCPI.CALCulate(Ch).SELected.MATH.MEMorize

Saves the measurement data to the memory trace. Automatically

Description .

turns on the display of the memory trace.
Type Method

The active trace of channel Ch,
Target

Ch:  channel number 1-16

Syntax app.SCPI.CALCulate(Ch).SELected.MATH.MEMorize
Equivalent Softkeys Display > Data—>Memory
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SCPI.CALCulate(Ch).SELected.MSTatistics.DATA

Read out the math statistics data array. The statistics function is
applied either over the whole range (for all the trace), or within the
range specified by the
SCPI.CALCulate(Ch).SELected.MSTatistics.DOMain.STATe command
(the range limits are determined by two markers).

Description The array includes 3 elements:

Data(0) Mean value;

Data(1) Standard deviation;

Data(2) Peak-to-peak  (difference  between the

maximum value and the minimum value).
Type Variant: array of double (read only)
The active trace of channel Ch,
Target
Ch:  channel number 1-16

Syntax Data = app.SCPI.CALCulate(Ch).SELected.MSTatistics.DATA
Equivalent Softkeys None
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SCPI.CALCulate(Ch).SELected.MSTatistics.DOMain.MARKer.STARt

Sets/gets the number of the marker, which specifies the start

pescripron frequency of the math statistics range.

Type Long (read/write)

Range from 1 to 16

Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

The active trace of channel Ch,

Target
Ch:  channel number 1-16
MkrNum = app.SCPI.CALCulate(Ch).SELected.MSTatistics.DOMain.MARKer.STARt
Syntax
app.SCPI.CALCulate(Ch).SELected.MSTatistics.DOMain.MARKer.STARt = 3
Equivalent Softkeys Markers > Marker Math > Statistics > Statistics Start

SCPI.CALCulate(Ch).SELected.MSTatistics.DOMain.MARKer.STOP

Sets/gets the number of the marker, which specifies the stop

Description L.
frequency of the math statistics range.
Type Long (read/write)
Range from1to 16
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

The active trace of channel Ch,

Target
Ch:  channel number 1-16
MarkerNum =
Syntax app.SCPI.CALCulate(Ch).SELected.MSTatistics.DOMain.MARKer.STOP
app.SCPI.CALCulate(Ch).SELected.MSTatistics.DOMain.MARKer.STOP = 4
Equivalent Softkeys Markers > Marker Math > Statistics > Statistics Stop
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SCPI.CALCulate(Ch).SELected.MSTatistics.DOMain.STATe

Description Turns ON/OFF the state of the math statistics range.

Type Boolean (read/write)

True: Statistics range ON

Parameter i
False:  Statistics range OFF
Preset Value False
Tarcet The active trace of channel Ch,
? Ch:  channel number 1-16
Status = app.SCPI.CALCulate(Ch).SELected.MSTatistics.DOMain.STATe
Syntax

app.SCPI.CALCulate(Ch).SELected. MSTatistics.DOMain.STATe = true

Equivalent Softkeys Markers > Marker Math > Statistics > Statistics Range

SCPI.CALCulate(Ch).SELected.MSTatistics.STATe

Description Turns ON/OFF the state of the math statistics display.

Type Boolean (read/write)

True: Statistics display ON

Parameter L. .

False:  Statistics display OFF
Preset Value False

The active trace of channel Ch,
Target

Ch:  channel number 1-16

Status = app.SCPI.CALCulate(Ch).SELected.MSTatistics.STATe

Syntax

app.SCPI.CALCulate(Ch).SELected.MSTatistics.STATe = true

Equivalent Softkeys Markers > Marker Math > Statistics > Statistics
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SCPI.CALCulate(Ch).SELected. RLIMit.DATA

Description

Sets/gets the data array, which is the limit line for the ripple limit
function. The array size is 1 + 4N, where N is the number of limit
line segments.

For the n—-th point, where n from 1 to N:

Data(0) the number of limit line segments N is the
integer from 0 to 12. Setting O clears the limit
line;

Data(4n-3) type of the n—th limit line segment;

0: Off
1:0n

Data(4n-2)  the stimulus value in the beginning point of the
n-th segment;

Data(4n-2)  the stimulus value in the end point of the n-th
segment;

Data(4n-0)  the ripple limit value of the n-th segment.

Type

Variant: array of double (read/write)

Notes

If the array size is not 1 + 4N, where N is Data(0), an error occurs (error
code 214). If Data(4n - 3) is less than 0 or more than 1, an error occurs
(error code 214). When Data(4n-2), Data(4n-1), and Data(4n-0) elements
are out of allowable range, the value is set to the limit, which is closer to
the specified value.

Target

The active trace of channel Ch,
Ch: channel number 1-16

Syntax

Data = app.SCPI.CALCulate(Ch).SELected.RLIMit.DATA
app.SCPI.CALCulate(Ch).SELected.RLIMit.DATA = Array(1,1,800,900,10)

Equivalent Softkeys

Analysis > Ripple Limit > Edit Ripple Limit
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SCPI.CALCulate(Ch).SELected.RLIMit.DISPlay.LINE

Description Turns ON/OFF the state of the ripple limit line display.
Type Boolean (read/write)
Parameter True: Ripple limit line ON

False:  Ripple limit line OFF

Preset Value

False

The active trace of channel Ch,

Target
Ch:  channel number 1-16
Status = app.SCPI.CALCulate(Ch).SELected.RLIMit.DISPlay.LINE
Syntax
app.SCPI.CALCulate(Ch).SELected.RLIMit.DISPlay.LINE = true
Equivalent Softkeys | Analysis > Ripple Limit > Ripple Limit

SCPI.CALCulate(Ch).SELected.RLIMit.DISPlay.SELect

Sets/gets the number of the ripple limit test band selected for the

Deseription ripple value display.

Type Long (read/write)

Range from 1 to 12

Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

The active trace of channel Ch,

Target
Ch: channel number 1-16
Value = app.SCPI.CALCulate(Ch).SELected.RLIMit.DISPlay.SELect
Syntax
app.SCPI.CALCulate(Ch).SELected.RLIMit.DISPlay.SELect = 2
Equivalent Softkeys Analysis > Ripple Limit > Ripple Value Band
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SCPI.CALCulate(Ch).SELected.RLIMit.DISPlay.VALue

Description

Sets/gets the selection of the display type of the ripple value in
the specified band.

Type

String (read/write)

Parameter

"OFF" : Ripple value display OFF
"ABSolute” : Absolute value

"MARgin"  : Margin (difference between the ripple limit and the
absolute value)

Preset Value

"OFF"

The active trace of channel Ch,

Target
Ch:  channel number 1-16
Param = app.SCPI.CALCulate(Ch).SELected.RLIMit.DISPlay.VALue
Syntax
app.SCPI.CALCulate(Ch).SELected.RLIMit.DISPlay.VALue = "ABS"
Equivalent Softkeys | Analysis > Ripple Limit > Ripple Value

SCPI.CALCulate(Ch).SELected.RLIMit.FAIL

Description Reads out the Ripple limit test result.
Type Boolean (read only)

True: Fail
Parameter

False:  Pass

The active trace of channel Ch,
Target

Ch:  channel number 1-16

Syntax Status = app.SCPI.CALCulate(Ch).SELected.RLIMit.FAIL
Equivalent Softkeys None
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SCPI.CALCulate(Ch).SELected.RLIMit.REPort.DATA

Reads out the data array, which is the ripple limit test results. The
array size is 1+3N, where N is the number of ripple limit bands.

For the n-th point, where n from 1 to N:

Data(0) N total number of the bands;
Description Data(3n-2) n number of the band;
Data(3n-1) Ripple value in the n-th band;
Data(3n-0)  Ripple limit test result in the n-th band:
0: Pass
1: Fail
Type Variant: array of double (read only)
The active trace of channel Ch,
Target
Ch:  channel number 1-16
Syntax Data = app.SCPI.CALCulate(Ch).SELected.RLIMit.REPort.DATA
Equivalent Softkeys None

SCPIL.CALCulate(Ch).SELected.RLIMit.STATe

Description

Turns ON/OFF the state of the ripple limit test.

Type

Boolean (read/write)

Parameter

True: Ripple limit test ON
False:  Ripple limit test OFF

Preset Value

False

The active trace of channel Ch,

Target
Ch:  channel number 1-16
Status = app.SCPI.CALCulate(Ch).SELected.RLIMit.STATe
Syntax
app.SCPI.CALCulate(Ch).SELected.RLIMIit.STATe = true
Equivalent Softkeys Analysis > Ripple Limit > Ripple Test
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SCPI.CALCulate(Ch).SELected.SMOothing.APERture

Description Sets/gets the smoothing aperture for the smoothing function.
Type Double (read/write)

Range from 0.01 to 20

Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Unit %

The active trace of channel Ch,
Target

Ch: channel number 1-16

Value = app.SCPI.CALCulate(Ch).SELected.SMOothing.APERture
Syntax

app.SCPI.CALCulate(Ch).SELected.SMOothing.APERture = 1.5
Equivalent Softkeys Average > Smo Aperture

SCPIL.CALCulate(Ch).SELected.SMOothing.STATe

Description

Turns ON/OFF the state of the trace smoothing function.

Type

Boolean (read/write)

Parameter

True: Trace smoothing ON
False:  Trace smoothing OFF

Preset Value

False

The active trace of channel Ch,

Target
Ch:  channel number 1-16
Status = app.SCPI.CALCulate(Ch).SELected.SMOothing.STATe
Syntax
app.SCPI.CALCulate(Ch).SELected.SMOothing.STATe = true
Equivalent Softkeys Average > Smoothing
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SCPI.CALCulate(Ch).SELected. TRANsform.TIME.CENTer

Sets/gets the time (distance) domain center value, when the time

Description it . . .
domain transformation function is turned ON.

Type Double (read/write)

Range Varies depending on the specified frequency range and the number of
points.

Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Unit s (second) m (meters) or ft (feet)
The active trace of channel Ch,
Target
Ch:  channel number 1-16
Value = app.SCPI.CALCulate(Ch).SELected. TRANsform.TIME.CENTer
Syntax

app.SCPI.CALCulate(Ch).SELected. TRANsform. TIME.CENTer = 1e-8

RelatedComands

SCPI.CALCulate(Ch).SELected.TRANsform. TIME.UNIT

Equivalent Softkeys

Analysis > Time Domain > Center
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SCPI.CALCulate(Ch).SELected. TRANsform.TIME.IMPulse.WIDTh

Sets/gets the impulse width (time domain transformation
resolution), coupled with the Kaiser-Bessel window shape

Description . . .
parameter. The impulse width setting changes the B parameter,
and setting of B parameter changes the impulse width.
Type Double (read/write)
Range Varies depending on the specified frequency range and the number of
points.
Out of Range Sets the value of the limit, which is closer to the specified value.
Unit s (second)
The active trace of channel Ch,
Target
Ch:  channel number 1-16
Value = app.SCPI.CALCulate(Ch).SELected. TRANsform.TIME.IMPulse. WIDTh
Syntax
app.SCPI.CALCulate(Ch).SELected. TRANsform.TIME.IMPulse.WIDTh = 1e-8
_ Analysis > Time Domain > Window > Impulse Width (when the
Equivalent Softkeys

transformation type is set to Bandpass or Lowpass Impulse)
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SCPI.CALCulate(Ch).SELected. TRANsform.TIME.KBESsel

Sets/gets the [ parameter, which controls the Kaiser-Bessel

Description ] . . K .
window shape, when performing time domain transformation.

Type Double (read/write)

Range fromOto 13

Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value 6
Unit s (second)
Tarcet The active trace of channel Ch,
I Ch:  channel number 1-16
Value = app.SCPI.CALCulate(Ch).SELected. TRANsform.TIME.KBESsel
Syntax
app.SCPI.CALCulate(Ch).SELected. TRANsform. TIME.KBESsel = 13
Equivalent Softkeys Analysis > Time Domain > Window > Kaiser Beta

SCPI.CALCulate(Ch).SELected. TRANsform.TIME.LPFRequency

Changes the frequency range to match with the lowpass type of

Description A K . .

the time domain transformation function.
Type Method

The active trace of channel Ch,
Target

Ch: channel number 1-16

Syntax app.SCPI.CALCulate(Ch).SELected. TRANsform. TIME.LPFRequency
Equivalent Softkeys | Analysis > Time Domain > Set Frequency Low Pass
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SCPI.CALCulate(Ch).SELected. TRANsform.TIME.REFLection.TYPE

Sets/gets the selection of the reflection distance either one way or

Description . . . . .
round trip for the time domain transformation function.
Type String (read/write)
"RTRip" Round Trip
Parameter
"OWAY" One Way
Preset Value "RTRip"

The active trace of channel Ch,

Target
e Ch:  channel number 1-16 (see Table 1 on page 25)
Param = app.SCPI.CALCulate(Ch).SELected. TRANsform.TIME.REFLection.TYPE
Syntax
app.SCPI.CALCulate(Ch).SELected. TRANsform.TIME.REFLection.TYPE = "RTR"
Equivalent Softkeys Analysis > Time Domain >Reflection Type > Round Trip | One Way

135




SCPI.CALCulate(Ch).SELected. TRANsform.TIME.SPAN

Sets/gets the time (distance) domain span value, when the time

Description 1 . . .
domain transformation function is turned ON.

Type Double (read/write)

Range Varies depending on the specified frequency range and the number of
points.

Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

2e-8

Unit s (second) m (meters) or ft (feet)
The active trace of channel Ch,
Target
Ch:  channel number 1-16
Value = app.SCPI.CALCulate(Ch).SELected. TRANsform.TIME.SPAN
Syntax

app. SCPI.CALCulate(Ch).SELected. TRANsform. TIME.SPAN = 1e-8

Related Commands

SCPI.CALCulate(Ch).SELected. TRANsform. TIME.UNIT

Equivalent Softkeys

Analysis > Time Domain > Span
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SCPI.CALCulate(Ch).SELected. TRANsform.TIME.STARt

Sets/gets the start value used for the transformation function of
the time domain function.

Description . . . . .
The time (distance) domain start value, when the time domain
transformation function is turned ON.

Type Double (read/write)

Range Varies depending on the specified frequency range and the number of
points.

Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

-le-8

Unit s (second) m (meters) or ft (feet)
Tarcet The active trace of channel Ch,
! Ch:  channel number 1-16
Value = app.SCPI.CALCulate(Ch).SELected. TRANsform.TIME.STARt
Syntax

app.SCPI.CALCulate(Ch).SELected. TRANsform.TIME.STARt = 1e-8

Related Commands

SCPI.CALCulate(Ch).SELected. TRANsform. TIME.UNIT

Equivalent Softkeys

Analysis > Time Domain > Start
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SCPI.CALCulate(Ch).SELected. TRANsform.TIME.STATe

Turns ON/OFF the state of the time domain transformation

Description .

function.
Type Boolean (read/write)

True: Time domain transformation ON
Parameter

False:  Time domain transformation OFF

Preset Value

False

The active trace of channel Ch,

Target
e Ch:  channel number 1-16
Status = app.SCPI.CALCulate(Ch).SELected. TRANsform.TIME.STATe
Syntax
app.SCPI.CALCulate(Ch).SELected. TRANsform.TIME.STATe = true
Equivalent Softkeys Analysis > Time Domain > Time Domain
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SCPI.CALCulate(Ch).SELected. TRANsform.TIME.STEP.RTIMe

Sets/gets the rise time of the step signal (time domain
transformation resolution), coupled with the Kaiser-Bessel

Description window shape 3 parameter. The impulse width setting changes the
B parameter, and setting of B parameter changes the impulse
width.

Type Double (read/write)

Range Varies depending on the specified frequency range and the number of
points.

Out of Range Sets the value of the limit, which is closer to the specified value.

Unit s (second)

The active trace of channel Ch,
Target
Ch:  channel number 1-16
Value = app.SCPI.CALCulate(Ch).SELected. TRANsform.TIME.IMPulse.WIDTh

Syntax

app.SCPI.CALCulate(Ch).SELected. TRANsform. TIME.IMPulse. WIDTh = 1e-8
_ Analysis > Time Domain > Window > Impulse Width (when the
Equivalent Softkeys

transformation type is set to Lowpass Step)
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SCPI.CALCulate(Ch).SELected. TRANsform.TIME.STIMulus

Description

Sets/gets the selection of the stimulus type for the time domain
transformation function: impulse or step.

Type

String (read/write)

"IMPulse” Impulse
Parameter

"STEP" Step
Preset Value "IMP"

The active trace of channel Ch,

Target
e Ch:  channel number 1-16
Param = app.SCPI.CALCulate(Ch).SELected. TRANsform.TIME.STIMulus
Syntax
app.SCPI.CALCulate(Ch).SELected. TRANsform.TIME.STIMulus = "STEP"
o> Ti s
Equivalent Softkeys Analysis > Time Domain > Type > Bandpass | Lowpass Step | Lowpass

Impulse
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SCPI.CALCulate(Ch).SELected. TRANsform.TIME.STOP

Sets/gets the time (distance) domain stop value, when the time

Description 1 . . .
domain transformation function is turned ON.

Type Double (read/write)

Range Varies depending on the specified frequency range and the number of
points.

Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

le-8

Unit s (second) m (meters) or ft (feet)

The active trace of channel Ch,
Target

Ch:  channel number 1-16

Value = app.SCPI.CALCulate(Ch).SELected. TRANsform.TIME.STOP
Syntax

app.SCPI.CALCulate(Ch).SELected. TRANsform.TIME.STOP = 2e-8
Equivalent Softkeys | Analysis > Time Domain > Stop
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SCPI.CALCulate(Ch).SELected. TRANsform.TIME.TYPE

Sets/gets the selection of the transformation type for the time

Description domain transformation function: bandpass response or direct
current circuit.
Type String (read/write)

"BPASs" Bandpass
Parameter

"LPASs" Lowpass
Preset Value "BPASs”

The active trace of channel Ch,

Target
Ch:  channel number 1-16
Param = app.SCPI.CALCulate(Ch).SELected. TRANsform.TIME.TYPE
Syntax
app.SCPI.CALCulate(Ch).SELected. TRANsform.TIME.TYPE = "STEP"
Equivalent Softkeys Analysis > Time Domain > Type > Bandpass | Lowpass Step | Lowpass

Impulse
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SCPI.CALCulate(Ch).SELected. TRANsform.TIME.UNIT

Sets/gets the selection of the transformation unit for the time

Description ! . .
domain transformation function: seconds, meters, feet.
Type String (read/write)
"SEConds” Seconds
Parameter "METers" Meters
"FEET" Feet
Preset Value "SEConds"”

The active trace of channel Ch,

Target
Ch:  channel number 1-16
Param = app.SCPI.CALCulate(Ch).SELected. TRANsform. TIME.UNIT
Syntax
app.SCPI.CALCulate(Ch).SELected. TRANsform. TIME.UNIT = "MET"
Equivalent Softkeys Analysis > Time Domain > Unit > Seconds | Meters | Feet
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SCPI.CALCulate(Ch).TRACe(Tr).DATA.FDATa

Reads out or writes the formatted data array. The array elements
contain measurements in the current format, for example, in
logarithmic magnitude format (Log Mag). Also, see section 14.

The array size is 2N, where N is the number of measurement
points.

Description
For the n-th point, where n from 1 to N:
Data(Z2n-2)  real number in rectangular format, real part in
polar and Smith chart formats;
Data(2n-1) 0 in rectangular format, imaginary part in polar
and Smith chart formats.
Type Variant: array of double (read/write)
Trace Tr of channel Ch,
Target Ch:  channel number 1-16
Tr: trace number 1-16
Data = app.SCPI.CALCulate(Ch).Trace(Tr).DATA.FDATa
Syntax

app.SCPI.CALCulate(Ch).Trace(Tr).DATA.FDATa = Data

Equivalent Softkeys

None
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SCPI.CALCulate(Ch). TRACe(Tr).DATA.FMEMory

Reads out or writes the formatted memory array. The array
elements contain saved measurements in the current format, for
example, in logarithmic magnitude format (Log Mag). Also, see
section 14.

The array size is 2N, where N is the number of measurement
points.

Description
For the n-th point, where n from 1 to N:
Data(Z2n-2)  real number in rectangular format, real part in
polar and Smith chart formats;
Data(2n-1) 0 in rectangular format, imaginary part in polar
and Smith chart formats.
Type Variant: array of double (read/write)
Trace Tr of channel Ch,
Target Ch:  channel number 1-16
Tr: trace number 1-16
Data = app.SCPI.CALCulate(Ch).Trace(Tr).DATA.FMEMory
Syntax
app.SCPI.CALCulate(Ch).Trace(Tr).DATA.FMEMory = Data
Equivalent Softkeys None
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SCPI.CALCulate(Ch). TRACe(Tr).DATA.SDATa

Reads out or writes the corrected data array. The corrected
measurements are complex numbers. Also, see section 14.

The array size is 2N, where N is the number of measurement
points.

Description For the n—th point, where n from 1 to N:
Data(Zn-2)  the real part of corrected measurement;
Data(Zn-1) the imaginary part of corrected measurement.
Type Variant: array of double (read/write)
Trace Tr of channel Ch,
Target Ch:  channel number 1-16
Tr: trace number 1-16
Data = app.SCPI.CALCulate(Ch).Trace(Tr).DATA.SDATa
Syntax
app.SCPI.CALCulate(Ch).Trace(Tr).DATA.SDATa = Data
Equivalent Softkeys None
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SCPI.CALCulate(Ch). TRACe(Tr).DATA.SMEMory

Reads out or writes the corrected memory array. The corrected
measurements are complex numbers. Also, see section 14.

The array size is 2N, where N is the number of measurement
points.

Description For the n-th point, where n from 1 to N:
Data(Zn-2) the real part of corrected measurement memory;
Data(Z2n-1) the imaginary part of corrected measurement
memory.
Type Variant: array of double (read/write)
Trace Tr of channel Ch,
Target Ch:  channel number 1-16
Tr: trace number 1-16
Data = app.SCPI.CALCulate(Ch).Trace(7r).DATA.SMEMory
Syntax
app.SCPI.CALCulate(Ch).Trace(Tr).DATA.SMEMory = Data
Equivalent Softkeys None

SCPI.CALCulate(Ch). TRACe(Tr).DATA.XAXis

Reads out the trace X axis data array. The array size is N, where N
is the number of measurement points.

Description

For the n-th point, where n from 0 to N-1:

Data(n) the X axis value;

Type Variant: array of double (read only)

Trace Tr of channel Ch,
Target Ch:  channel number 1-16

Tr: trace number 1-16

Syntax Data = app.SCPI.CALCulate(Ch).Trace(Tr).DATA.XAXis
Equivalent Softkeys None
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SCPI.DISPlay.COLor.BACK

Sets/gets the background color for trace display.

The array contains 3 elements:

Description Data(0) Red value R;
Data(1) Green value G;
Data(2) Blue value B.
Type Variant: array of long (read/write)
Range For all the array elements from O to 255.
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

0,0,0

Syntax

Data = app.SCPI.DISPlay.COLor.BACK
app.SCP1.DISPlay.COLor.BACK = Array(255, 255, 255)

Equivalent Softkeys

Display > Properties > Color > Background > Red | Green | Blue
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SCPI.DISPlay.COLor.GRATicule

Sets/gets the grid and the graticule label color for trace display.

The array contains 3 elements:

Description Data(0) Red value R;
Data(1) Green value G;
Data(2) Blue value B.
Type Variant: array of long (read/write)
Range For all array elements from O to 255.
Out of Range Sets the value of the limit, which is closer to the specified value.

Data(0) 160;
Preset Value Data(l) 160:
Data(2) 164.
Data = app.SCPI.DISPlay.COLor.GRATicule
Syntax
app.SCP1.DISPlay.COLor. GRATIcule = Array(128, 128, 128)
Equivalent Softkeys | Display > Properties > Color > Grid > Red | Green | Blue

SCPI.DISPlay.COLor.RESet

Description Restores the display settings to the default values.
Type Method

Syntax app.SCP1.DISPlay.COLor.RESet

Equivalent Softkeys | Display > Properties > Set Defaults
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SCPI.DISPlay.COLor.TRACe(Tr).DATA

Sets/gets the data trace color.
The array contains 3 elements:

Description Data(0) Red value R;
Data(1) Green value G;
Data(2) Blue value B.
Type Variant: array of long (read/write)
Range For all array elements from O to 255.
Out of Range Sets the value of the limit, which is closer to the specified value.
Trace number Tr in all channels,
Target
Tr: trace number 1-16
Data = app.SCP1.DISPlay.COLor.TRACe(Tr).DATA
Syntax
app.SCP1.DISPlay.COLor. TRACe(Tr).DATA = Array(255, 255, 0)
Equivalent Softkeys | Display > Properties > Color > Data Trace > Red | Green | Blue
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SCPI.DISPlay.COLor. TRACe(Tr).MEMory

Sets/gets the memory trace color.
The array contains 3 elements:
Description Data(0) Red value R;
Data(1) Green value G;
Data(2) Blue value B.
Type Variant: array of long (read/write)
Range For all array elements from O to 255.
Out of Range Sets the value of the limit, which is closer to the specified value.
Trace number Trin all channels
Target
Tr: trace number 1-16
Data = app.SCPI.DISPlay.COLor.TRACe(Tr).MEMory
Syntax
app.SCP1.DISPlay.COLor.TRACe(Tr).MEMory = Array(255, 255, 0)
Equivalent Softkeys | Display > Properties > Color > Data Trace > Red | Green | Blue
SCPIL.DISPlay.ENABLle
Description Turns ON/OFF the display update.
Type Boolean (read/write)

Parameter

True: Display update ON
False:  Display update OFF

Preset Value

True

Syntax

Status = app.SCPL.DISPlay.ENABLe
app.SCPI.DISPlay.ENABLe = true

Equivalent Softkeys

Display > Update
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SCPI.DISPlay.FSIGn

Description Turns ON/OFF the state of the Fail sign display, when performing
limit test or ripple limit test.
Type Boolean (read/write)
True: Fail sign display ON
Parameter . .
False:  Fail sign display OFF
Preset Value False
Status = app.SCPI.DISPlay.FSIGn
Syntax
app.SCPI.DISPlay.FSIGn = true
, Analysis > Limit Test > Fail Sign
Equivalent Softkeys . . .. .
Analysis > Ripple Limit > Fail Sign
SCPI.DISPlay.GLABel
Sets/gets the Graticule Label state.
Description
(S2VNA only)
Type String (read/write)
"OFF" : Graticule label is OFF
Parameter "ACTive" : Only active trace has graticule label
"ALL" : All traces have graticule label
Preset Value "ACTive"
Param = app.SCPI1.DISPlay.GLABel
Syntax
app.SCP1.DISPlay.GLABel = "OFF"
Equivalent Softkeys | Display > Properties > Graticule Label
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SCPI.DISPlay.IMAGe

Description Sets/gets the inverted color display of the data traces.

Type String (read/write)

"NORMal" : Normal display

Parameter

"INVert" . Inverted color display
Preset Value "NORM"

Param = app.SCPIL.DISPlay.IMAGe
Syntax

app.SCPL.DISPlay.IMAGe = "INV"

Equivalent Softkeys | Display > Properties > Invert Color

SCPI.DISPlay.HIDE
o Hides the analyzer GUI. Blanks the main window and outputs
Description
"Remote Control".
Type Method
Syntax app.SCPI.DISPlay.HIDE

Related Commands SCPI.DISPlay.SHOW

Equivalent Softkeys None
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SCPI.DISPlay.MAXimize

Description Turns ON/OFF the state of the maximization of the active channel
window.
Type Boolean (read/write)
True: maximization ON
Parameter L. .
False: maximization OFF
Preset Value False
Target The active channel window
Status = app.SCPI.DISPlay.MAXimize
Syntax
app.SCPI.DISPlay.MAXimize = true
Equivalent Softkeys | Display > Active Trace/Channel > Maximize Channel

SCPIL.DISPlay.PARTition.FONT.SIZE(Param)

Description Sets/gets the font size of the item specified by Parameter.
(S2VNA only)
Type Long (read/write)
"CHANnel" : Channel window
"BUTTon" : Soft buttons
Parameter "MENU" : Menu bar
"CSTatus” : Channel status
"ASTatus" : Analyzer status
Range Fron 10 to 22.
Preset Value "11"
Size = app.SCPI.DISPlay.PARTition.FONT.SIZE(“CHAN")
Syntax
app.SCP1.DISPlay.PARTition.FONT.SIZE("CHAN") = 20
Equivalent Softkeys Display > Properties > Font > Size
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SCPI.DISPlay.PARTition.VISible(Param)

Description

Shows or hides the display patition specified by Parameter.
(S2VNA only)

Type

Boolean (read/write)

Parameter

"BUTTon" : Soft buttons
"MENU" : Menu bar
"CSTatus" : Channel status
"ASTatus" : Analyzer status
"TITLe" : Main window title
"FLABel" : Frequency label
"MTABle" : Marker table

Syntax

State = app.SCPI.DISPlay.PARTition.VISible(*"MENU")
app.SCPI.DISPlay.PARTition.VISible(“"MENU”) = true

Equivalent Softkeys

Display > Properties > Menu Bar

Display > Display Properties > Frequency Label
Markers > Properties > Marker Table

or None
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SCPI.DISPlay.POSition

Sets/gets the application window position on the screen and its
dimension.

The array contains 4 elements:
Data(0) Specifies the coordinate of the left side of the

Description wind ow;,
Data(1) Specifies the coordinate of the top of the window;
Data(2) Specifies the width of the window;
Data(3) Specifies the height of the window.
(S2VNA only)
Type Variant: array of long (read/write)
Range from O to the screen resolution;
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Data(0) - (screen width - 800) / 2,
Data(1) - (screen height - 600) / 2,
Data(2) - 800,
Data(3) - 600,

Preset: Display > Properties > Set Defaults

Syntax

Pos = app.SCPI.DISPlay.POSition
app.SCP1.DISPlay.POSition = Array(0, 0, 800, 600)

Equivalent Softkeys

None
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SCPI.DISPlay.SHOW

Shows the analyzer GUI hidden by the SCPI.DISPlay.HIDE

Description
command.
Type Method
Syntax app.SCP1.DISPlay.SHOW

Related Commands SCPI1.DISPlay.HIDE

Equivalent Softkeys None

SCPIL.DISPlay.SPLit
o Sets/gets the number and layout of the channel windows on the
Description . ..
screen. The channel window layout is in Table 1 below.
Type Long (read/write)
Range from1to 16
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 1
Value = app.SCPI.DISPlay.SPLit
Syntax
app.SCPI.DISPlay.SPLit = 2
Equivalent Softkeys Display > Allocate channels
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Table 1. Channel Window Layout on the Screen
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SCPL.DISPlay.REFResh.IMMediate

SCPI.DISPlay.UPDate.IMMediate

Updates the display once, when the display update is set to OFF

Description .
(SCPL.DISPlay.ENABLe is set to False).

Type Method
app.SCPI.DISPlay.REFResh.IMMediate

Syntax

app.SCPI.DISPlay.UPDate.IMMediate

Equivalent Softkeys None
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SCPI.DISPlay.WINDow(Ch).ACTivate

Description Selects the active channel.

Type Method

Notes The channel window must be displayed. In attempt to set to the active
channel the channel, which is not displayed, an error occurs.

Target Channel Ch from 1 to 16

Syntax app.SCP1.DISPlay.WINDow(Ch).ACTivate

Equivalent Softkeys | Display > Active Trace / Channel > Active Channel

SCPI.DISPlay.WINDow(Ch).ANNotation.MARKer.ALIGn.TYPE

Sets/gets the alignment mode of the marker display position of
each trace, when the only active trace display feature is turned

Description
" OFF (SCPI.DISPlay.WINDow(Ch).ANNotation.MARKer.SINGle.STATe
property is set to False).
Type String (read/write)

"VERTical" : Vertical alignment
Parameter "HORizontal” : Horizontal alignment

"NONE" : No alignment
Preset Value "NONE"
Target Channel Ch from 1 to 16

Param = app.SCPI.DISPlay.WINDow(Ch).ANNotation.MARKer.ALIGN.TYPE
Syntax

app.SCP1.DISPlay.WINDow(Ch).ANNotation.MARKer.ALIGNn.TYPE = "VERT"
Equivalent Softkeys Markers > Properties > Align > Vertical | Horizontal | OFF
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SCPI.DISPlay.WINDow(Ch).ANNotation.MARKer.SINGle.STATe

Description

Turns ON/OFF the state of the marker display for the active trace
only.

Type

Boolean (read/write)

Parameter

True: Only active trace markers display
False:  Markers of All traces display

Preset Value

True

Target Channel Ch from 1 to 16

Status = app.SCPI SCPL.DISPlay.WINDow(Ch).ANNotation.MARKer.SINGle.STATe
Syntax

app.SCP1 SCPI.DISPlay.WINDow(Ch).ANNotation.MARKer.SINGLle.STATe = true
Equivalent Softkeys Markers > Properties > Active Only

SCPIL.DISPlay.WINDow(Ch).MAXimize

Description

Turns ON/OFF the state of the active trace maximization of the
specified channel

Type

Boolean (read/write)

Parameter

True: maximization ON
False: maximization OFF

Preset Value

False

The active trace of channel Ch,

Target
Ch:  channel number 1-16
Status = app.SCPI.DISPlay.WINDow(Ch).MAXimize
Syntax
app.SCP1.DISPlay.WINDow(Ch).MAXimize = true
Equivalent Softkeys | Display > Active Trace/Channel > Maximize Trace
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SCPI.DISPlay.WINDow(Ch).SPLit

Sets/gets the code of the graph layout of channels. The channel

peseripton window layout is in Table 1 above.

Type Long (read/write)

Range from 1 to 16

Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Notes

This command does not define the number of traces in the channel
window, the number of traces is defined by the
SCPI.CALCulate(Ch).PARameter.COUNt command.

Target Channel Ch from 1 to 16

Value = app.SCPI.DISPlay.WINDow(Ch).SPLit
Syntax

app.SCPI.DISPlay.WINDow(Ch).SPLit = 2
Equivalent Softkeys | Display > Allocate Traces

SCPI.DISPlay.WINDow(Ch).TITLe.DATA

Description Sets/gets the channel title label.
Type String (read/write)
Target Channel Ch from 1 to 16
Text = app.SCPIL.DISPlay.WINDow(Ch).TITLe.DATA
e app.SCP1.DISPLay.WINDow(Ch).TITLe.DATA = *Network 1"
Equivalent Softkeys | Display > Edit Title Label
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SCPI.DISPlay.WINDow(Ch).TITLe.STATe

Description Turns ON/OFF the state of the title label display.
Type Boolean (read/write)

True: Title label display ON
Parameter

False:  Title label display OFF

Preset Value

False

Target Channel Ch from 1 to 16

Status = app.SCPI.DISPlay.WINDow(Ch).TITLe.STATe
Syntax

app.SCPI1.DISPlay.WINDow(Ch).TITLe.STATe = true
Equivalent Softkeys | Display > Title Label

SCPIL.DISPlay.WINDow(Ch).TRACe(Tr).ANNotation.MARKer. MEMory

Turns ON/OFF the state of the memory value display on the

Description

marker.
Type Boolean (read/write)

True: Memory value display ON
Parameter .

False:  Memory value display OFF

Trace Tr of channel Ch,
Target Ch:  channel number 1-16

Tr: trace number 1-16

Status = app.SCP1.DISPlay.WINDow(Ch).TRACe(Tr).ANNotation.MARKer.MEMory
Syntax

app.SCPI.DISPlay.WINDow(Ch). TRACe(Tr).ANNotation.MARKer.MEMory = true
Equivalent Softkeys | Markers > Properties > Memory Value
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SCPI.DISPlay.WINDow(Ch).TRACe(Tr).ANNotation.MARKer.POSition.X

Sets/gets the display position of the marker value on the X-axis

Description . .
by a percentage of the display width.
Type Double (read/write)
Range from O to 100
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Unit %

Trace Tr of channel Ch,
Target Ch:  channel number 1-16

Tr: trace number 1-16

Value = app.SCPL.DISPlay.WINDow(Ch).TRACe(Tr).ANNotation.MARKer.POSition.X
Syntax

app.SCP1.DISPlay.WINDow(Ch).TRACe(Tr).ANNotation.MARKer.POSition.X = 50
Equivalent Softkeys Markers > Properties > Data X Position
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SCPI.DISPlay.WINDow(Ch).TRACe(Tr).ANNotation.MARKer.POSition.Y

Sets/gets the display position of the marker value on the Y -axis by

Description . .
a percentage of the display height.
Type Double (read/write)
Range from O to 100
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Unit %

Trace Tr of channel Ch,
Target Ch:  channel number 1-16

Tr: trace number 1-16

Value = app.SCPL.DISPlay.WINDow(Ch).TRACe(Tr).ANNotation.MARKer.POSition.Y
Syntax

app.SCPI.DISPlay.WINDow(Ch).TRACe(Tr).ANNotation.MARKer.POSition.Y = 50
Equivalent Softkeys Markers > Properties > Data Y Position
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SCPI.DISPlay.WINDow(Ch). TRACe(Tr).MEMory. STATe

Description Turns ON/OFF the state of the memory trace display.
Type Boolean (read/write)
Parameter True: Memory trace display ON

False:  Memory trace display OFF

Preset Value

False

Notes If the memory is empty, an error occurs and the object is ignored.
Trace Tr of channel Ch,
Target Ch:  channel number 1-16
Tr: trace number 1-16
Status = app.SCPI.DISPlay.WINDow(Ch).TRACe(Tr).MEMory.STATe
Syntax
app.SCP1.DISPlay.WINDow(Ch).TRACe(Tr).MEMory.STATe = true
Equivalent Softkeys Display > Display > Memory | Data & Memory (ON)

Display > Display > Data | OFF (OFF)
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SCPI.DISPlay.WINDow(Ch). TRACe(Tr).STATe

Description Turns ON/OFF the state of the data trace display.
Type Boolean (read/write)

True: Data trace display ON
Parameter

False:  Data trace display OFF

Preset Value

True

Trace Tr of channel Ch,

Target Ch:  channel number 1-16
Tr: trace number 1-16
Status = app.SCPI.DISPlay.WINDow(Ch). TRACe(Tr).STATe
Syntax
app.SCP1.DISPlay.WINDow(Ch).TRACe(Tr).STATe = false
Equivalent Softkeys Display > Display > Data | Data & Memory (ON)

Display > Display > Memory | OFF (OFF)

SCPI.DISPlay.WINDow(Ch).TRACe(Tr).Y.SCALe.AUTO

Description Executes the auto scale function for the trace.
Type Method
Trace Tr of channel Ch,
Target Ch: channel number 1-16
Tr: trace number 1-16
Syntax app.SCP1.DISPlay.WINDow(Ch).TRACe(Tr).Y.SCALe.AUTO
Equivalent Softkeys Scale > Auto Scale
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SCPI.DISPlay.WINDow(Ch).TRACe(Tr).Y.SCALe.PDIVision

Sets/gets the trace scale. Sets the scale per division, when the data

Description format is the rectangular format. Sets the full scale value, when
the data format is the Smith chart format or the polar format.

Type Double (read/write)

Range from 10E-18 to 1E18

Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Varies depending on the format.
Logarithmic Magnitude: 10 dB/Div
Phase: 40 °/Div

Expand Phase: 100 °/Div

Group Delay: 10e-9 s/Div

Smith Chart, Polar, SWR: 1 /Div
Linear Magnitude: 0.1 /Div

Real part, Imaginary part: 0.2 /Div

dB/Div (decibel per division), °/Div (degree per division), s/Div (second

Unit ...
per division)
Trace Tr of channel Ch,
Target Ch: channel number 1-16
Tr: trace number 1-16
Value = app.SCPI.DISPlay.WINDow(Ch). TRACe(T7).Y.SCALe.PDIVision
Syntax

app.SCPI.DISPlay.WINDow(Ch).TRACe(T7).Y.SCALe.PDIVision = 20

Equivalent Softkeys

Scale > Scale
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SCPI.DISPlay.WINDow(Ch).TRACe(T7r).Y.SCALe.RLEVel

Sets/gets the value of the reference line (response value on the

peseripton reference line). For the rectangular format only.

Type Double (read/write)

Range from -1E-18 to 1E18

Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

0 (except for SWR: 1)

Unit dB (decibel) | ° (degree) | s (second)

Trace Tr of channel Ch,
Target Ch: channel number 1-16

Tr: trace number 1-16

Value = app.SCPL.DISPlay.WINDow(Ch).TRACe(Tr).Y.SCALe.RLEVel
Syntax

app.SCP1.DISPlay.WINDow(Ch).TRACe(Tr).Y.SCALe.RLEVel = 10
Equivalent Softkeys Scale > Ref Value
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SCPI.DISPlay.WINDow(Ch).TRACe(Tr).Y.SCALe.RPOSition

Sets/gets the position of the reference line. For the rectangular

Description
format only.
Type Long (read/write)
Range From 0 to the number of the scale divisions (set by the
SCPI.DISPlay.WINDow(Ch).Y.SCALe.DIVisions command, 10 by default).
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

5 (except for SWR: 0)

Trace Tr of channel Ch,

Target Ch: channel number 1-16
TIr: trace number 1-16
Value = app.SCPI.DISPlay.WINDow(Ch). TRACe(T7).Y.SCALe.RPOSition
Syntax
app.SCP1.DISPlay.WINDow(Ch).TRACe(Tr).Y.SCALe.RPOSition = 10
Equivalent Softkeys Scale > Ref Position

SCPI.DISPlay.WINDow(Ch).X.SPACing

Sets/gets the selection of the display method of the graph

Description . .

horizontal axis for the segment sweep.
Type String (read/write)

"LINear” : Frequency base (linear frequency axis)
Parameter . . .

"OBASe" : Order base (linear axis of the point numbers)
Preset Value "LIN"

Target Channel Ch from 1 to 16

Param = app.SCPI.DISPlay.WINDow(Ch).X.SPACing
Syntax

app.SCP1.DISPlay.WINDow(Ch).X.SPACing = "OBAS"
Equivalent Softkeys Stimulus > Segment Table > Segment Display
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SCPI.DISPlay.WINDow(Ch).Y.SCALe.DIVisions

Description Sets/gets the number of the vertical scale divisions. For the
rectangular format only.

Type Long (read/write)

Range from 4 to 30

Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value 10

Resolution 2

Target Channel Ch from 1 to 16
Value = app.SCPI.DISPlay.WINDow(Ch).Y.SCALe.DIVisions

e app.SCP1.DISPlay.WINDow(Ch).Y.SCALe.DIVisions = 12

Equivalent Softkeys Scale > Divisions

SCPI.HCOPy.ABORt

Description Aborts the printout.
Type Method

Syntax app.SCPI.HCOPy.ABORt
Equivalent Softkeys None

170




SCPI.HCOPyY.DATE.STAMp

Description Sets/gets the ON/OFF state of the current date and time printout

in the upper right corner.
Type Boolean (read/write)

True: Date & time printout ON
Parameter . .

False:  Date & time printout OFF
Preset Value True

Status = app.SCPI.LHCOPy.DATE.STAMp
Syntax

app.SCPI.HCOPy.DATE.STAMp = False
Equivalent Softkeys | System > Print > Print Date & Time

SCPI.HCOPy.IMAGe

Description Sets/gets the inverted color image printout.

Type String (read/write)

"NORMal" : Normal printout

Parameter .
"INVert" . Inverted color printout
Preset Value "NORM"
Param = app.SCPIL.LHCOPy.IMAGe
Syntax

app.SCPI.HCOPy.IMAGe = "INV"

Equivalent Softkeys System > Print > Invert Image
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SCPI.HCOPy.IMMediate

Description Prints out the image displayed on the screen without previewing.
Type Method
Syntax app.SCPI.HCOPy.IMMediate
Equivalent Softkeys | System > Print > Print Embedded
SCPI.HCOPy.PAINt
Description Sets/gets the color chart for the image printout.
Type String (read/write)
"COLor" : Color printout
Parameter "GRAY" : Grayscale printout
"BW" : Black&white printout
Preset Value "BW"
Param = app.SCPL.LHCOPy.PAINt
Syntax
app.SCPILHCOPy.PAINt = "COL"
Equivalent Softkeys System > Print > Print Color
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SCPI.IEEE4882.CLS

Clears the following:
e Error Queue
« Status Byte Register
» « Standard Event Status Register
Description A A
 Operation Status Event Register
e Questionable Status Event Register
» Questionable Limit Status Event Register
 Questionable Limit Channel Status Event Register
Type Method
Target Status Reporting System
Syntax app.SCPI.IEEE4882.CLS
Equivalent Softkeys None
SCPIL.IEEE4882.IDN
Description Reads out the Analyzer identification string.
Type String (read only)
Syntax StrName = app.NAME
The identification string in format: <manufacturer>, <model>, <serial
number>, <software version>/<hardware version>.
Reply
For example: CMT, C1209, 08080188, 16.2/01
Equivalent Softkeys None
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SCPI.IEEE4882.0PC

Reads out the "1" at the completion of all pending operations.
Write form of the command sets 1 the OPC bit (bit O) of the
Standard Event Status Register when all of pending operations

Description complete.
Note: since COM server executes commands sequentially and any
operation is complete before COM server returns control the OPC
read command doesn't wait anything.

Type Long (read/write)

Target Status Reporting System
Value = app.SCPI.IEEE4882.0PC

Syntax
app.SCPI.IEEE4882.0PC = Dummy

Equivalent Softkeys None

SCPL.IEEE4882.RST
Restores the default settings of the instrument. There is difference

Description from presetting the instrument with the SCPLSYSTem.PRESet
method - in this case the trigger mode is set to Hold.

Type Method

Target Analyzer

Syntax app.SCPI.IEEE4882.RST

Equivalent Softkeys None
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SCPI.IEEE4882.TRG

Generates a trigger signal and initiates a sweep under the
following conditions.

e Trigger source is set to the BUS (set by the command
SCPIL.TRIGger.SEQuence.SOURce = BUS), otherwise an error
occurs and the command is ignored.

Description
e Analyzer must be in the trigger waiting state, otherwise (the
analyzer is in the measurement state or hold state) an error
occurs and the command is ignored.
The command is completed immediately after the generation of
the trigger signal (does not wait the end of a sweep).
Type Method
Target Analyzer
Syntax app.SCPI.IEEE4882.TRG

Related Commands

SCPI.TRIGger.SEQuence.SOURce
SCPLINITiate(Ch).CONTinuous
SCPLINITiate(Ch).IMMediate

Equivalent Softkeys

None
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SCPI.IEEE4882.WAI

Waits for the execution of all commands sent before this
command.

Description Note: since COM server executes commands sequentially and any
operation is complete before COM server returns control the WAI
command doesn't wait anything.

Type Method

Target Analyzer

Syntax app.SCPI.IEEE4882.WAI

Equivalent Softkeys None
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SCPLINITiate(Ch).CONTinuous

Description

Turns ON/OFF the continuous trigger initiation mode.
When the continuous initiation mode turned ON:

e |If the Internal trigger source is selected by the command
SCPIL.TRIGger.SEQuence.SOURce = "INT", then the channel
continuously sweeps;

e If the trigger source other than the internal is selected, then
the channel goes to the trigger waiting state. Upon receipt
of a trigger from the selected source, the sweep starts for
the channels awaiting trigger. On completion of the sweep
the channel goes to the trigger waiting state.

When the continuous trigger initiation mode turned OFF the channel
is in the Hold state, to initiate a sweep one should use the INIT
command.

Type

Boolean (read/write)

Parameter

True: Continuous trigger initiation mode ON
False:  Continuous trigger initiation mode OFF

Preset Value

True

Target

Channel Ch from 1 to 16

Syntax

Status = app.SCPLINITiate(Ch).CONTinuous
app.SCPLINITiate(Ch).CONTinuous = False

Notes

The sweep start in continuous trigger initiation mode depends on the
trigger source. If the trigger is set to internal, the sweeps will go
immediately one after another. If the trigger is set otherwise, the sweep
will start when the trigger signal is received.

Equivalent Softkeys

Stimulus > Trigger > Continuous
Stimulus > Trigger > Hold
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SCPLINITiate(Ch).IMMediate

Puts the channel to the Trigger Waiting state for the one trigger
event. The channel should be in the hold state, otherwise an error
occurs and the command is ignored. The channel goes into the
Hold as a result of the command SCPILINITiate(Ch).CONTinuous =
False.

If the Internal trigger source is selected by the command
TRIG:SOUR INT, then the command initiates a sweep in the single

Description . .- .
channel, otherwise the channel goes to the Waiting for a Single
Trigger mode.
Upon receipt of a trigger from the selected source, the sweep
starts for the channels awaiting trigger. On completion of the
sweep the channel goes to the Hold state.
The method returns control immediately (does not wait the end of
the sweep).

Type Method

Target Channel Ch from 1 to 16

Syntax app.SCPLINITiate(Ch).IMMediate
The sweep start in the single trigger mode depends on the trigger

Notes source. If the trigger is set to internal, the sweep will start immediately
after the method is called. If the trigger is set otherwise, the sweep will
start when the trigger signal is received.

Equivalent Softkeys Stimulus > Trigger > Single
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SCPI.MMEMory.CATalog(Dir)

This command reads out the following information on the hard
drive:

e Space in use
e Available space

« Name and size of all files (including directories) in the
specified directory

Format:
("{A}L,{B}{Name 1},,{Size 1},{Name 2},{Size 2}, ... {Name N},{Size

Description N } ")
Where N is the number of all files in the specified directory and n
is an integer between 1 and N.
{A}: Space in use of the hard drive (byte).
{B}: Available space of the hard drive (byte).
{Name n}: Name of the n-th file (directory).
{Size n}: Size (byte) of the n-th file (directory). Always O for
directories.
Type String (read only)
Parameter Dir - Directory name whose information you want to read out
Syntax Cat = app.SCPI.LMMEMory.CATalog("\.")
Equivalent Softkeys None
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SCPI.MMEMory.COPY(Src, Dst)

Description Copies afile.
Type Method
Syntax app.SCPI.MMEMory.COPY(Src, Dst)

Src - Source file name. String data type.
Parameter . . . .

Dst - Destination file name. String data type.
Equivalent Softkeys None

SCPI.MMEMory.DELete(File)

Description Deletes a file.

Type Method

Syntax app.SCPI.MMEMory.DELete(File)
Parameter File — File name. String data type.
Equivalent Softkeys None
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SCPI.MMEMory.LOAD.CHANnel.STATe

Recalls the analyzer state for the active channel, saved in one of

Description the four memory registers by the
SCPI.MMEMory.STORe.CHANnel.STATe command.
Type String (write only)
"A" : Recall from register A
"B" : Recall from register B
Parameter .
"C" : Recall from register C
"D" : Recall from register D
Target Active channel
Syntax app.SCPI.MMEMory.LOAD.CHANnel.STATe = "A"
Equivalent Softkeys Save/Recall > Recall Channel > State A|B|C|D

SCPI.MMEMory.LOAD.CKIT(CK)

Recalls the definition file for the calibration kit. The file must be

Description

saved by the SCPI.MMEMory.STORe.CKIT(Ck) command.
Type String (write only)
Parameter File Name

Calibration kit Ck,
Target . . .

Ck: calibration kit number 1-50

Syntax app.SCPI.MMEMory.LOAD.CKIT(CK) = File

Notes

If the full path to the file is not specified, the \CalKit subdirectory of the
main directory will be searched for the file. The calibration kit definition
file has *.ckd extension by default.

Equivalent Softkeys

None

181




SCPI.MMEMory.LOAD.LIMit

Recalls the specified limit table file. The file must be saved by the

Description .
SCPI.MMEMory.STORe.LIMit command.
Type String (write only)
Parameter File Name
Target Active trace of the active channel.
Syntax app.SCPI.MMEMory.LOAD.LIMit = File
If the full path to the file is not specified, the \Limit subdirectory of the
Notes main directory will be searched for the file. The limit table files have
*lim extension by default.
Equivalent Softkeys Analysis > Limit Test > Edit Limit Line > Restore Limit Table

SCPI.MMEMory.LOAD.PLOSs(Pt)

Recalls the specified loss compensation table file. The file must be

Description
saved by the SCPI.MMEMory.STORe.PLOSs(Pt) command.

Type String (write only)

Parameter File Name

Tarcet Port Pt of the active channel,

’ Pt:  port number 1-2 (4 for S4VNA) .

Syntax app.SCPI.MMEMory.LOAD.PLOSs(Pt) = File
If the full path to the file is not specified, the \CalKit subdirectory of the

Notes main directory will be searched for the file. The loss compensation file
has *.[ct extension by default.

Equivalent Softkeys Calibration > Power Calibration > Loss Compen > Import Loss Table
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SCPI.MMEMory.LOAD.RLIMit

Recalls the ripple limit table file. The file must be saved by the

Description .
SCPI.MMEMory.STORe.RLIMit command.
Type String (write only)
Parameter File Name
Target Active trace of the active channel.
Syntax app.SCPI.MMEMory.LOAD.RLIMit = File
If the full path to the file is not specified, the \Limit subdirectory of the
Notes main directory will be searched for the file. The ripple limit files have
*rlm extension by default.
Equivalent Softkeys | Analysis > Ripple Limit > Edit Ripple Limit > Restore Ripple Limit Table

SCPI.MMEMory.LOAD.SEGMent

Recalls the segment table file. The file must be saved by the

Description
SCPI.MMEMory.STORe.SEGMent command.
Type String (write only)
Parameter File Name
Target Active channel
Syntax app.SCPI.MMEMory.LOAD.SEGMent = File
If the full path to the file is not specified, the \Segment subdirectory of
Notes the main directory will be searched for the file. The segment files have
*seg extension by default.
Equivalent Softkeys Stimulus > Segment Table > Recall...
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SCPI.MMEMory.LOAD.SNP.DATA

Loads the Touchstone file with the specified name to the
measured S—parameters of the active channel. The Touchstone file
types slp, s2p, s3p and s4p are supported. The *.s1p file loads the

Description S11 parameter only. *s2p file loads all S11, S21, S12 and S22
parameters and so on. On completion of the command, the
channel goes to the hold state.

Type String (write only)

Parameter File Name

Target Active channel

Syntax app.SCPI.MMEMory.LOAD.SNP.DATA = File

Equivalent Softkeys | Save/Recall > Load Data From Touchstone File > To S-parameters...

SCPI.MMEMory.LOAD.SNP.TRACe(7r).MEMory

Loads the Touchstone file with the specified name to the memory
trace. The Touchstone file types slp, s2p, s3p and s4p are

Description supported. The current measured S-parameter of data trace selects
the appropriate S-parameter from Touchstone file. After successful
load the display of memory trace is automatically switched on.

Type String (write only)

Parameter File Name
Trace Tr of active channel,

Target Tr: trace number 1-16

Active channel set by command SCPI.DISPlay.WINDow(Ch).ACTivate

Syntax app.SCPI.MMEMory.LOAD.SNP.TRACe(Tr).MEMory = File

Equivalent Softkeys Save/Recall > Load Data From Touchstone File > To Active Trace Memory
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SCPI.MMEMory.LOAD.STATe

Recalls the specified analyzer state file. The file must be saved by

Description
the SCPI.MMEMory.STORe.STATe command.
Type String (write only)
Parameter File Name
Syntax app.SCPI.MMEMory.LOAD.STATe = File
If the full path to the file is not specified, the \State subdirectory of the
Notes main directory will be searched for the file. The analyzer state files have
* sta extension by default.
Equivalent Softkeys Save/Recall > Recall State > State...

SCPI.MMEMory.MDIRectory

Creates a new directory (folder). Contains the full path to the

Deseripton folder being created.

Type String (write only)

Parameter Directory Name

Syntax app.SCPI.MMEMory.MDIRectory = Path
Equivalent Softkeys None
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SCPI.MMEMory.STORe.CHANnel.CLEar

Clears the memory of the channel state saved by the

pescripron SCPI.MMEMory.STORe.CHANnel.STATe command.
Type Method

Syntax app.SCPI.MMEMory.STORe.CHANnel.CLEar

Equivalent Softkeys Save/Recall > Save Channel > Clear States

SCPI.MMEMory.STORe.CHANnel.STATe

Saves the analyzer state of the items set for the active channel

Description . .

into one of the four memory registers.
Type String (write only)

"A" : Save to register A

"B" : Save to register B
Parameter .

"C" : Save to register C

"D" : Save to register D
Target Active channel
Syntax app.SCPI.LMMEMory.STORe.CHANnel.STATe = "A"
Equivalent Softkeys Save/Recall > Save Channel > State A|B|C|D
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SCPI.MMEMory.STORe.CKIT(Ck)

Description Saves the definition file for the calibration kit parameters.

Type String (write only)

Parameter File Name

Tarcet Calibration kit Ck,

’ Ck: calibration kit number 1-50

Syntax app.SCPI.MMEMory.STORe.CKIT(Ck) = File
If the full path to the file is not specified, the file will be saved to the

Notes \CalKit subdirectory of the main directory. The calibration kit definition
file has *.ckd extension by default.

Equivalent Softkeys None

SCPI.MMEMory.STORe.FDATa

Description Saves the CSV formatted data into a file.

Type String (write only)

Parameter File Name

Target Active trace of the active channel

Syntax app.SCPI.MMEMory.STORe.FDATa = File
If the full path to the file is not specified, the file will be saved to the

Notes \CSV subdirectory of the main directory. The files have *.csv extension by
default.

Equivalent Softkeys Save/Recall > Save Trace Data
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SCPI.MMEMory.STORe.IMAGe

Description Saves the display image in BMP or PNG format into a file.
Type String (write only)
Parameter File Name
Syntax app.SCPI.MMEMory.STORe.IMAGe = File
If the full path to the file is not specified, the file will be saved to the
Notes \Image subdirectory of the main directory. If the file has *.png extension,
the file has PNG format, in all the other cases the file has BMP format.
Equivalent Softkeys System > Print > Print Windows > Save as...

SCPI.MMEMory.STORe.LIMit

Description Saves the limit table into a file with the specified name.

Type String (write only)

Parameter File Name

Target Active trace of the active channel

Syntax app.SCPI.LMMEMory.STORe.LIMit = File
If the full path to the file is not specified, the file will be saved to the

Notes \Limit subdirectory of the main directory. The files have *.[im extension
by default.

Equivalent Softkeys Analysis > Limit Test > Edit Limit Line > Save Limit Table
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SCPI.MMEMory.STORe.PLOSs(Pt)

Saves the loss compensation table into a file with the specified

Description
name.
Type String (write only)
Parameter File Name
Target Port Pt of the active channel,
Pt: port number 1-2 (4 for S4VNA)
Syntax app.SCPI.MMEMory.STORe.PLOSs(Pt) = File
If the full path to the file is not specified, the file will be saved to the
Notes \CalKit subdirectory of the main directory. The loss compensation files
have *.Ict extension by default.
Equivalent Softkeys Calibration > Power Calibration > Loss Compen > Export Loss Table

SCPI.MMEMory.STORe.RLIMit

Description Saves the ripple limit table into a file with the specified name.

Type String (write only)

Parameter File Name

Target Active trace of the active channel

Syntax app.SCPI.MMEMory.STORe.RLIMit = File
If the full path to the file is not specified, the file will be saved to the

Notes \Limit subdirectory of the main directory. The ripple limit files have *.rim
extension by default.

Equivalent Softkeys | Analysis > Ripple Limit > Edit Ripple Limit > Save Ripple Limit Table
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SCPI.MMEMory.STORe.SEGMent

Description Saves the segment table in a file with the specified name.

Type String (write only)

Parameter File Name

Target Active channel

Syntax app.SCPI.MMEMory.STORe.SEGMent = File
If the full path to the file is not specified, the file will be saved to the

Notes \Segment subdirectory of the main directory. The segment files have *.seg
extension by default.

Equivalent Softkeys | Stimulus > Segment Table > Save...

SCPI.MMEMory.STORe.SNP.DATA

Saves the measured S—parameters of the active channel into a
Touchstone file with the specified name. The file type (slp, s2p,
s3p or s4p) is set by the SCPLLMMEMory.STORe.SNP.TYPE.S1P to

Descripti
e SCPI.MMEMory.STORe.SNP.TYPE.S4P properties. The 1-port type

file saves one reflection parameter: S11 or S22. The 2-port type
file saves all the four parameters: S11, S21,S12, S22 and so on.

Type String (write only)

Parameter File Name

Target Active channel

Syntax app.SCPI.MMEMory.STORe.SNP.DATA = File

Notes If the full path to the file is not specified, the file will be saved to the
\FixtureSim subdirectory of the main directory.

Equivalent Softkeys Save/Recall > Save Data to Touchstone File > Save File...
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SCPI.MMEMory.STORe.SNP.FORMat

Sets/gets the data format for the S-parameters saving by the

Description
SCPI.MMEMory.STORe.SNP.DATA command.
Type String (read/write)
"MA" : Logarithmic Magnitude / Angle format
Parameter " DB" : Linear Magnitude / Angle format
"RI" : Real part /Imaginary part format
Preset Value "RI"

Syntax

Param = app.SCPI.MMEMory.STORe.SNP.FORMat
app.SCPI.LMMEMory.STORe.SNP.FORMat = "DB”

Equivalent Softkeys

Save/Recall > Save Data to Touchstone File > Format

SCPI.MMEMory.STORe.SNP.SEParator

Sets/gets the Touchstone file separator symbol when the S-

Description parameters are saved by the SCPIL.MMEMory.STORe.SNP.DATA
command.
Type String (read/write)

" TAB" : Tab symbol (0x09)
Parameter

" SPACe" : Space symbol (0x20)
Preset Value "TAB"

Syntax

Param = app.SCPI.MMEMory.STORe.SNP.SEParator
app.SCPI.MMEMory.STORe.SNP.SEParator = "SPACe"

Equivalent Softkeys

Save/Recall > Save Data to Touchstone File > Separator
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SCPI.MMEMory.STORe.SNP.TYPE.S1P

Selects slp save type (l-port measurements) and sets port
numbers (selects S11, S22, S33 or S44 parameter) when saving the

Description
measured S-parameters by the SCPI.LMMEMory.STORe.SNP.DATA
command.

Type Long (read/write)

Range Port number from 1 to 2 (4 for S4VNA)

Out of Range An error occurs. Error code 222.

Preset Value

Syntax

Value = app.SCPI.MMEMory.STORe.SNP.TYPE.S1P
app.SCPI.LMMEMory.STORe.SNP.TYPE.S1P = 2

Equivalent Softkeys

Save/Recall > Save Data to Touchstone File > Type > 1-Port (s1p)

Save/Recall > Save Data to Touchstone File > Select Port (s1p)

SCPI.MMEMory.STORe.SNP.TYPE.S2P

Selects s2p save type (2-port measurements) and sets port
numbers when saving the measured S-parameters by the
SCPI.MMEMory.STORe.SNP.DATA command.

Description The array contains 2 elements:
Data(0) First port number from 1 to 2 (4 for S4VNA);
Data(1) Second port number from 1 to 2 (4 for S4VNA).
Type Variant: array of long (read/write)
Data = app.SCPI.MMEMory.STORe.SNP.TYPE.S2P
Syntax
app.SCPI.MMEMory.STORe.SNP.TYPE.S2P = Array(1, 2)
_ Save/Recall > Save Data to Touchstone File > Type > 2-Port (s2p)
Equivalent Softkeys

Save/Recall > Save Data to Touchstone File > Select Ports (s2p)
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SCPI.MMEMory.STORe.SNP.TYPE.S3P

Selects s3p save type and sets port numbers when saving the
measured S-parameters by the SCPI.MMEMory.STORe.SNP.DATA
command.

The array contains 3 elements:

Description Data(0) First port number;
Data(1) Second port number;
Data(2) Third port number.
(S4VNA only)
Type Variant: array of long (read/write)
Data = app.SCPI.MMEMory.STORe.SNP.TYPE.S3P
Syntax
app.SCPI.MMEMory.STORe.SNP.TYPE.S3P = Array(1, 2, 3)
, Save/Recall > Save Data to Touchstone File > Type > 3-Port (s3p)
Equivalent Softkeys

Save/Recall > Save Data to Touchstone File > Select Ports (s3p)
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SCPI.MMEMory.STORe.SNP.TYPE.S4P

Selects s4p save type and sets port numbers when saving the
measured S-parameters by the SCPI.MMEMory.STORe.SNP.DATA
command.

The array contains 3 elements:

Data(0) First port number;
Description
Data(1) Second port number;
Data(2) Third port number;
Data(3) Forth port number.
(S4VNA only)
Type Variant: array of long (read/write)
Data = app.SCPI.MMEMory.STORe.SNP.TYPE.S4P
Syntax
app.SCPI.MMEMory.STORe.SNP.TYPE.S4P = Array(1, 2, 3, 4)
Equivalent Softkeys | Save/Recall > Save Data to Touchstone File > Type > 4-Port (s4p)

SCPI.MMEMory.STORe.STATe

Description Saves the analyzer state into a file with the specified name.

Type String (write only)

Parameter File Name

Syntax app.SCPI.MMEMory.STORe.STATe = File
If the full path to the file is not specified, the file will be saved to the

Notes \State subdirectory of the main directory. The state files have *sta
extension by default.

Equivalent Softkeys Save/Recall > Save State > State...
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SCPI.MMEMory.STORe.STYPe

Selects the type of the analyzer or channel state saving by the

Description SCPI.LMMEMory.STORe.STATe or
SCPI.MMEMory.STORe.CHANnel.STATe command.

Type String (read/write)
"STATe": Measurement conditions
"CSTate": Measurement conditions and calibration tables
"DSTate": Measurement conditions and data traces

Parameter
"CDSTate": Measurement conditions, calibration tables and data

traces

"CMSTate": Measurement conditions, calibration and memory

Preset Value "CST"

Param = app.SCPI.MMEMory.STORe.STYPe

Syntax
app.SCPI.LMMEMory.STORe.STYPe = "STATe"

Equivalent Softkeys Save/Recall > Save Type

SCPL.OUTPut.STATe

Description Turns ON/OFF the stimulus signal output. Measurements cannot
be performed when the stimulus signal output is set to OFF.

Type Boolean (read/write)
True: Stimulus signal output ON

Parameter

False:  Stimulus signal output OFF

Preset Value True
Target Ana Lyzer

Status = app.SCPI.LOUTPut.STATe
Syntax

app.SCPI.OUTPut.STATe = False
Equivalent Softkeys Stimulus > Power > RF Out
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SCPI.SENSe(Ch).AVERage.CLEar

Description Resets the averaging count to 0. Restarts the averaging process.
Type Method

Target Channel Ch from 1 to 16

Syntax app.SCPI.SENSe(Ch).AVERage.CLEar

Equivalent Softkeys | None

SCPI.SENSe(Ch).AVERage.COUNt

Sets/gets the averaging factor, when the averaging function is set

pescripron to ON by the SCPI.SENSe(Ch).AVERage.STATe command.
Type Long (read/write)

Range from 1 to 999

Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

10

Target Channel Ch from 1 to 16

Value = app.SCPI.SENSe(Ch).AVERage.COUNt
Syntax

app.SCPI.SENSe(Ch).AVERage.COUNt = 2
Equivalent Softkeys | Average > Avg Factor
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SCPI.SENSe(Ch).AVERage.STATe

Description Turns ON/OFF the state of the averaging function.
Type Boolean (read/write)
Parameter True: Averaging ON

False:  Averaging OFF

Preset Value

False

Target Channel Ch from 1 to 16

Status = app.SCPI.SENSe(Ch).AVERage.STATe
Syntax

app.SCPI.SENSe(Ch).AVERage.STATe = False
Equivalent Softkeys Average > Averaging
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SCPI.SENSe(Ch).BANDwidth.RESolution

Sets/gets the IF bandwidth value. Less IF bandwidth reduces noise

peseripton and increases measurement time.

Type Double (read/write)

Range from 1 to 30000

Resolution Instepsof 1,1.5,2,3,5,7.

Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value 10000
Unit Hz (Hertz)
Target Channel Ch from 1 to 16

Value = app.SCPI.SENSe(Ch).BANDwidth.RESolution
e app.SCPI.SENSe(Ch).BANDwidth.RESolution = 100
Equivalent Softkeys Average > IF Bandwidth

SCPI.SENSe(Ch).CORRection.CLEar

Description Clears the calibration coefficient table.
Type Method

Target Channel Ch from 1 to 16

Syntax app.SCPI.SENSe(Ch).CORRection.CLEar
Equivalent Softkeys None
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SCPI.SENSe(Ch).CORRection.COEFficient.DATA(Str, Pt _r, Pt_s)

Sets/gets the calibration coefficient data array set by the type of
the corrected error term Str, the number of the receiver port Pt r
and the number of the source port Pt s,

Str : error term (see below)

Pt r: the number of the receiver port 1-2 (4 for S4VNA)

Pt s: the number of the source port 1-2 (4 for S4VNA)

Description
The array size is 2N, where N is the number of measurement
points.
For the n-th point, where n from 1 to N:
Data(2n-2) real part of the calibration coefficients
Data(Zn-1) imaginary part of the calibration coefficients
Type Variant: array of double (read/write)
String Str - corrected error term:
"ES": Source match
"ER": Reflection tracking
"ED": Directivity
"EL": Load match
Parameter "ET": Transmission tracking
"EX": Isolation
When ES, ER, or ED is used, the numbers of the ports Pt r and Pt s must
be the same. When EL, ET, or EX is used, the numbers of the ports Pt r
and Pt_s must be different.
Target Channel Ch from 1 to 16
Data = app.SCPL.SENSe(Ch).CORRection.COEFficient.DATA(Str, Pt_r, Pt_s)
Syntax
app.SCPI.SENSe(Ch).CORRection.COEFficient. DATA(Str, Pt_r, Pt_s) = Data
When sets, this command writes the calibration coefficient data array to
Notes a temporary storage. Written calibration coefficients become effective
after the SCPI.SENSe(Ch) .CORRection.COEFficient.SAVE method
is invoked.
Equivalent Softkeys None
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SCPIL.SENSe(Ch).CORRection.COEFficient. METHod.ERESponse

Selects the port numbers and sets the I-path 2-port calibration
type, when the written calibration coefficients are made effective
by the SCPI.SENSe(Ch).CORRection.COEFficient.SAVE method.

Description .
The array contains 2 elements:
Data(0) the number of the receiver port;
Data(1) the number of the source port.
Type Variant: array of long (write only)
Range Port number is 1-2 (4 for S4VNA). Array elements can not contain the
same port numbers.
Out of Range If an incorrect port number is specified, an error occurs (error code: 222).
I If the same port numbers are specified, an error occurs (error code: 220).
Target Channel Ch from 1 to 16
Ports = Array(2, 1)
Syntax
app.SCPI.SENSe(Ch).CORRection.COEFficient. METHod.ERESponse = Ports
Equivalent Softkeys None
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SCPI.SENSe(Ch).CORRection.COEFficient. METHod.RESPonse.OPEN

Selects the port and sets the response calibration (Open) type, when

Description the written calibration coefficients are made effective by the
SCPI.SENSe(Ch).CORRection.COEFficient.SAVE method.
Type Long (write only)
Range Port number from 1 to 2 (4 for S4VNA)
Out of Range An error occurs. Error code: 222.
Target Channel Ch from 1 to 16
Port =1
Syntax
app.SCP1.SENSe(Ch).CORRection.COEFficient. METHod.RESPonse.OPEN = Port
Equivalent Softkeys None

SCPI.SENSe(Ch).CORRection.COEFficient. METHod.RESPonse.SHORt

Selects the port and sets the response calibration (Short) type, when

Description the written calibration coefficients are made effective by the
SCPI.SENSe(Ch).CORRection.COEFficient.SAVE method.
Type Long (write only)
Range from 1-2 (4 for S4VNA)
Out of Range An error occurs. Error code: 222.
Target Channel Ch from 1 to 16
Port =1
Syntax
app.SCPI.SENSe(Ch).CORRection.COEFficient. METHod.RESPonse.SHORt = Port
Equivalent Softkeys None
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SCPI.SENSe(Ch).CORRection.COEFficient. METHod.RESPonse. THRU

Selects the ports and sets the response calibration (Thru) type, when
the written calibration coefficients are made effective by the
SCPI.SENSe(Ch).CORRection.COEFficient.SAVE method.

Description .
The array contains 2 elements:
Data(0) the number of the receiver port;
Data(1) the number of the source port.
Type Variant: array of long (write only)
Range Port number is 1 to 2 (or 4 for S4VYNA). The array elements can not
contain the same port numbers.
Out of Range If an incorrect port number is specified, an error occurs (error code: 222).
I If the same port numbers are specified, an error occurs (error code: 220).
Target Channel Ch from 1 to 16
Ports = Array(2, 1)
Syntax
app.SCPI.SENSe(Ch).CORRection.COEFficient. METHod.RESPonse.THRU = Ports
Equivalent Softkeys None
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SCPI.SENSe(Ch).CORRection.COEFficient. METHod.SOLT1

Selects the port and sets the full 1-port calibration type, when the

Description written calibration coefficients are made effective by the
SCPI.SENSe(Ch).CORRection.COEFficient.SAVE method.

Type Long (write only)

Range Port number from 1 to 2 (4 for S4VNA)

Out of Range An error occurs. Error code: 222.

Target Channel Ch from 1 to 16
Port =1

Syntax
app.SCPI.SENSe(Ch).CORRection.COEFficient. METHod.SOLT1= Port

Equivalent Softkeys None
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SCPI.SENSe(Ch).CORRection.COEFficient. METHod.SOLT2

Selects the ports and sets the full 2-port calibration type, when the
written calibration coefficients are made effective by the
SCPI.SENSe(Ch).CORRection.COEFficient.SAVE method.

Description The array contains 2 elements:
Data(0) specifies a port for full 2-port calibration 1-4;
Data(1) specifies a port for full 2-port calibration 1-4.
Type Variant: array of long (write only)
Rance Port number is 1 to 2 (or 4 for S4VYNA). The array elements can not
! contain the same port numbers.
Out of Range If an incorrect port number is specified, an error occurs (error code: 222).
I If the same port numbers are specified, an error occurs (error code: 220).
Target Channel Ch from 1 to 16
Ports = Array(1,2)
Syntax
app.SCPI.SENSe(Ch).CORRection.COEFficient. METHod.SOLT2 = Ports
Equivalent Softkeys None
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SCPI.SENSe(Ch).CORRection.COEFficient. METHod.SOLT3

Selects the ports and sets the full 3-port calibration type, when the
written calibration coefficients are made effective by the
SCPI.SENSe(Ch).CORRection.COEFficient.SAVE method.
The array contains 3 elements:
Description Data(0) specifies a port for full 3-port calibration;
Data(1) specifies a port for full 3-port calibration;
Data(2) specifies a port for full 3-port calibration.
(S4VNA only)
Type Variant: array of long (write only)
Range Port number is 1 to 4. The array elements can not contain the same port
numbers.
Out of Range If an incorrect port number is specified, an error occurs (error code: 222).
I If the same port numbers are specified, an error occurs (error code: 220).
Target Channel Ch from 1 to 16
Ports = Array(1,2,4)
Syntax
app.SCPI.SENSe(Ch).CORRection.COEFficient.METHod.SOLT2 = Ports
Equivalent Softkeys None
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SCPI.SENSe(Ch).CORRection.COEFficient. METHod.SOLT4

Selects the ports and sets the full 4-port calibration type, when the
written calibration coefficients are made effective by the
SCPI.SENSe(Ch).CORRection.COEFficient.SAVE method.

The array contains 4 elements:

Data(0) specifies a port for full 4-port calibration;
Description Data(1) specifies a port for full 4-port calibration;
Data(2) specifies a port for full 4-port calibration;
Data(3) specifies a port for full 4-port calibration.
(S4VNA only)
Type Variant: array of long (write only)
Rance Port number is 1 to 4. The array elements can not contain the same port
I numbers.
Out of Range If an incorrect port number is specified, an error occurs (error code: 222).
I If the same port numbers are specified, an error occurs (error code: 220).
Target Channel Ch from 1 to 16
Ports = Array(1,2,3,4)
Syntax
app.SCPI.SENSe(Ch).CORRection.COEFficient. METHod.SOLT2 = Ports
Equivalent Softkeys None
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SCPI.SENSe(Ch).CORRection.COEFficient.SAVE

Enables the written calibration coefficients depending on the
selected calibration type.

On completion of the method the written calibration coefficients

Description are cleared, the error correction automatically turns ON.
At the attempt to execute this method before all the needed
calibration coefficients are written, an error occurs and the method
is ignored.

Type Method

Target Channel Ch from 1 to 16

Syntax

app.SCPI.SENSe(Ch).CORRection.COEFficient.SAVE

Related Commands

Calibration type selection:
SCPI.SENSe(Ch).CORRection.COEFficient. METHod.ERESponse
SCPI.SENSe(Ch).CORRection.COEFficient. METHod.RESPonse. OPEN
SCPI.SENSe(Ch).CORRection.COEFficient. METHod.RESPonse. SHORt
SCPI.SENSe(Ch).CORRection.COEFficient. METHod.RESPonse. THRU
SCPI.SENSe(Ch).CORRection.COEFficient. METHod.SOLT1
SCPI.SENSe(Ch).CORRection.COEFficient. METHod.SOLT2
SCPI.SENSe(Ch).CORRection.COEFficient. METHod.SOLT3
SCPI.SENSe(Ch).CORRection.COEFficient. METHod.SOLT4

Calibration coefficient writing:

SCPI.SENSe(Ch).CORRection.COEFficient.DATA (Str, Pt_r, Pt_s)

Equivalent Softkeys

None
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SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.ISOLation

Measures the isolation calibration data between the source port
and the receiver port.

Description The array contains 2 elements:
Data(0) the number of the receiver port;
Data(1) the number of the source port.
Type Variant: array of long (write only)
Rance Port number is 1 to 2 (or 4 for S4VNA). The array elements can not
I contain the same port numbers.
If an incorrect port number is specified, an error occurs (error code: 222).
Out of Range .
If the same port numbers are specified, an error occurs (error code: 220).
Target Channel Ch from 1 to 16
Syntax app.SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.ISOLation = Array(1, 2)
The command starts the measurement immediately if the trigger source
Notes for calibration set to the ‘Internal" by the command
SENS:CORR:TRIG:FREE, otherwise waits for the trigger signal. The
command waits for the completion of the measurement.
Calibration > Calibrate > Response (Thru) > Isolation (Optional)
Calibration > Calibrate > One Path 2-Port Cal > Isolation (Optional)
Equivalent Softkeys Calibration > Calibrate > 2-Port SOLT Cal > Port x-y Isol (Optional)

Calibration > Calibrate > 3-Port SOLT Cal > Port x-y Isol (Optional)

Calibration > Calibrate > 4-Port SOLT Cal > Port x-y Isol (Optional)

208




SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.LOAD

Measures the calibration data of the load standard for the specified

Description
port.
Type Long (write only)
Range Port number is 1 to 2 (4 for S4VNA).
Out of Range An error occurs (error code: 222).
Target Channel Ch from 1 to 16
Syntax app.SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.LOAD =1
The command starts the measurement immediately if the trigger source
Notes for calibration set to the ‘Internal by the command
SENS:CORR:TRIG:FREE, otherwise waits for the trigger signal. The
command waits for the completion of the measurement.
Calibration > Calibrate > Response (Open) > Load (Optional)
Calibration > Calibrate > Response (Short) > Load (Optional)
Calibration > Calibrate > 1-Port SOL Cal > Load
Equivalent Softkeys Calibration > Calibrate > One Path 2-Port Cal > Load

Calibration > Calibrate > 2-Port SOLT Cal > Port n Load

Calibration > Calibrate > 3-Port SOLT Cal > Reflection Port n > Load

Calibration > Calibrate > 4-Port SOLT Cal > Reflection Port n > Load
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SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.OPEN

Measures the calibration data of the open standard for the

Description R
specified port.
Type Long (write only)
Range Port number is 1 to 2 (4 for S4VNA).
Out of Range An error occurs (error code: 222).
Target Channel Ch from 1 to 16
Syntax app.SCPI.SENSe(Ch).CORRection.COLLect. ACQuire.OPEN= 1
The command starts the measurement immediately if the trigger source
Notes for calibration set to the ‘Internal by the command
SENS:CORR:TRIG:FREE, otherwise waits for the trigger signal. The
command waits for the completion of the measurement.
Calibration > Calibrate > Response (Open) > Open
Calibration > Calibrate > 1-Port SOL Cal > Open
Calibration > Calibrate > One Path 2-Port Cal > Open
Equivalent Softkeys

Calibration > Calibrate > 2-Port SOLT Cal > Port n Open
Calibration > Calibrate > 3-Port SOLT Cal > Reflection Port n > Open

Calibration > Calibrate > 4-Port SOLT Cal > Reflection Port n > Open
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SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.SHORt

Measures the calibration data of the short standard for the

Description R
specified port.
Type Long (write only)
Range Port number is 1 to 2 (4 for S4VNA).
Out of Range An error occurs (error code: 222).
Target Channel Ch from 1 to 16
Syntax app.SCPI.SENSe(Ch).CORRection.COLLect. ACQuire.SHORt = 1
The command starts the measurement immediately if the trigger source
Notes for calibration set to the ‘Internal by the command
SENS:CORR:TRIG:FREE, otherwise waits for the trigger signal. The
command waits for the completion of the measurement.
Calibration > Calibrate > Response (Short) > Short
Calibration > Calibrate > 1-Port SOL Cal > Short
Calibration > Calibrate > One Path 2-Port Cal > Short
Equivalent Softkeys

Calibration > Calibrate > 2-Port SOLT Cal > Port n Short

Calibration > Calibrate > 3—Port SOLT Cal > Reflection Port n > Short

Calibration > Calibrate > 4—Port SOLT Cal > Reflection Port n > Short
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SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.SUBClass

Sets/gets the subclass number which is used for the calibration of
the selected channel (Ch). For example, if two different subclasses

Description are set in advance, say Thru 1 & Thru 2, which are visible at the
calibration softkey, this command can select either Thrul or Thru2.
When performing Thru cal, either Thru 1 or Thru 2 set with this
command is used for the calibration.

Type Long (read/write)

Range 1to8

Target Channel Ch from 1 to 16
app.SCPI.SENSe(Ch).CORRection.COLLect. ACQuire.SUBClass = 2

Syntax
Subclass = app.SCPL.SENSe(Ch).CORRection.COLLect.ACQuire.SUBClass

Equivalent Softkeys None
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SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.THRU

Description

Measures the calibration data of the thru standard between the
source port and the receiver port.

The array contains 2 elements:
Data(0) the number of the receiver port;

Data(1) the number of the source port.

Type

Variant: array of long (write only)

Range

Port number is 1 to 2 (or 4 for S4VYNA). The array elements can not
contain the same port numbers.

Out of Range

If an incorrect port number is specified, an error occurs (error code: 222).
If the same port numbers are specified, an error occurs (error code: 220).

Target

Channel Ch from 1 to 16

Syntax

app.SCPI.SENSe(Ch).CORRection.COLLect. ACQuire.THRU= Array(1, 2)

Notes

The command starts the measurement immediately if the trigger source
for calibration set to the ‘Internal" by the command
SENS:CORR:TRIG:FREE, otherwise waits for the trigger signal. The
command waits for the completion of the measurement.

Equivalent Softkeys

Calibration > Calibrate > Response (Thru) > Thru
Calibration > Calibrate > One Path 2-Port Cal > Thru
Calibration > Calibrate > 2-Port SOLT Cal > Port x-y Thru
Calibration > Calibrate > 3-Port SOLT Cal > x-y Thru

Calibration > Calibrate > 4-Port SOLT Cal > Transmission > x-y Thru
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SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.TRLLine

Description

Measures the calibration data of the TRL Line/Match standard
between the source port and the receiver port. Line standard is
measured in both directions. Match standard requires two
commands to measure forward and reverse directions. Match is
connected to the stimulus port (second port).

The array contains 2 elements:
Data(0) the number of the receiver port;

Data(1) the number of the source port.

Type

Variant: array of long (write only)

Range

Port number is 1 to 4. The array elements can not contain the same port
numbers.

Out of Range

If an incorrect port number is specified, an error occurs (error code: 222).
If the same port numbers are specified, an error occurs (error code: 220).

Target

Channel Ch from 1 to 16

Syntax

app.SCPI.SENSe(Ch).CORRection.COLLect. ACQuire. TRLLine= Array(1, 2)

Notes

The command starts the measurement immediately if the trigger source
for calibration set to the ‘Internal by the command
SENS:CORR:TRIG:FREE, otherwise waits for the trigger signal. The
command waits for the completion of the measurement.

Equivalent Softkeys

Calibration > Calibrate > 2-Port TRL Cal > x-y Line/Match
Calibration > Calibrate > 3-Port TRL Cal > Line/Match > x-y Line/Match

Calibration > Calibrate > 4-Port TRL Cal > Line/Match > x-y Line/Match
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SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.TRLReflect

Measures the calibration data of the TRL Reflect standard for the

Description R
specified port.
Type Long (write only)
Range Port number is 1 to 4.
Out of Range An error occurs (error code: 222).
Target Channel Ch from 1 to 16
Syntax app.SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.TRLReflect = 1
The command starts the measurement immediately if the trigger source
Notes for calibration set to the ‘Internal by the command
SENS:CORR:TRIG:FREE, otherwise waits for the trigger signal. The
command waits for the completion of the measurement.
Calibration > Calibrate > 2-Port TRL Cal > Port x Reflect
Equivalent Softkeys Calibration > Calibrate > 3-Port TRL Cal > Reflect > Port x

Calibration > Calibrate > 4-Port TRL Cal > Reflect > Port x
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SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.TRLThru

Measures the calibration data of the TRL Thru/Line standard
between two ports. Thru/line standard is measured in both
directions.

Description .
The array contains 2 elements:
Data(0) the number of the first port;
Data(1) the number of the second port.
Type Variant: array of long (write only)
Rance Port number is 1 to 4. The array elements can not contain the same port
I numbers.
If an incorrect port number is specified, an error occurs (error code: 222).
Out of Range .
If the same port numbers are specified, an error occurs (error code: 220).
Target Channel Ch from 1 to 16
Syntax app.SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.TRLThru= Array(1, 2)
The command starts the measurement immediately if the trigger source
Notes for calibration set to the ‘Internal" by the command
SENS:CORR:TRIG:FREE, otherwise waits for the trigger signal. The
command waits for the completion of the measurement.
Calibration > Calibrate > 2-Port TRL Cal > x-y Thru/Line
Equivalent Softkeys Calibration > Calibrate > 3-Port TRL Cal > Thru/Line > x-y Thru/Line

Calibration > Calibrate > 4-Port TRL Cal > Thru/Line > x-y Thru/Line
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.LABel

Description Sets/gets the calibration kit label.
Type String (read/write)
Parameter Label
Tarcet Calibration kit, selected for channel Ch,
I Ch:  channel number 1-16
Syntax Lab = app.SCPL.SENSe(Ch).CORRection.COLLect.CKIT.LABel
app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.LABel = "Userl"
Equivalent Softkeys | Calibration > Cal Kit > Label

SCPL.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.LOAD(Pt)

Sets/gets the number of the calibration standard of the load type,

Description used for the measurement of the specified port Pt,
Pt:  port number 1-2 (4 for S4VNA)
Type Long (read/write)
Range From 1 to the number of standards in the calibration kit.
If the specified standard number is greater than the number of standards
in the kit, an error occurs (error code: 222). If the specified standard
Out of Range .
number is not the load standard number, an error occurs (error code:
220).
Toroet Calibration kit, selected for channel Ch,
I Ch:  channel number 1-16
Num = app.SCPL.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.LOAD(Pt)
Syntax
app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.LOAD(Pt) = 1
Equivalent Softkeys

Calibration > Cal Kit > Specify CLSs > Load Port n (Row)
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.OPEN(PT)

Sets/gets the number of the calibration standard of the open type,

Description used for the measurement of the specified port Pt,
Pt:  port number 1-2 (4 for S4VNA)
Type Long (read/write)
Range From 1 to the number of standards in the calibration kit.
If the specified standard number is greater than the number of standards
in the kit, an error occurs (error code: 222). If the specified standard
Out of Range .
number is not the open standard number, an error occurs (error code:
220).
Tarcet Calibration kit, selected for channel Ch,
I Ch:  channel number 1-16
Num = app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.OPEN(Pt)
Syntax
app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.OPEN(Pt) = 1
Equivalent Softkeys

Calibration > Cal Kit > Specify CLSs > Open Port x (Row)

SCPIL.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.SELect

Sets/gets the subclass used to specify classes of calbration

Description standards by the commands
SCPI.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.XXXX.

Type Long (read/write)

Range 1to 8.

Tarcet Calibration kit, selected for channel Ch,

’ Ch:  channel number 1-16

Num = app.SCPL.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.SELect

Syntax
app.SCP1.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.SELect = 1

Equivalent Softkeys

Calibration > Cal Kit > Specify CLSs > Subclass n (Column)
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.SHOR¢t(Pt)

Sets/gets the number of the calibration standard of the short type,

Description used for the measurement of the specified port Pt,
Pt:  port number 1-2 (4 for S4VNA)
Type Long (read/write)
Range From 1 to the number of standards in the calibration kit.
If the specified standard number is greater than the number of standards
in the kit, an error occurs (error code: 222). If the specified standard
Out of Range .
number is not the short standard number, an error occurs (error code:
220).
Tarcet Calibration kit, selected for channel Ch,
I Ch:  channel number 1-16
Num = app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.SHORt(Pt)
Syntax
app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.SHORt(Pt) = 1
Equivalent Softkeys

Calibration > Cal Kit > Specify CLSs > Short Port x (Row)
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.THRU(Pt_m, Pt_n)

Sets/gets the number of the calibration standard of the thru type,
used for the measurement between the Pt_m and Pt_n ports,

Description
Pt m: port number 1-2 (4 for S4VNA)
Pt n: port number 1-2 (4 for S4VNA)
Type Long (read/write)
Range From 1 to the number of standards in the calibration kit.
If the specified standard number is greater than the number of standards
Out of Range in the kit, an error occurs (error code: 222). If the specified standard
I number is not the thru standard number, an error occurs (error code:
220).
Tarcet Calibration kit, selected for channel Ch,
! Ch:  channel number 1-16
Num = app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.THRU(1, 2)
Syntax
app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.THRU(1, 2) = 1
Equivalent Softkeys

Calibration > Cal Kit > Specify CLSs > Thru Port x-y (Row)
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.TRLLine(Pt_m, Pt_n)

Sets/gets the number of the calibration standard of the TRL
Line/Match type, used for the measurement between the Pt m and

Description Pt n ports,
Pt m: port number 1-2 (4 for S4VNA)
Pt n: port number 1-2 (4 for S4VNA)
Type Long (read/write)
Range From 1 to the number of standards in the calibration kit.
If the specified standard number is greater than the number of standards
A in the kit, an error occurs (error code: 222). If the specified standard
I number is not the thru standard number, an error occurs (error code:
220).
Tarcet Calibration kit, selected for channel Ch,
! Ch:  channel number 1-16
Num = app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.TRLLine(1, 2)
Syntax
app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.TRLLine(1,2) =1
Equivalent Softkeys | Calibration > Cal Kit > Specify CLSs > TRL Line/Match Port x-y (Row)
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.TRLReflect(Pt)

Sets/gets the number of the calibration standard of the TRL

Description Reflect type, used for the measurement of the specified port Pt,
Pt:  port number 1-2 (4 for S4VNA)
Type Long (read/write)
Range From 1 to the number of standards in the calibration kit.
If the specified standard number is greater than the number of standards
in the kit, an error occurs (error code: 222). If the specified standard
Out of Range .
number is not the short standard number, an error occurs (error code:
220).
Tarcet Calibration kit, selected for channel Ch,
I Ch:  channel number 1-16
Num = app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.TRLReflect(Pt)
Syntax
app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.TRLReflect(Pt) = 1
Equivalent Softkeys

Calibration > Cal Kit > Specify CLSs > TRL Reflect Port x (Row)
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.TRLThru(Pt_m, Pt_n)

Sets/gets the number of the calibration standard of the TRL Thru
type, used for the measurement between the Pt m and Pt_n ports,

Description
Pt m: port number 1-2 (4 for S4VNA)
Pt n: port number 1-2 (4 for S4VNA)
Type Long (read/write)
Range From 1 to the number of standards in the calibration kit.
If the specified standard number is greater than the number of standards
Out of Range in the kit, an error occurs (error code: 222). If the specified standard
I number is not the thru standard number, an error occurs (error code:
220).
Tarcet Calibration kit, selected for channel Ch,
! Ch:  channel number 1-16
Num = app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.TRLThru(1, 2)
Syntax
app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.ORDer.TRLThru(1, 2) = 1
Equivalent Softkeys

Calibration > Cal Kit > Specify CLSs > TRL Thru Port x-y (Row)

SCPIL.SENSe(Ch).CORRection.COLLect.CKIT.RESet

Description Resets the calibration kit to the factory settings.
Type Method
Tarcet Calibration kit, selected for channel Ch,

I Ch: channel number 1-16
Syntax app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.RESet
Equivalent Softkeys Calibration > Cal Kit > Restore Cal Kit
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.SELect

Description Sets/gets the selected calibration kit for the channel.
Type Long (read/write)
Range from 1 to 50
Out of Range An error occurs. Error code: 222.
Preset Value 1
Target Channel Ch from 1 to 16

Value = app.SCPL.SENSe(Ch).CORRection.COLLect.CKIT.SELect
e app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.SELect = 3
Equivalent Softkeys | Calibration > Cal Kit > Select n

224




SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).ARBitrary

Sets/gets the value of the arbitrary impedance for the load

Description
standard.
Type Double (read/write)
Range from -1E18 to 1E18
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

50 or 75, depending on the selected calibration kit.

Unit Q (Ohm)
Standard Std of the calibration kit specified for channel Ch,
Target Ch: channel number 1-16
Std:  calibration standard number 1-30
Syntax Value = app.SCPL.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).ARBitrary
app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).ARBitrary = 50
Equivalent Softkeys Calibration > Cal Kit > Define STDs > Terminal Impedance
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).CO

Description Sets/gets the CO value of the open calibration standard.
Type Double (read/write)

Range from -1E18 to 1E18

Out of Range Sets the value of the limit, which is closer to the specified value.
Unit 1E-15 F (Farad)

Standard Std of the calibration kit specified for channel Ch,
Target Ch: channel number 1-16
Std:  standard number 1-30

Value = app.SCPL.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).CO
app.SCPL.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).CO = 100

Syntax

Equivalent Softkeys | Calibration > Cal Kit > Define STDs > CO 10-*°F

SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).C1

Description Sets/gets the C1 value of the open calibration standard.
Type Double (read/write)

Range from -1E18 to 1E18

Out of Range Sets the value of the limit, which is closer to the specified value.
Unit 1E-27 F/Hz (Farad/Hertz)

Standard Std of the calibration kit specified for channel Ch,
Target Ch:  channel number 1-16
Std:  standard number 1-30

Value = app.SCPL.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).C1
Syntax

app.SCP1.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).C1 = 100

Equivalent Softkeys | Calibration > Cal Kit > Define STDs > C1 102 F/Hz
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).C2

Description Sets/gets the C2 value of the open calibration standard.
Type Double (read/write)

Range from -1E18 to 1E18

Out of Range Sets the value of the limit, which is closer to the specified value.
Unit 1E-36 F/Hz? (Farad/Hertz?)

Standard Std of the calibration kit specified for channel Ch,
Target Ch: channel number 1-16
Std:  standard number 1-30

Value = app.SCPL.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).C2
Syntax

app.SCPL.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).C2 = 100

Equivalent Softkeys | Calibration > Cal Kit > Define STDs > C2 10736 F/Hz>

SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).C3

Description Sets/gets the C3 value of the open calibration standard.
Type Double (read/write)

Range from -1E18 to 1E18

Out of Range Sets the value of the limit, which is closer to the specified value.
Unit 1E-45 F/HZ* (Farad/Hertz®)

Standard Std of the calibration kit specified for channel Ch,
Target Ch:  channel number 1-16
Std:  standard number 1-30

Value = app.SCPL.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).C3
Syntax

app.SCP1.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).C3 = 100

Equivalent Softkeys | Calibration > Cal Kit > Define STDs > C3 10~* F/Hz?
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).DELay

Description Sets/gets the offset delay value of the calibration standard.
Type Double (read/write)
Range from -1E18 to 1E18
Out of Range Sets the value of the limit, which is closer to the specified value.
Unit s (second)

Standard Std of the calibration kit specified for channel Ch,
Target Ch: channel number 1-16

Std:  standard number 1-30

Value = app.SCPL.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).DELay
Syntax

app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).DELay = 93E-12
Equivalent Softkeys

Calibration > Cal Kit > Define STDs > Offset Delay
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).FMAXimum

Sets/gets the maximum frequency value of the calibration

Description

standard.
Type Double (read/write)
Range from O to 1E14
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 999GHz
Unit Hz (Hertz)

Standard Std of the calibration kit specified for channel Ch,
Target Ch: channel number 1-16

Std:  standard number 1-30

Value = app.SCPL.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).FMAXimum
Syntax

app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).FMAXimum = 3E9
Equivalent Softkeys

Calibration > Cal Kit > Define STDs > Frequency max
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).FMINimum

Sets/gets the minimum frequency value of the calibration

Description

standard.
Type Double (read/write)
Range from O to 1E14
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 0 Hz
Unit Hz (Hertz)

Standard Std of the calibration kit specified for channel Ch,
Target Ch:  channel number 1-16

Std:  standard number 1-30

Value = app.SCPL.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).FMINimum
Syntax

app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).FMINimum = 3E9
Equivalent Softkeys

Calibration > Cal Kit > Define STDs > Frequency min
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).LO

Description Sets/gets the LO value of the short calibration standard.
Type Double (read/write)
Range from -1E18 to 1E18
Out of Range Sets the value of the limit, which is closer to the specified value.
Unit 1E-12 H (Henry)

Standard Std of the calibration kit specified for channel Ch,
Target Ch: channel number 1-16

Std:  standard number 1-30

Value = app.SCPL.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).LO
Syntax

app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).LO = 100
Equivalent Softkeys | Calibration > Cal Kit > Define STDs > L0 10-12H
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).L1

Description Sets/gets the L1 value of the short calibration standard.
Type Double (read/write)

Range from -1E18 to 1E18

Out of Range Sets the value of the limit, which is closer to the specified value.
Unit 1E-24 H/Hz (Henry/Hertz)

Standard Std of the calibration kit specified for channel Ch,
Target Ch: channel number 1-16
Std:  standard number 1-30

Value = app.SCPL.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).L1
Syntax

app.SCPL.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).L1 = 100

Equivalent Softkeys | Calibration > Cal Kit > Define STDs > L1 10-2*H/Hz

SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).L2

Description Sets/gets the L2 value of the short calibration standard.
Type Double (read/write)

Range from -1E18 to 1E18

Out of Range Sets the value of the limit, which is closer to the specified value.
Unit 1E-33 H/Hz? (Henry/Hertz?)

Standard Std of the calibration kit specified for channel Ch,
Target Ch:  channel number 1-16
Std:  standard number

Value = app.SCPL.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).L2
Syntax

app.SCP1.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).L2 = 100

Equivalent Softkeys | Calibration > Cal Kit > Define STDs > L2 10-%3 H/Hz>
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).L3

Description Sets/gets the L3 value of the short calibration standard.
Type Double (read/write)

Range from -1E18 to 1E18

Out of Range Sets the value of the limit, which is closer to the specified value.
Unit 1E-42 H/HZz?® (Henry/Hertz®)

Standard Std of the calibration kit specified for channel Ch,
Target Ch: channel number 1-16
Std:  standard number 1-30

Value = app.SCPL.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).L3
Syntax

app.SCPL.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).L3 = 100

Equivalent Softkeys | Calibration > Cal Kit > Define STDs > L3 10-*? H/Hz?

SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).LABel

Description Sets/gets the label of the calibration standard.
Type String (read/write)
Parameter Label

Standard Std of the calibration kit specified for channel Ch,
Target Ch:  channel number 1-16
Std:  standard number 1-30

Lab = app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).LABel
Syntax

app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).LABel = "Open”

Equivalent Softkeys | Calibration > Cal Kit > Define STDs > Standard Label
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).LOSS

Description Sets/gets the offset loss value of the calibration standard.
Type Double (read/write)
Range from -1E18 to 1E18
Out of Range Sets the value of the limit, which is closer to the specified value.
Unit Q/s (Ohm/second)

Standard Std of the calibration kit specified for channel Ch,
Target Ch: channel number 1-16

Std:  standard number 1-30

Value = app.SCPL.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).LOSS
Syntax

app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).LOSS = 700E6
Equivalent Softkeys | Calibration > Cal Kit > Define STDs > Offset Loss
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).TYPE

Description Sets/gets the type of the calibration standard.
Type String (read/write)

"OPEN" : Open

"SHORt" : Short

"LOAD" : Load

"THRU" : Thru
Parameter

"UTHRuU" : Unknown Thru

"SLID" : Sliding load

"DATA" : Data based standard

"NONE" : Not defined

Standard Std of the calibration kit specified for channel Ch,
Target Ch: channel number 1-16

Std:  standard number 1-30

Param = app.SCPL.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).TYPE
Syntax

app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).TYPE = "OPEN"
Equivalent Softkeys

Calibration > Cal Kit > Define STDs > Standard Type
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SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).Z0

Description Sets/gets the offset ZO value of the calibration standard.
Type Double (read/write)

Range from O to 1E18

Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

50 or 75, depending on the selected calibration kit.

Unit Q (Ohm)

Standard Std of the calibration kit specified for channel Ch,
Target Ch: channel number 1-16

Std:  standard number 1-30

Value = app.SCPL.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).Z0
Syntax

app.SCPI.SENSe(Ch).CORRection.COLLect.CKIT.STAN(Std).Z0 = 50
Equivalent Softkeys | Calibration > Cal Kit > Define STDs > Offset Z0
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SCPI.SENSe(Ch).CORRection.COLLect.CLEar

Description

Clears the measurement values of the calibration standards.

Type

Method

Target

Channel Ch from 1 to 16

Syntax

app.SCPI.SENSe(Ch).CORRection.COLLect.CLEar

Equivalent Softkeys

Calibration > Calibrate >
Response (Open) |
Response (Short) |
Response (Thru) |
One Path 2-Port Cal |
1-Port SOL Cal |
2-Port SOLT Cal |
3-Port SOLT Cal |
4-Port SOLT Cal |
2-Port TRL Cal |
3-Port TRL Cal |
4-Port TRL Cal |

> Cancel > OK
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SCPI.SENSe(Ch).CORRection.COLLect.DATA.ISOLation(Pt_r, Pt _s)

Sets/gets the array of the isolation calibration measurements
performed between the receiver port Pt_r and the source port Pt s,
Pt r: the number of the receiver port 1-2 (4 for S4VNA)
Pt s: the number of the source port 1-2 (4 for S4VNA)

The array elements are complex numbers. Also see section 14.

Description . . .
The array size is 2N, where N is the number of measurement
points.
For the n-th point, where n from 1 to N:
Data(Z2n-2)  real part of the measurement;
Data(2n-1) imaginary part of the measurement.
Type Variant: array of double (read/write)
Target Channel Ch from 1 to 16
Data = app.SCPL.SENSe(Ch).CORRection.COLLect.DATA.ISOLation(Pt_r, Pt_s)
Syntax

app.SCPI.SENSe(Ch).CORRection.COLLect.DATA.ISOLation(Pt_r, Pt_s) = Data

Related Commands

SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.ISOLation

Equivalent Softkeys

None
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SCPI.SENSe(Ch).CORRection.COLLect.DATA.LOAD(Pt)

Description

Sets/gets the array of the load calibration standard measurements
for the port P,
Pt: port number 1-2 (4 for S4VNA)

The array elements are complex numbers. Also see section 14.

The array size is 2N, where N is the number of measurement
points.
For the n—th point, where n from 1 to N:

Data(Z2n-2)  real part of the measurement;

Data(2n-1)  imaginary part of the measurement.

Type

Variant: array of double (read/write)

Target

Channel Ch from 1 to 16

Syntax

Data = app.SCPI.SENSe(Ch).CORRection.COLLect.DATA.LOAD(Pt)
app.SCPI.SENSe(Ch).CORRection.COLLect.DATA.LOAD(Pt) = Data

Related Commands

SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.LOAD

Equivalent Softkeys

None
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SCPI.SENSe(Ch).CORRection.COLLect.DATA.OPEN(Pt)

Sets/gets the array of the open calibration standard measurements
for the port P,
Pt:  port number 1-2 (4 for S4VNA)

The array elements are complex numbers. Also see section 14.

Description The array size is 2N, where N is the number of measurement
points.
For the n—th point, where n from 1 to N:
Data(Z2n-2)  real part of the measurement;
Data(2n-1)  imaginary part of the measurement.
Type Variant: array of double (read/write)
Target Channel Ch from 1 to 16
Data = app.SCPI.SENSe(Ch).CORRection.COLLect.DATA.OPEN(Pt)
Syntax

app.SCPI.SENSe(Ch).CORRection.COLLect.DATA.OPEN(Pt) = Data

Related Commands

SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.OPEN

Equivalent Softkeys

None
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SCPI.SENSe(Ch).CORRection.COLLect.DATA.SHORt(Pt)

Sets/gets the array of the short calibration standard measurements
for the port P,
Pt:  port number 1-2 (4 for S4VNA)

The array elements are complex numbers. Also see section 14.

Description The array size is 2N, where N is the number of measurement
points.
For the n—th point, where n from 1 to N:
Data(Z2n-2)  real part of the measurement;
Data(2n-1)  imaginary part of the measurement.
Type Variant: array of double (read/write)
Target Channel Ch from 1 to 16
Data = app.SCPI.SENSe(Ch).CORRection.COLLect.DATA.SHORt(Pt)
Syntax

app.SCPI.SENSe(Ch).CORRection.COLLect.DATA.SHORt(Pt) = Data

Related Commands

SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.SHORt

Equivalent Softkeys

None
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SCPI.SENSe(Ch).CORRection.COLLect.DATA.THRU.MATCh(Pt_r,Pt _s)

Sets/gets the array of the reflection measurements of the thru
standard connected between the receiver port Pt r and the source
port Pt s,

Pt r: the number of the receiver port 1-2 (4 for S4VNA)

Pt s: the number of the source port 1-2 (4 for S4VNA)

The array elements are complex numbers. Also see section 14.

Description
The array size is 2N, where N is the number of measurement
points.
For the n-th point, where n from 1 to N:
Data(2n-2) real part of the measurement;
Data(2n-1) imaginary part of the measurement.
Type Variant: array of double (read/write)
Target Channel Ch from 1 to 16
Data = app.SCPI.SENSe(Ch).CORRection.COLLect. DATA.THRU.MATCh(Pt_r, Pt_s)
Syntax

app.SCPI.SENSe(Ch).CORRection.COLLect.DATA.THRU.MATCh(Pt r, Pt s) = Data

Related Commands

SCPI.SENSe(Ch).CORRection.COLLect. ACQuire.THRU

Equivalent Softkeys

None
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SCPI.SENSe((/).CORRection.COLLect.DATA.THRU.TRANsmission(/Pt 1, Pt s)

Sets/gets the array of the transmission measurements performed
between the receiver port Pt r and the source port Pt_s, using the
thru standard,

Pt r: the number of the receiver port 1-2 (4 for S4VNA)

Pt s: the number of the source port 1-2 (4 for S4VNA)

The array elements are complex numbers. Also see section 14.

Description
The array size is 2N, where N is the number of measurement
points.
For the n-th point, where n from 1 to N:
Data(2n-2) real part of the measurement;
Data(2n-1) imaginary part of the measurement.
Type Variant: array of double (read/write)
Target Channel Ch from 1 to 16
Data = app.SCPI.SENSe(Ch).CORRection.COLLect. DATA.THRU.TRANsmission(Pt_r,
Pt s)
Syntax

app.SCPI.SENSe(Ch).CORRection.COLLect.DATA.THRU.TRANsmission(Pt r, Pt s) =
Data

Related Commands

SCPI.SENSe(Ch).CORRection.COLLect. ACQuire.THRU

Equivalent Softkeys

None
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SCPI.SENSe(Ch).CORRection.COLLect.ECAL.CCHeck.ACQuire

Executes the confidence check of the calibration coefficients of
specified channel using the AutoCal module.

The command sets the AutoCal Module to the special internal

Description state, reads the S-parameters of this state from the AutoCal
Module and sets memory traces so that they can be compared with
actual measured data. Comparison is carried out visually by the
user.

Type Method

Target Channel Ch from 1 to 16

Syntax app.SCPI.SENSe(Ch).CORRection.COLLect.ECAL.CCHeck. ACQuire

Equivalent Softkeys | Calibration > AutoCal > Confidence Check

SCPL.SENSe(Ch).CORRection.COLLect.ECAL.ERESponse

Executes one path 2-port calibration between the specified 2 ports

peseription of selected channel (Ch) using the AutoCal module.

Type Variant: array of long (write only)

Target Channel Ch from 1 to 16

Syntax app.SCPL.SENSe(Ch).CORRection.COLLect.ECAL.ERESponse = Array(2, 1)
Equivalent Softkeys | Calibration > AutoCal > One Path 2-Port Cal > Port x-y
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SCPI.SENSe(1).CORRection.COLLect.ECAL.INFormation

Autocal Module Information:
Model Name,
Serial Number,
Current Temperature of AutoCal Module,
Selected Characterization Information:
Characterization Name,
Characterization Date and Time,
Min Frequency,
Max Frequency,
Number of Points,
Characterization Temperature,
PortA Connector,
PortB Connector,
PortA Adapter,
PortB Adapter,
Analyzer,
Location,
Operator.

Description

Gets information about the AutoCal Module connected to the
Network Analyzer in a string with comma separated fields.

Type String (read only)

Target AutoCal module

Syntax ID = app.SCPI.SENSe(1).CORRection.COLLect.ECAL.INFormation

Equivalent Softkeys Calibration > AutoCal > Characterization Info...
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SCPI.SENSe(1).CORRection.COLLect.ECAL.ORIenation.STATe

Description

Turns ON/OFF the state of the Auto-Orientation function used
when executing AutoCal.

Type

Boolean (read/write)

Parameter

True: Auto-Orientation function ON
False:  Auto-Orientation function OFF

Preset Value False
Target AutoCal

Status = app.SCPI.SENSe(1).CORRection.COLLect.ECAL.ORIentation.STATe
Syntax

app.SCPI.SENSe(1).CORRection.COLLect.ECAL.ORIentation.STATe = False
Equivalent Softkeys Calibration > AutoCal > Orientation > Auto-Orientation

SCPI.SENSe(1).CORRection.COLLect.ECAL.PATH(Pt)

Sets or reads out the AutoCal module port number which is

Description

connected to a selected Network Analyzer port (Pt).
Type Long (read/write)

1: Port A of AutoCal Module

2: Port B of AutoCal Module
Parameter

3: Port C of AutoCal Module (4 port AutoCal module only)

4: Port D of AutoCal Module (4 port AutoCal module only)
Target AutoCal

Value = app.SCPL.SENSe(2).CORRection.COLLect.ECAL.PATH(P)
Syntax

app.SCPI.SENSe(1).CORRection.COLLect.ECAL.PATH(Pt) = 2
Equivalent Softkeys Calibration > AutoCal > Orientation > Port x
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SCPI.SENSe(Ch).CORRection.COLLect.ECAL.SOLT1

Executes 1-port calibration of the specified port of selected

pescripron channel (Ch) using the AutoCal module.

Type Long (write only)

Target Channel Ch from 1 to 16

Syntax app.SCPI.SENSe(Ch).CORRection.COLLect.ECAL.SOLT1 = Port
Equivalent Softkeys | Calibration > AutoCal > 1-Port Cal > Port x

SCPIL.SENSe(Ch).CORRection.COLLect.ECAL.SOLT2

Executes full 2-port calibration between the specified 2 ports of

peseripton selected channel (Ch) using the AutoCal module.

Type Variant: array of long (write only)

Target Channel Ch from 1 to 16

Syntax app.SCP1.SENSe(Ch).CORRection.COLLect.ECAL.SOLT2 = Array(2, 1)
Fquivalent Softkeys | Calibration > AutoCal > 2-Port Cal > Port x-y
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SCPI.SENSe(Ch).CORRection.COLLect.ECAL.SOLT3

Executes full 3-port calibration between the specified 3 ports of

Description selected channel (Ch) using the AutoCal module (4-port AutoCal
module only).

Type Variant: array of long (write only)

Target Channel Ch from 1 to 16

Syntax app.SCPI.SENSe(Ch).CORRection.COLLect.ECAL.SOLT3 = Array(1, 2,3)

Equivalent Softkeys | Calibration > AutoCal > 3-Port Cal > Select Ports [x-y-Z]

Calibration > AutoCal > 3-Port Cal > 4-Port Autocal Module

SCPI.SENSe(Ch).CORRection.COLLect.ECAL.SOLT4

Executes full 4-port calibration between the specified 4 ports of

Description selected channel (Ch) using the AutoCal module (4-port AutoCal
module only).

Type Variant: array of long (write only)

Target Channel Ch from 1 to 16

Syntax app.SCPI.SENSe(Ch).CORRection.COLLect.ECAL.SOLT4 = Array(1,2,3,4)

Equivalent Softkeys | Calibration > AutoCal > 3-Port Cal > 4-Port Autocal Module
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SCPI.SENSe(1).CORRection.COLLect.ECAL.UCHar

Sets or reads out the Characteristic number used when executing

Description . .
AutoCal (factory or user characterization).
Type String (read/write)
"CHARO" : Factory characterization
"CHAR1" : User characterization 1
Parameter . .
"CHAR2" : User characterization 2
"CHAR3" : User characterization 3
Preset Value CHARO
Target AutoCal
Param = app.SCPI.SENSe(1).CORRection.COLLect.ECAL.UCHar
Syntax
app.SCPI.SENSe(1).CORRection.COLLect.ECAL.UCHar = "CHARQ"
Equivalent Softkeys | Calibration > AutoCal > Characterization
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SCPI.SENSe(1).CORRection.COLLect.ECAL.UTHRu.STATe

Description

Turns ON/OFF the state of the Unknown Thru feature used when
executing AutoCal.

Type

Boolean (read/write)

Parameter

True: Unknown Thru feature ON
False: Unknown Thru feature OFF

Preset Value False
Target AutoCal

Status = app.SCPI.SENSe(1).CORRection.COLLect.ECAL.UTHRu.STATe
Syntax

app.SCPI.SENSe(1).CORRection.COLLect.ECAL.UTHRu.STATe = False
Note PLANAR 304/1 does not support
Equivalent Softkeys Calibration > AutoCal > Unkn Thru
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SCPIL.SENSe(Ch).CORRection.COLLect. METHod.ERESponse

Selects the ports and sets the one path 2-port calibration type for
the calculation of the calibration coefficients on completion of the
calibration executed by the
SCPI.SENSe(Ch).CORRection.COLLect.SAVE method.

Description
The array contains 2 elements:
Data(0) the number of the receiver port;
Data(1) the number of the source port.
Type Variant: array of long (write only)
panae Port number is 1 to 2 (4 for S4VNA). The array elements can not contain
I the same port numbers.
Out of Range If an incorrect port number is specified, an error occurs (error code: 222).
If the same port numbers are specified, an error occurs (error code: 220).
Target Channel Ch from 1 to 16
Syntax app.SCPI.SENSe(Ch).CORRection.COLLect.METHod.ERESponse = Array(2, 1)
Equivalent Softkeys Calibration > Calibrate > One Path 2-Port Cal > Select Ports
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SCPI.SENSe(Ch).CORRection.COLLect.METHod.RESPonse.OPEN

Selects the port and sets the response calibration (Open) type for
the calculation of the calibration coefficients on completion of the

Descrption calibration executed by the
SCPI.SENSe(Ch).CORRection.COLLect.SAVE method.

Type Long (write only)

Range Port number from 1 to 2 (4 for S4VNA)

Out of Range An error occurs. Error code: 222.

Target Channel Ch from 1 to 16

Syntax app.SCPI.SENSe(Ch).CORRection.COLLect.METHod.RESPonse.OPEN =1

Equivalent Softkeys | Calibration > Calibrate > Response (Open) > Select Port

SCPIL.SENSe(Ch).CORRection.COLLect. METHod.RESPonse.SHORt

Selects the port and sets the response calibration (Short) type for
the calculation of the calibration coefficients on completion of the

Descrpion calibration executed by the
SCPI.SENSe(Ch).CORRection.COLLect.SAVE method.

Type Long (write only)

Range Port number from 1 to 2 (4 for S4VNA)

Out of Range An error occurs. Error code: 222.

Target Channel Ch from 1 to 16

Syntax app.SCPI.SENSe(Ch).CORRection.COLLect.METHod.RESPonse.HORt = 1

Equivalent Softkeys | Calibration > Calibrate > Response (Short) > Select Port

252




SCPI.SENSe(Ch).CORRection.COLLect.METHod.RESPonse.THRU

Selects the ports and sets the response calibration (Thru) type for
the calculation of the calibration coefficients on completion of the
calibration executed by the
SCPI.SENSe(Ch).CORRection.COLLect.SAVE method.

Description
The array contains 2 elements:
Data(0) the number of the receiver port;
Data(1) the number of the source port.
Type Variant: array of long (write only)
panae Port number is 1 to 2 (4 for S4VNA). Array elements can not contain the
I same port numbers.
Out of Range If an incorrect port number is specified, an error occurs (error code: 222).
If the same port numbers are specified, an error occurs (error code: 220).
Target Channel Ch from 1 to 16
Syntax app.SCPI.SENSe(Ch).CORRection.COLLect.METHod.RESPonse. THRU = Array(2, 1)
Equivalent Softkeys Calibration > Calibrate > Response (Thru) > Select Ports
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SCPI.SENSe(Ch).CORRection.COLLect.METHod.SOLT1

Selects the port and sets the full 1-port calibration type for the
calculation of the calibration coefficients on completion of the

Descrption calibration executed by the
SCPI.SENSe(Ch).CORRection.COLLect.SAVE method.

Type Long (write only)

Range Port number from 1 to 2 (4 for S4VNA)

Out of Range An error occurs. Error code: 222.

Target Channel Ch from 1 to 16

Syntax app.SCPI.SENSe(Ch).CORRection.COLLect.METHod.SOLT1 =1

Equivalent Softkeys | Calibration > Calibrate > 1-Port SOL Cal > Select Port
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SCPI.SENSe(Ch).CORRection.COLLect.METHod.SOLT2

Selects the port and sets the 2-port SOLT calibration type for the
calculation of the calibration coefficients on completion of the
calibration executed by the
SCPI.SENSe(Ch).CORRection.COLLect.SAVE method.

Description
The array contains 2 elements:
Data(0) specifies a port for full 2-port calibration 1-4;
Data(1) specifies a port for full 2-port calibration 1-4.
Type Variant: array of long (write only)
panae Port number is 1 to 2 (4 for S4VNA). Array elements can not contain the
I same port numbers.
If an incorrect port number is specified, an error occurs (error code: 222).
Out of Range .
If the same port numbers are specified, an error occurs (error code: 220).
Target Channel Ch from 1 to 16
Syntax app.SCP1.SENSe(Ch).CORRection.COLLect. METHod.SOLT2 = Array(2, 1)
Equivalent Softkeys Calibration > Calibrate > 2-Port SOLT Cal > Select Ports
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SCPI.SENSe(Ch).CORRection.COLLect.METHod.SOLT3

Description

Selects the port and sets the 3-port SOLT calibration type for the
calculation of the calibration coefficients on completion of the
calibration executed by the
SCPI.SENSe(Ch).CORRection.COLLect.SAVE method.

The array contains 3 elements:

Data(0) specifies a port for full 3-port calibration;
Data(1) specifies a port for full 3-port calibration;
Data(2) specifies a port for full 3-port calibration.
(S4VNA only)
Type Variant: array of long (write only)
Rance Port number is 1 to 4. Array elements can not contain the same port
I numbers.
Out of Range If an incorrect port number is specified, an error occurs (error code: 222).
I If the same port numbers are specified, an error occurs (error code: 220).
Target Channel Ch from 1 to 16
Syntax app.SCPI.SENSe(Ch).CORRection.COLLect.METHod.SOLT3 = Array(1, 2, 4)
Equivalent Softkeys Calibration > Calibrate > 3-Port SOLT Cal > Select Ports
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SCPI.SENSe(Ch).CORRection.COLLect.METHod.SOLT4

Selects the port and sets the 4-port SOLT calibration type for the
calculation of the calibration coefficients on completion of the
calibration executed by the
SCPI.SENSe(Ch).CORRection.COLLect.SAVE method.

The array contains 4 elements:

Description Data(0) specifies a port for full 4-port calibration;
Data(1) specifies a port for full 4-port calibration;
Data(2) specifies a port for full 4-port calibration;
Data(3) specifies a port for full 4-port calibration.
(S4VNA only)
Type Variant: array of long (write only)
panae Port number is 1 to 4. Array elements can not contain the same port
I numbers.
Out of Range If an incorrect port number is specified, an error occurs (error code: 222).
If the same port numbers are specified, an error occurs (error code: 220).
Target Channel Ch from 1 to 16
Syntax app.SCPI.SENSe(Ch).CORRection.COLLect. METHod.SOLT4 = Array(1, 2, 3, 4)
Equivalent Softkeys Calibration > Calibrate > 4-Port SOLT Cal
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SCPI.SENSe(Ch).CORRection.COLLect.METHod.TRL2

Selects the port and sets the Z2-port TRL calibration type for the
calculation of the calibration coefficients on completion of the
calibration executed by the
SCPI.SENSe(Ch).CORRection.COLLect.SAVE method.

Description
The array contains 2 elements:
Data(0) specifies a port for 2-port TRL calibration;
Data(1) specifies a port for 2-port TRL calibration.
Type Variant: array of long (write only)
panae Port number is 1 to 4. Array elements can not contain the same port
I numbers.
Out of Range If an incorrect port number is specified, an error occurs (error code: 222).
If the same port numbers are specified, an error occurs (error code: 220).
Target Channel Ch from 1 to 16
Syntax app.SCP1.SENSe(Ch).CORRection.COLLect. METHod.TRL2 = Array(1, 2)
Equivalent Softkeys Calibration > Calibrate > 2-Port TRL Cal > Select Ports
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SCPI.SENSe(Ch).CORRection.COLLect.METHod.TRL3

Description

Selects the port and sets the 3-port TRL calibration type for the
calculation of the calibration coefficients on completion of the
calibration executed by the
SCPI.SENSe(Ch).CORRection.COLLect.SAVE method.

The array contains 3 elements:

Data(0) specifies a port for 3-port TRL calibration;
Data(1) specifies a port for 3-port TRL calibration;
Data(2) specifies a port for 3-port TRL calibration.
(S4VNA only)
Type Variant: array of long (write only)
Rance Port number is 1 to 4. Array elements can not contain the same port
I numbers.
Out of Range If an incorrect port number is specified, an error occurs (error code: 222).
I If the same port numbers are specified, an error occurs (error code: 220).

Target Channel Ch from 1 to 16

Syntax app.SCPI.SENSe(Ch).CORRection.COLLect.METHod.TRL3 = Array(1, 2, 3)

Equivalent Softkeys Calibration > Calibrate > 3-Port TRL Cal > Select Ports
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SCPI.SENSe(Ch).CORRection.COLLect.METHod.TRL4

Selects the port and sets the 4-port TRL calibration type for the
calculation of the calibration coefficients on completion of the
calibration executed by the
SCPI.SENSe(Ch).CORRection.COLLect.SAVE method.

The array contains 4 elements:

Description Data(0) specifies a port for 4-port TRL calibration;
Data(1) specifies a port for 4-port TRL calibration;
Data(2) specifies a port for 4-port TRL calibration;
Data(3) specifies a port for 4-port TRL calibration.
(S4VNA only)
Type Variant: array of long (write only)
panae Port number is 1 to 4. Array elements can not contain the same port
I numbers.
If an incorrect port number is specified, an error occurs (error code: 222).
Out of Range .
If the same port numbers are specified, an error occurs (error code: 220).
Target Channel Ch from 1 to 16
Syntax app.SCPI.SENSe(Ch).CORRection.COLLect. METHod.TRL4 = Array(1, 2, 3, 4)
Equivalent Softkeys Calibration > Calibrate > 4-Port TRL Cal
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SCPI.SENSe(Ch).CORRection.COLLect.METHod.TYPE

Reads out the calibration type selected for calculating of the

Description calibration coefficients on completion of the calibration executed
by the SCPI.SENSe(Ch).CORRection.COLLect.SAVE method.
Type String (read only)
"RESPO" : Response (Open)
"RESPS”" : Response (Short)
"RESPT" : Response (Thru)
"1PATH" : One path 2-port calibration
"SOLT1" : Full 1-port calibration
"SOLT2" : Full 2-port calibration
Parameter . .
"SOLT3" : Full 3—-port calibration
"SOLT4" : Full 4-port calibration
"TRL2" : 2-port TRL calibration
"TRL3" : 3—port TRL calibration
"TRL4" : 4-port TRL calibration
"NONE" : Not defined
Target Channel Ch from 1 to 16
Syntax Param = app.SCPL.SENSe(Ch).CORRection.COLLect. METHod.TYPE
Equivalent Softkeys None
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SCPI.SENSe(Ch).CORRection.COLLect.SAVE

Calculates the calibration coefficients from the calibration
standards measurements depending on the selected calibration

type.
On completion of the method, all the calibration standards

measurements are cleared and the error correction automatically
turns ON.

Description .
At the attempt to execute this method before all the needed
standards are measured, an error occurs and the method is
ignored.
Before executing this command it is neccessery to select
calibration type by one of commands
SCPI.SENSe(Ch).CORRection.COLLect.METHod.XXXX.

Type Method

Target Channel Ch from 1 to 16

Syntax

app.SCPI.SENSe(Ch).CORRection.COLLect.SAVE

Related Commands

Calibration type selection:
SCPI.SENSe(Ch).CORRection.COLLect.METHod.RESPonse.OPEN
SCPI.SENSe(Ch).CORRection.COLLect.METHod.RESPonse.SHORt
SCPI.SENSe(Ch).CORRection.COLLect.METHod.RESPonse. THRU
SCPI.SENSe(Ch).CORRection.COLLect.METHod.ERESponse
SCPI.SENSe(Ch).CORRection.COLLect.METHod.SOLT1
SCPI.SENSe(Ch).CORRection.COLLect.METHod.SOLT2
SCPI.SENSe(Ch).CORRection.COLLect.METHod.SOLT3
SCPI.SENSe(Ch).CORRection.COLLect.METHod.SOLT4
SCPI.SENSe(Ch).CORRection.COLLect.METHod.TRL2
SCPI.SENSe(Ch).CORRection.COLLect.METHod.TRL3
SCPI.SENSe(Ch).CORRection.COLLect.METHod.TRL4
Calibration standards measurement:
SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.ISOLation
SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.LOAD
SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.OPEN
SCPI.SENSe(Ch).CORRection.COLLect. ACQuire.SHORt
SCPI.SENSe(Ch).CORRection.COLLect. ACQuire.THRU
SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.TRLLine
SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.TRLReflect
SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.TRLThru

Equivalent Softkeys

Calibration > Calibrate > Response (Open) | Response (Short) | Response
(Thru) | One Path 2-Port Cal | 1-Port SOL Cal | 2-Port SOLT Cal |3-Port
SOLT Cal |[4-Port SOLT Cal |2-Port TRL Cal |3-Port TRL Cal |4-Port TRL
Cal | > Apply
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SCPI.SENSe(Ch).CORRection.COLLect.SIMPlified.SAVE

Same as SCPI.SENSe(Ch).CORRection.COLLect.SAVE method.
Allows to accomplish 3 and 4 port calibration with non complete

Description set of standard measurements. About omissible calibration
standards see user guide chapter "Simplified calibration”.

Type Method

Target Channel Ch from 1 to 16

Syntax

app.SCPI.SENSe(Ch).CORRection.COLLect.SIMPLlified.SAVE

Related Commands

Calibration type selection:
SCPI.SENSe(Ch).CORRection.COLLect.METHod.SOLT3
SCPI.SENSe(Ch).CORRection.COLLect.METHod.SOLT4
SCPI.SENSe(Ch).CORRection.COLLect.METHod.TRL3
SCPI.SENSe(Ch).CORRection.COLLect.METHod.TRL4
Calibration standards measurement:
SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.ISOLation
SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.THRU
SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.TRLLine

Equivalent Softkeys

Calibration > Calibrate > 3-Port SOLT Cal |4-Port SOLT Cal |3-Port TRL
Cal |4-Port TRL Cal | > Apply
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SCPIL.SENSe(Ch).CORRection.EXTension.PORT(Pt).FREQuency(Ls)

Sets/gets the value of the frequency at the point number Ls for

Description calculation of the loss for the port extension function,
Ls:  point number 1-2
Type Double (read/write)
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value 1E9
Unit Hz (Hertz)

Port Pt of channel Ch,
Target Ch:  channel number 1-16

Pt: port number 1-2 (4 for S4VNA)

Value = app.SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).FREQuency(Ls)
Syntax

app.SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).FREQuency(Ls) = 100E6
Equivalent Softkeys Calibration > Port Extensions > Loss Port n > Freql | Freq2
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SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).INCLude(Ls).STATe

Turns ON/OFF the state of the loss compensation at the point

Description number Ls to calculate the loss for the port extension function,
Ls:  point number 1-2
Type Boolean (read/write)

Parameter

True: Loss compensation ON
False:  Loss compensation OFF

Preset Value

False

Port Pt of channel Ch,

Target Ch:  channel number 1-16
Pt: port number 1-2 (4 for S4VNA)
Status = app.SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).INCLude(Ls).STATe
Syntax
app.SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).INCLude(Ls).STATe = True
Equivalent Softkeys Calibration > Port Extensions > Loss Port n > Loss1 | Loss2
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SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).LDC

Sets/gets the loss value at DC for the loss calculation of the port

peseripton extension function.

Type Double (read/write)

Range from =200 to 200

Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Unit dB (decibel)

Port Pt of channel Ch,
Target Ch:  channel number 1-16

pt: port number 1-2 (4 for S4VNA)

Value = app.SCPL.SENSe(Ch).CORRection.EXTension.PORT(Pt).LDC
Syntax

app.SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).LDC = 10
Equivalent Softkeys | Calibration > Port Extensions > Loss Port n > Loss at DC
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SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).LOSS(Ls)

Sets/gets the loss value at the point number Ls to calculate the

Description loss for the port extension function,
Ls: point number 1-2
Type Double (read/write)
Range from -200 to 200
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Unit dB (decibel)
Port Pt of channel Ch,
Target Ch:  channel number 1-16
Pt: port number 1-2 (4 for S4VNA)
Value = app.SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).LOSS(Ls)
Syntax

app.SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).LOSS(Ls) = 10

Equivalent Softkeys

Calibration > Port Extensions > Loss Port n > Loss1 | Loss2
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SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).TIME

Description Sets/gets the electrical delay value for the port extension function.
Type Double (read/write)

Range from -10to 10

Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value 0

Unit s (second)

Port Pt of channel Ch,
Target Ch: channel number 1-16
pt: port number 1-2 (4 for S4VNA)

Value = app.SCPL.SENSe(Ch).CORRection.EXTension.PORT(Pt).TIME
Syntax

app.SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt). TIME = 10E-9

Equivalent Softkeys | Calibration > Port Extensions > Extension Port n

SCPI.SENSe(Ch).CORRection.EXTension.STATe

Description Turns ON/OFF the state of the port extension function.
Type Boolean (read/write)

True: Port extension function ON
Parameter

False: Port extension function OFF

Preset Value False

Target Channel Ch from 1 to 16

Status = app.SCPIL.SENSe(Ch).CORRection.EXTension.STATe
app.SCPI.SENSe(Ch).CORRection.EXTension.STATe = True

Syntax

Equivalent Softkeys Calibration > Port Extensions > Extensions
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SCPIL.SENSe(Ch).CORRection.INFormation(rPt, sPt)

Description Reads out the calibration information string for port pair.
Type String (read only)

Target Channel Ch from 1 to 16

Syntax Calinfo = app.SCPI.SENSe(Ch).CORRection.INFormation(rPt, sPt)
Equivalent Softkeys None

SCPIL.SENSe(1).CORRection.IMPedance.INPut.MAGNitude

Description Sets/gets the system characteristic impedance (Z0) value.
Type Double (read/write)

Range from 0.001 to 1000

Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 50

Unit Q (Ohm)

Value = app.SCPI.SENSe.CORRection.IMPedance.INPut.MAGNitude
Syntax

app.SCPI.SENSe.CORRection.IMPedance.INPut.MAGNitude = 50

Object SENSe has an index of 1, which can be omitted in Visual Basic but
it cannot be omitted in other programming languages.

Warning

Equivalent Softkeys Calibration > System Z0
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SCPI.SENSe(Ch).CORRection.OFFSet.CLEar

Description Clears the scalar mixer calibration coefficient table.
Type Method

Target Channel Ch from 1 to 16

Syntax app.SCPI.SENSe(Ch).CORRection.OFFSet.CLEar

Equivalent Softkeys None

SCPIL.SENSe(Ch).CORRection.OFFSet.COLLect.ACQuire.LOAD

Measures the calibration data of the load standard of the specified
port when the frequency offset feature is on (scalar mixer cal).

Description The array contains 2 elements:
Port(0) Measurement port number;
Port(1) Frequency port number.
Type Variant: array of long (write only)
Range Port number is 1 to 2 (4 for S4VNA). The array elements can contain the
same port numbers.
Out of Range If an incorrect port number is specified, an error occurs (error code: 222).
Target Channel Ch from 1 to 16
Syntax app.SCPI.SENSe(Ch).CORRection.OFFSet.COLLect.ACQuire.LOAD = Array(1, 2)
The command starts the measurement immediately if the trigger source
Notes for calibration set to the ‘Internal by the command
SENS:CORR:TRIG:FREE, otherwise waits for the trigger signal. The
command waits for the completion of the measurement.
, Calibration > Mixer/Converter Calibration > Scalar Mixer Calibration >
Equivalent Softkeys

Reflection Port n > Port n @Freq m Load
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SCPI.SENSe(Ch).CORRection.OFFSet.COLLect.ACQuire.OPEN

Measures the calibration data of the open standard of the specified
port when the frequency offset feature is on (scalar mixer cal).

Description The array contains 2 elements:
Port(0) Measurement port number;
Port(1) Frequency port number.
Type Variant: array of long (write only)
Range Port number is 1 to 2 (4 for S4VNA). The array elements can contain the
same port numbers.
Out of Range If an incorrect port number is specified, an error occurs (error code: 222).
Target Channel Ch from 1 to 16
Syntax app.SCPI.SENSe(Ch).CORRection.OFFSet.COLLect.ACQuire.OPEN = Array(1, 2)
The command starts the measurement immediately if the trigger source
Notes for calibration set to the ‘Internal" by the command
SENS:CORR:TRIG:FREE, otherwise waits for the trigger signal. The
command waits for the completion of the measurement.
, Calibration > Mixer/Converter Calibration > Scalar Mixer Calibration >
Equivalent Softkeys

Reflection Port n > Port n @Freq m Open
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SCPI.SENSe(Ch).CORRection.OFFSet.COLLect.ACQuire.SHORt

Measures the calibration data of the short standard of the
specified port when the frequency offset feature is on (scalar mixer
cal).

Description .
The array contains 2 elements:
Port(0) Measurement port number;
Port(1) Frequency port number.
Type Variant: array of long (write only)
Range Port number is 1 to 2 (4 for S4VNA). The array elements can contain the
same port numbers.
Out of Range If an incorrect port number is specified, an error occurs (error code: 222).
Target Channel Ch from 1 to 16
Syntax app.SCPI.SENSe(Ch).CORRection.OFFSet.COLLect.ACQuire.SHORt = Array(1, 2)
The command starts the measurement immediately if the trigger source
Notes for calibration set to the ‘Internal" by the command
SENS:CORR:TRIG:FREE, otherwise waits for the trigger signal. The
command waits for the completion of the measurement.
, Calibration > Mixer/Converter Calibration > Scalar Mixer Calibration >
Equivalent Softkeys

Reflection Port n > Port n @Freq m Short
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SCPI.SENSe(Ch).CORRection.OFFSet.COLLect.ACQuire.THRU

Measures the calibration data of the thru standard of the specified
port when the frequency offset feature is on (scalar mixer cal).

Description The array contains 2 elements:
Port(0) Response port number;
Port(1) Stimulus port number.
Type Variant: array of long (write only)
Range Port number is 1 to 2 (4 for S4VNA). The array elements can not contain
the same port numbers.
If an incorrect port number is specified, an error occurs (error code: 222).
Out of Range .
If the same port numbers are specified, an error occurs (error code: 220).
Target Channel Ch from 1 to 16
Syntax app.SCPI.SENSe(Ch).CORRection.OFFSet.COLLect. ACQuire.THRU = Array(1, 2)
The command starts the measurement immediately if the trigger source
Notes for calibration set to the ‘Internal" by the command
SENS:CORR:TRIG:FREE, otherwise waits for the trigger signal. The
command waits for the completion of the measurement.
_ Calibration > Mixer/Converter Calibration > Scalar Mixer Calibration >
Equivalent Softkeys

Reflection Port n > Port n @Freq m Thru
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SCPI.SENSe(Ch).CORRection.OFFSet.COLLect.ACQuire.PMETer

Measures the scalar-mixer calibration data using the power meter
when the frequency offset feature is ON.

The array contains 3 elements:

Description
Port(0) Measurement port number;
Port(1) Frequency port number.
Port(2) Reserved.
Type Variant: array of long (write only)
Range Port number is 1 to 2 (4 for S4VNA). The array elements can contain the
same port numbers.
Out of Range If an incorrect port number is specified, an error occurs (error code: 222).
Target Channel Ch from 1 to 16
Syntax app.SCPI.SENSe(Ch).CORRection.OFFSet.COLLect.ACQuire.PMETer = Array(1, 2, 0)
The command starts the measurement for the channel independently of
Notes the trigger initiation and trigger source settings. The command waits for
the completion of the measurement.
_ Calibration > Mixer/Converter Calibration > Scalar Mixer Calibration >
Equivalent Softkeys

Power > Port n @Freq m
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SCPI.SENSe(Ch).CORRection.OFFSet.COLLect.CLEar

Clears the calibration measurement data when the frequency

Description . . . .
offset feature is ON (scalar mixer calibration).
Type Method
Target Channel Ch from 1 to 16
Syntax app.SCPI.SENSe(Ch).CORRection.OFFSet.COLLect.CLEar
Calibration > Mixer/Converter Calibration > Scalar Mixer Calibration >
Equivalent Softkeys

Cancel

SCPIL.SENSe(Ch).CORRection.OFFSet.COLLect.METHod.SMIX2

Selects the ports and sets the scalar mixer calibration type when
the frequency offset feature is on for the calculation of the
calibration coefficients on completion of the calibration executed
by the SCPI.SENSe(Ch).CORRection.OFFSet.COLLect.SAVE

Description method.
The array contains 2 elements:
Port(0) Port number 1;
Port(1) Port number 2.
Type Variant: array of long (write only)
Ranae Port number is 1 to 2 (4 for S4VNA). The array elements can not contain
I the same port numbers.
If an incorrect port number is specified, an error occurs (error code: 222).
Out of Range .
If the same port numbers are specified, an error occurs (error code: 220).
Target Channel Ch from 1 to 16
Syntax app.SCPI.SENSe(Ch).CORRection.OFFSet.COLLect.METHod.SMIX2 = Array(2, 1)
Equivalent Softkeys Calibration > Mixer/Converter Calibration > Scalar Mixer Calibration
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SCPI.SENSe(Ch).CORRection.OFFSet.COLLect.SAVE

Calculates the calibration coefficient for the selected calibration
type (scalar mixer calibration only) from the calibration data
measured with the frequency offset feature is ON.

Description
If this command is executed before all necessary calibration data
for calculating the calibration coefficient is measured, an error
occurs when executed.

Type Method

Target Channel Ch from 1 to 16

Syntax app.SCPI.SENSe(Ch).CORRection.OFFSet.COLLect.SAVE

Related Commands

SCPIL.SENSe(Ch).CORRection.OFFSet.COLLect.METHod.SMIX2
SCPI.SENSe(Ch).CORRection.OFFSet.COLLect. ACQuire.LOAD
SCPI.SENSe(Ch).CORRection.OFFSet.COLLect.ACQuire.OPEN

).
).
).
).
SCPI.SENSe(Ch).CORRection.OFFSet.COLLect.ACQuire.THRU

).

(

(

(
SCPI.SENSe(Ch).CORRection.OFFSet.COLLect. ACQuire. SHORt

(

(

SCPI.SENSe(Ch).CORRection.OFFSet.COLLect. ACQuire.PMETer

Equivalent Softkeys

Calibration > Mixer/Converter Calibration > Scalar Mixer Calibration >
Apply
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SCPI.SENSe(Ch).CORRection.RECeiver(Pt).COLLect.ACQuire

The port number Src writing executes the receiver calibration (T -
channel) for the specified port Pt, using the specified source port

Description Src to the right of the equal sign. Then executes the receiver
calibration (R - channel) for the specified port Pt, using port Pt as
source (the specified source port Src is ignored).

Type Long (write only)

Range The number of the source port from 1 to 2 (4 for S4VNA).

Out of Range Error occurs. Error code: 222.

Port Pt of channel Ch,
Target Ch:  channel number 1-16
Pt: port number 1-2 (4 for S4VNA)

Syntax app.SCPI.SENSe(Ch).CORRection.RECeiver(Pt).COLLect.ACQuire = Src
The command starts the measurement for the channel independently of

Notes the trigger initiation and trigger source settings. The command waits for
the completion of the measurement.

Equivalent Softkeys Calibration > Receiver Calibration > Calibrate Both
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SCPI.SENSe(Ch).CORRection.RECeiver(Pt).COLLect.RCHannel.ACQuire

Method executes the receiver calibration (R - channel) for the

Description R .
specified port Pt, using port Pt as source.
Type Method
Port Pt of channel Ch,
Target Ch:  channel number 1-16
Pt: port number 1-2 (4 for S4VNA)
Syntax app.SCPI.SENSe(Ch).CORRection.RECeiver(Pt).COLLect.ACQuire
The command starts the measurement for the channel independently of
Notes the trigger initiation and trigger source settings. The command waits for
the completion of the measurement.
Equivalent Softkeys Calibration > Receiver Calibration > Calibrate Reference Receiver

SCPIL.SENSe(Ch).CORRection.RECeiver(Pt).COLLect.TCHannel.ACQuire

The port number Src writing executes the receiver calibration (T -

Description channel) for the specified port Pt, using the specified source port
Src to the right of the equal sign.
Type Long (write only)
Range The number of the source port from 1 to 4.
Out of Range Error occurs. Error code: 222.
Port Pt of channel Ch,
Target Ch:  channel number 1-16
Pt: port number 1-2 (4 for S4VNA)
Syntax app.SCP1.SENSe(Ch).CORRection.RECeiver(Pt).COLLect.ACQuire = Src
The command starts the measurement for the channel independently of
Notes the trigger initiation and trigger source settings. The command waits for
the completion of the measurement.
Equivalent Softkeys Calibration > Receiver Calibration > Calibrate Test Receiver
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SCPI.SENSe(Ch).CORRection.RECeiver(Pt).OFFSet.AMPlitude

Sets/gets the power offset value for Receiver Calibration. Receiver
Description calibration is done at the condition of <source power> + <Specified
offset>, for selected channel (Ch).

Type Double (read/write)
Range -200 to 200.

Unit dB (decibel)

Preset Value 0

Port Pt of channel Ch,
Target Ch: channel number 1-16
Pt: port number 1-2 (4 for S4VNA)

Offset = app.SCPL.SENSe(Ch).CORRection.RECeiver(Pt).OFFSet. AMPLitude
app.SCPI.SENSe(Ch).CORRection.RECeiver(Pt).OFFSet. AMPLitude = -10

Syntax

Equivalent Softkeys Calibration > Receiver Calibration > Power Offset

SCPIL.SENSe(Ch).CORRection.RECeiver(Pt).STATe

Description Turns ON/OFF the state of the receiver correction for the port Pt.
Type Boolean (read/write)
True: Receiver correction ON

Parameter . .
False: Receiver correction OFF

Preset Value False

Port Pt of channel Ch,
Target Ch:  channel number 1-16
Pt: port number 1-2 (4 for S4VNA)

Status = app.SCPI.SENSe(Ch).CORRection.RECeiver(Pt).STATe
app.SCPI.SENSe(Ch).CORRection.RECeiver(Pt).STATe = True

Syntax

Equivalent Softkeys Calibration > Receiver Calibration > Correction
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SCPI.SENSe(Ch).CORRection.STATe

Turns ON/OFF the state of the error correction (user calibration of

Description

S-parameters).
Type Boolean (read/write)

True: Error correction ON
Parameter

False: Error correction OFF

Preset Value

False

Target Channel Ch from 1 to 16

Status = app.SCPI.SENSe(Ch).CORRection.STATe
Syntax

app.SCPI.SENSe(Ch).CORRection.STATe = True
Equivalent Softkeys Calibration > Correction
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SCPI.SENSe(Ch).CORRection.TYPE(Tr)

Reads out the information about the applied calibration type and
the port numbers for the specified trace.

The array contains 5 elements:

Data(0) calibration type (see below);
Data(1) the port number to which the calibration is
applied;
Description
Data(2) the port number to which the calibration is
applied.
Data(3) the port number to which the calibration is
applied.
Data(4) the port number to which the calibration is
applied.
Type Variant: array of Variants (read only)

Calibration type in the element Data(0):

"RESPO" : Response (Open)

"RESPS” : Response (Short)

"RESPT" : Response (Thru)

"SOLT1" : Full 1-port calibration
Parameter "SOLT2" : Full 2-port calibration

"SOLT3" : Full 3-port calibration

"SOLT4" : Full 4-port calibration

"1PATH" : One path 2-port calibration

"NONE" : Not defined

Trace Tr of channel Ch,
Target Ch: channel number 1-16
Tr: trace number 1-16

Syntax Callnfo = app.SCPI.SENSe(Ch).CORRection.TYPE(TH)

Equivalent Softkeys None
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SCPI.SENSe(Ch). CORRection.TRANsform.TIME.FREQuency

Sets/gets the frequency at which the cable loss specified for the

Description cable correction function, when the time domain transformation
function is turned ON.
Type Double (read/write)

Preset Value 1 GHz.
Unit Hz (Hertz)
Target Channel Ch from 1 to 16

Value = app.SCP1.SENSe(Ch).CORRection.TRANsform.TIME.FREQuency
Syntax

app.SCPI.SENSe(Ch).CORRection. TRANsform.TIME.FREQuency = 1E9
Equivalent Softkeys

Analysis > Time Domain > Cable Correction > Frequency

SCPL.SENSe(Ch). CORRection.TRANsform.TIME.LOSS

Description

Sets/gets the cable loss value for the cable correction function,
when the time domain transformation function is turned ON.

Type

Double (read/write)

Preset Value

Unit dB/m (decibell / meter)
Target Channel Ch from 1 to 16

Value = app.SCPI.SENSe(Ch).CORRection.TRANsform.TIME.LOSS
Syntax

app.SCPI.SENSe(Ch).CORRection.TRANsform.TIME.LOSS = 1.4
Equivalent Softkeys

Analysis > Time Domain > Cable Correction > Cable Loss
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SCPI.SENSe(Ch). CORRection.TRANsform.TIME.RVELocity

Sets/gets the cable relative wave speed velocity for the cable

Description correction function, when the time domain transformation function
is turned ON.
Type Double (read/write)

Preset Value

Target Channel Ch from 1 to 16

Value = app.SCPI.SENSe(Ch).CORRection.TRANsform.TIME.RVELocity
Syntax

app.SCPI.SENSe(Ch).CORRection.TRANsform.TIME.RVELocity = 0.66
Equivalent Softkeys

Analysis > Time Domain > Cable Correction > Velocity Factor

SCPL.SENSe(Ch).CORRection.TRANsform.TIME.STATe

Description

Turns ON/OFF the state of the cable correction when the time
domain transformation function is turned ON.

Type

Boolean (read/write)

Parameter

True: cable correction ON
False: cable correction OFF

Preset Value

False

Target Channel Ch from 1 to 16

Status = app.SCP1.SENSe(Ch).CORRection. TRANsform.TIME.STATe
Syntax

app.SCPI.SENSe(Ch).CORRection.TRANsform.TIME.STATe = True
Equivalent Softkeys Analysis > Time Domain > Cable Correction > Cable Correction

283




SCPI.SENSe(Ch).CORRection.TRIGger.FREE.STATe

Enables/disables the internal trigger source for calibration. If the
internal trigger source for calibration is enabled then a command
of the calibration standard measurement starts the measurement
immediately. If the internal trigger source for calibration is
disabled then the system trigger source is used (which is set for
regular measurement with the command
SCPI.TRIGger.SEQuence.SOURce) to start the calibration standard
measurement.

The system trigger source also enables the averaging trigger

Description ; ] .
function (SCPI.TRIGger.SEQuence.AVERage) and the point trigger
function (SCPI.TRIGger.SEQuence.POINt) for calibration.

Note: When the system trigger source is selected you should avoid
the program trigger source (BUS), otherwise the program deadlock
is possible.

Note: The command does not apply to the electronic calibration,
the power calibration and the receiver calibration. The internal
trigger always used in these cases.

Type Boolean (read/write)

Parameter

True: Internal
False:  System

Preset Value

True

Target Channel Ch from 1 to 16

Status = app.SCP1.SENSe(Ch).CORRection.TRIGger.FREE.STATe
Syntax

app.SCPI.SENSe(Ch).CORRection. TRIGger.FREE.STATe = True
Equivalent Softkeys Calibration > Cal Trig Source { Internal | System }
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SCPI.SENSe(Ch).DATA.CORRdata(Param)

Reads out the corrected S-parameters array. The corrected
measurements are complex numbers. Also, see section 14.

The array size is 2N, where N is the number of measurement
points.

Description For the n—th point, where n from 1 to N:
Data(Zn-2)  the real part of corrected measurement;
Data(Zn-1) the imaginary part of corrected measurement.
The index of the array starts from O.
Type Variant: array of double (read only)
Param of String type selects S-parameter:
"S11°,"S12","S13", "S14",
Parameter "S21°,"S22","S23", "S24",
"S31","S32","S33","S34",
"S41°,"S42", "S43", "S44"
Target Channel Ch from 1 to 16
Syntax Data = app.SCPI.SENSe(ch).DATA.CORRdata("S11")
Equivalent Softkeys None

285




SCPI.SENSe(Ch).DATA.RAWData(Param)

Reads out the raw S-parameters array (without correction). The raw
measurements are complex numbers. Also, see section 14.

The array size is 2N, where N is the number of measurement
points.

Description For the n—th point, where n from 1 to N:
Data(Zn-2)  the real part of corrected measurement;
Data(Zn-1) the imaginary part of corrected measurement.
The index of the array starts from O.
Type Variant: array of double (read only)
Param of String type selects S-parameter:
"S11°,"S12","S13", "S14",
Parameter "S21°,"S22","S23", "S24",
"S31","S32","S33","S34",
"S41°,"S42", "S43", "S44"
Target Channel Ch from 1 to 16
Syntax Data = app.SCPI.SENSe(ch).DATA.RAWData("S11")
Equivalent Softkeys None
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SCPI.SENSe(Ch).FREQuency.CENTer

Description Sets/gets the stimulus center value of the sweep range for linear
or logarithmic sweep types.
Type Double (read/write)
Range from minimum to maximum frequency depends on model.
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value Center of frequency range depends on model.
Unit Hz (Hertz)
Target Channel Ch from 1 to 16
Value = app.SCPL.SENSe(Ch).FREQuency.CENTer
Syntax
app.SCPI.SENSe(Ch).FREQuency.CENTer = 1E9
Equivalent Softkeys Stimulus > Center
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SCPI.SENSe(Ch).FREQuency.CW

Description Sets/gets the value of the fixed frequency for the power sweep.
Type Double (read/write)

Range From minimum to maximum frequency depends on model.

Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Frequency minimum.

Unit Hz (Hertz)
Target Channel Ch from 1 to 16

Value = app.SCPI.SENSe(Ch).FREQuency.CW
Syntax

app.SCPI.SENSe(Ch).FREQuency.CW = 1E9
Equivalent Softkeys | Stimulus > Power > CW Freq

SCPL.SENSe(Ch).FREQuency.DATA

Reads out the frequency array of the measurement points for
linear, logarithmic or segment sweep type.

The array size is N, where N is the number of measurement points.

Description
For the n—th point, where n from 1 to N:
Data(n-1) the frequency value at the n-th measurement
point.
Type Variant: array of double (read only)
Unit Hz (Hertz)
Target Channel Ch from 1 to 16
Syntax Data = app.SCPI.SENSe(Ch).FREQuency.DATA
Equivalent Softkeys None
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SCPI.SENSe(Ch).FREQuency.SPAN

Sets/gets the stimulus span value of the sweep range for linear or

Description N .
logarithmic sweep types.
Type Double (read/write)
Range from minimum to maximum frequency depends on model.
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Full frequency span depending on model.

Unit Hz (Hertz)
Target Channel Ch from 1 to 16

Value = app.SCPL.SENSe(Ch).FREQuency.SPAN
Syntax

app.SCPI.SENSe(Ch).FREQuency.SPAN = 2E9
Equivalent Softkeys

Stimulus > Span
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SCPI.SENSe(Ch).FREQuency.STARt

Sets/gets the stimulus start value of the sweep range for linear or

Description N .
logarithmic sweep types.
Type Double (read/write)
Range from minimum to maximum frequency depends on model.
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Frequency minimum.

Unit Hz (Hertz)
Target Channel Ch from 1 to 16

Value = app.SCPL.SENSe(Ch).FREQuency.STARt
Syntax

app.SCPI.SENSe(Ch).FREQuency.STARt = 1E6
Equivalent Softkeys Stimulus > Start

290




SCPI.SENSe(Ch).FREQuency.STOP

Description Sets/gets the stimulus stop value of the sweep range for linear or
logarithmic sweep types.
Type Double (read/write)
Range from minimum to maximum frequency depends on model.
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value Frequency maximum.
Unit Hz (Hertz)
Target Channel Ch from 1 to 16
Value = app.SCPL.SENSe(Ch).FREQuency.STOP
Syntax
app.SCPI.SENSe(Ch).FREQuency.STOP = 1E6
Equivalent Softkeys Stimulus > Stop
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SCPI.SENSe(Ch).OFFSet.ADJust.CONTinuous.PERiod

Selects the period for continuous offset adjust feature:
1 - 3sec;
Description
2 - 10 sec;
3 - 30 sec.
Type Long (read/write)
Range from1to3
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 2
Target Channel Ch from 1 to 16
Value = app.SCPI.SENSe(Ch).OFFSet.ADJust.PERiod
Syntax
app.SCPI.SENSe(Ch).OFFSet.ADJust.PERiod = 1
Equivalent Softkeys | Stimulus > Frequency Offset > Offset Adjust > Adjust Period
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SCPI.SENSe(Ch).OFFSet.ADJust.CONTinuous.STATe

Description

Turns ON/OFF the state of the continuous frequency offset adjust
feature.

Type

Boolean (read/write)

Parameter

True: continuous offset adjust feature is ON
False:  continuous offset adjust feature is OFF

Preset Value

False

Target Channel Ch from 1 to 16
Status = app.SCPI.SENSe(Ch).OFFSet.ADJust.CONTinuous.STATe
Syntax
app.SCPI.SENSe(Ch).OFFSet.ADJust.CONTinuous.STATe = True
Equivalent Softkeys | Stimulus > Frequency Offset > Offset Adjust > Continuous Adjust

SCPI.SENSe(Ch).OFFSet.ADJust.EXECute

Description Executes the offset adjust when the frequency offset feature is ON.
Type Method

Target Channel Ch from 1 to 16

Syntax app.SCPI.SENSe(Ch).OFFset.ADJust.EXECute

Equivalent Softkeys | Stimulus > Frequency Offset > Offset Adjust > Adjust Immediate

293




SCPI.SENSe(Ch).OFFSet.ADJust.PORT

Description Selects the port number for frequency offset adjust feature.
Type Long (read/write)

Range Port number from 1 to 2 (4 for S4VNA)

Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value 1
Target Channel Ch from 1 to 16
Value = app.SCPL.SENSe(Ch).OFFset.ADJust.PORT
Syntax
app.SCPI.SENSe(Ch).OFFset.ADJust.PORT = 2
Equivalent Softkeys | Stimulus > Frequency Offset > Offset Adjust > Select Port

SCPI.SENSe(Ch).OFFSet.ADJust.STATe

Description

Turns ON/OFF the state of the frequency offset adjust feature.

Type

Boolean (read/write)

Parameter

True: offset adjust feature is ON
False:  offset adjust feature is OFF

Preset Value False
Target Channel Ch from 1 to 16
Status = app.SCPIL.SENSe(Ch).OFFSet.ADJust.STATe
e app.SCPI.SENSe(Ch).OFFSet.ADJust.STATe = True
Equivalent Softkeys Stimulus > Frequency Offset > Offset Adjust > Offset Adjust
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SCPI.SENSe(Ch).OFFSet.ADJust.Value

Sets/gets the frequency offset adjust value of the offset adjust

Description
feature.
Type Double (read/write)
Range from -5E5 to 5E5
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value 0
Unit Hz
Target Channel Ch from 1 to 16

Value = app.SCPL.SENSe(Ch).OFFSet.ADJust.VALue
Syntax

app.SCPI.SENSe(Ch).OFFSet.ADJust.VALue = 1000
Equivalent Softkeys

Stimulus > Frequency Offset > Offset Adjust > Adjust Value
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SCPI.SENSe(Ch).OFFSet.PORT(Pt).FREQuency.DATA

Reads out the frequency data for the selected port Pt when the
frequency offset feature is ON, and offset type is "PORT", for the
selected channel Ch.

Description The array size is N, where N is the number of measurement points.
For the n—th point, where n from 1 to N:
Data(n-1) the frequency value at the n-th measurement
point.
Type Variant: array of double (read only)
Port Pt of channel Ch,
Target Ch:  channel number 1-16
Pt:  port number 1-2 (4 for S4VNA)
Syntax

Data = app.SCPI.SENSe(Ch).OFFSet.PORT(Pt).FREQuency.DATA

Related commands

SCPI.SENSe(Ch).OFFset.STATe
SCPI.SENSe(Ch).OFFset.TYPE

Equivalent Softkeys

None
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SCPI.SENSe(Ch).OFFSet.PORT(Pt).FREQuency.DIVisor

Sets/gets the basic frequency range divisor when the frequency

Description .

offset feature is ON.
Type Double (read/write)
Range from 1 to 100
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 1

Port Pt of channel Ch,
Target Ch:  channel number 1-16

Pt:  port number 1-2 (4 for S4VNA)

Value = app.SCPI.SENSe(Ch).OFFset.PORT(Pt).FREQuency.DIVisor
Syntax

app.SCPI.SENSe(Ch).OFFset.PORT(Pt).FREQuency.DIVisor = 2
Equivalent Softkeys

Stimulus > Frequency Offset > Port n > Divider
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SCPI.SENSe(Ch).OFFSet.PORT(Pt).FREQuency. MULTiplier

Sets/gets the basic range frequency multiplier when the frequency

Description . e Y

offset feature is ON and offset type is "PORT".
Type Double (read/write)
Range from -100 to 100
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 1

Port Pt of channel Ch,
Target Ch:  channel number 1-16

Pt:  port number 1-2 (4 for S4VNA)

Value = app.SCPI.SENSe(Ch).OFFset.PORT(Pt).FREQuency.MULTiplier
Syntax

app.SCP1.SENSe(Ch).OFFset.PORT(Pt).FREQuency.MULTiplier = 2
Equivalent Softkeys

Stimulus > Frequency Offset > Port n > Multiplier
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SCPI.SENSe(Ch).OFFSet.PORT(Pt).FREQuency.OFFSet

Description Sets/gets the basic frequency range offset when the frequency
offset feature is ON and offset type is "PORT"..
Type Double (read/write)
Range from -1le-12to 1lel2
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 0
Unit Hz
Port Pt of channel Ch,
Target Ch:  channel number 1-16
Pt:  port number 1-2 (4 for S4VNA)
Value = app.SCPL.SENSe(Ch).OFFset.PORT(Pt).FREQuency.OFFSet
Syntax
app.SCPI.SENSe(Ch).OFFset.PORT(Pt).FREQuency.OFFSet = 1e9
related Commands | SCPI.SENSe(Ch).OFFset.STATe
SCPI.SENSe(Ch).OFFset. TYPE
Equivalent Softkeys Stimulus > Frequency Offset > Port n > Offset
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SCPI.SENSe(Ch).OFFSet.PORT(Pt).FREQuency. STARt

Sets/gets the frequency sweep start when the frequency offset

Description . .

feature is ON and offset type is "PORT".
Type Double (read/write)
Unit Hz

Port Pt of channel Ch,
Target Ch:  channel number 1-16

Pt:  port number 1-2 (4 for S4VNA)

Syntax

Value = app.SCPL.SENSe(Ch).OFFset.PORT(Pt).FREQuency.STARt

Related commands

SCPI.SENSe(Ch).OFFset.STATe
SCPI.SENSe(Ch).OFFset.TYPE

Equivalent Softkeys

Stimulus > Frequency Offset > Port n > Start

SCPI.SENSe(Ch).OFFSet.PORT(Pt).FREQuency. STOP

Sets/gets the frequency sweep stop when the frequency offset

Description . e "

feature is ON. and offset type is "PORT".
Type Double (read/write)
Unit Hz

Port Pt of channel Ch,
Target Ch:  channel number 1-16

Pt:  port number 1-2 (4 for S4VNA)

Syntax

Value = app.SCPI.SENSe(Ch).OFFset.PORT(Pt).FREQuency.STOP

Related Commands

SCPI.SENSe(Ch).OFFset.STATe
SCPI.SENSe(Ch).OFFset. TYPE

Equivalent Softkeys

Stimulus > Frequency Offset > Port n > Stop
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SCPI.SENSe(Ch).OFFSet.RECeiver.FREQuency.DATA

Reads out the receiver frequency data when the frequency offset
feature is ON and offset type is "SRCRcv”, for the selected channel
Ch.

The array size is N, where N is the number of measurement points.

Description
For the n—th point, where n from 1 to N:
Data(n-1) the frequency value at the n-th measurement
point.
Type Variant: array of double (read only)
Target Channel Ch from 1 to 16
Syntax

Data = app.SCPI.SENSe(Ch).OFFSet.RECeiver.FREQuency.DATA

Related Commands

SCPI.SENSe(Ch).OFFset.STATe
SCPI.SENSe(Ch).OFFset. TYPE

Equivalent Softkeys

None
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SCPI.SENSe(Ch).OFFSet.RECeiver.FREQuency.DIVisor

Sets/gets the basic frequency range divisor when the frequency

Description . .
offset feature is ON and offset type is "SRCRcv".
Type Double (read/write)
Range from 1 to 1000
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Target

Channel Ch from 1 to 16

Syntax

Value = app.SCPI.SENSe(Ch).OFFset.RECeiver.FREQuency.DIVisor

app.SCPI.SENSe(Ch).OFFset.RECeiver.FREQuency.DIVisor = 2

Related Commands

SCPL.SENSe(Ch).OFFset.STATe
SCPL.SENSe(Ch).OFFset. TYPE

Equivalent Softkeys

Stimulus > Frequency Offset > Receivers > Divider
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SCPI.SENSe(Ch).OFFSet.RECeiver.FREQuency.MULTiplier

Sets/gets the basic range frequency multiplier when the frequency

Description . .
offset feature is ON and offset type is "SRCRcv".
Type Double (read/write)
Range from -1000 to 1000
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Target

Channel Ch from 1 to 16

Syntax

Value = app.SCPI.SENSe(Ch).OFFset.RECeiver.FREQuency.MULTiplier

app.SCPI.SENSe(Ch).OFFset.RECeiver.FREQuency.MULTiplier = 2

Related Commands

SCPL.SENSe(Ch).OFFset.STATe
SCPL.SENSe(Ch).OFFset. TYPE

Equivalent Softkeys

Stimulus > Frequency Offset > Receivers > Multiplier
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SCPI.SENSe(Ch).OFFSet.RECeiver.FREQuency.OFFSet

Sets/gets the basic frequency range offset when the frequency

Deseripion offset feature is ON and offset type is "SRCRcv".
Type Double (read/write)
Range from -1le-12 to lel2
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 0
Unit Hz
Target Channel Ch from 1 to 16
Value = app.SCPL.SENSe(Ch).OFFset.RECeiver.FREQuency.OFFSet
Syntax

app.SCPI.SENSe(Ch).OFFset.RECeiver.FREQuency.OFFSet = 1e9

Related Commands

SCPI.SENSe(Ch).OFFset.STATe
SCPI.SENSe(Ch).OFFset.TYPE

Equivalent Softkeys

Stimulus > Frequency Offset > Receivers > Offset

304




SCPI.SENSe(Ch).OFFSet.RECeiver.FREQuency.STARt

Sets/gets the frequency sweep start when the frequency offset

pescripron feature is ON and offset type is "SRCRcv".
Type Double (read/write)
Unit Hz
Target Channel Ch from 1 to 16
Value = app.SCPI.SENSe(Ch).OFFset.RECeiver.FREQuency.STARt
Syntax

app.SCPI.SENSe(Ch).OFFset.RECeiver.FREQuency.STARt = 1e9

Related Commands

SCPI.SENSe(Ch).OFFset.STATe
SCPI.SENSe(Ch).OFFset.TYPE

Equivalent Softkeys

Stimulus > Frequency Offset > Receivers > Start

SCPIL.SENSe(Ch).OFFSet.RECeiver.FREQuency.STOP

Sets/gets the frequency sweep stop when the frequency offset

Description feature is ON and offset type is "SRCRcv".
Type Double (read/write)
Unit Hz
Target Channel Ch from 1 to 16
Value = app.SCPI.SENSe(Ch).OFFset.RECeiver.FREQuency.STOP
Syntax

app.SCPI.SENSe(Ch).OFFset.RECeiver.FREQuency.STOP = 1e9

Related Commands

SCPI.SENSe(Ch).OFFset.STATe
SCPI.SENSe(Ch).OFFset. TYPE

Equivalent Softkeys

Stimulus > Frequency Offset > Receivers > Stop
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SCPI.SENSe(Ch).OFFSet.SOURce.FREQuency.DATA

Reads out the source frequency data when the frequency offset
feature is ON and offset type is "SRCRcv”, for the selected channel
Ch.

The array size is N, where N is the number of measurement points.

Description
For the n—th point, where n from 1 to N:
Data(n-1) the frequency value at the n-th measurement
point.
Type Variant: array of double (read only)
Target Channel Ch from 1 to 16
Syntax

Data = app.SCPI.SENSe(Ch).OFFSet.SOURce.FREQuency.DATA

Related Commands

SCPI.SENSe(Ch).OFFset.STATe
SCPI.SENSe(Ch).OFFset. TYPE

Equivalent Softkeys

None
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SCPI.SENSe(Ch).OFFSet.SOURce.FREQuency.DIVisor

Sets/gets the basic frequency range divisor when the frequency

Description . .
offset feature is ON and offset type is "SRCRcv".
Type Double (read/write)
Range from 1 to 1000
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Target

Channel Ch from 1 to 16

Syntax

Value = app.SCPI.SENSe(Ch).OFFset.SOURce.FREQuency.DIVisor

app.SCPI.SENSe(Ch).OFFset.SOURce.FREQuency.DIVisor = 2

Related Commands

SCPL.SENSe(Ch).OFFset.STATe
SCPL.SENSe(Ch).OFFset. TYPE

Equivalent Softkeys

Stimulus > Frequency Offset > Source > Divider
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SCPI.SENSe(Ch).OFFSet.SOURce.FREQuency.MULTiplier

Sets/gets the basic range frequency multiplier when the frequency

Description . .
offset feature is ON and offset type is "SRCRcv".
Type Double (read/write)
Range from -1000 to 1000
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Target

Channel Ch from 1 to 16

Syntax

Value = app.SCPI.SENSe(Ch).OFFset.SOURce.FREQuency.MULTiplier

app.SCPI.SENSe(Ch).OFFset.SOURce.FREQuency.MULTiplier = 2

Related Commands

SCPL.SENSe(Ch).OFFset.STATe
SCPL.SENSe(Ch).OFFset. TYPE

Equivalent Softkeys

Stimulus > Frequency Offset > Source > Multiplier
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SCPI.SENSe(Ch).OFFSet.SOURce.FREQuency.OFFSet

Sets/gets the basic frequency range offset when the frequency

Deseripion offset feature is ON and offset type is "SRCRcv".
Type Double (read/write)
Range from -1le-12 to lel2
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 0
Unit Hz
Target Channel Ch from 1 to 16
Value = app.SCPIL.SENSe(Ch).OFFset.SOURce.FREQuency.OFFSet
Syntax

app.SCPI.SENSe(Ch).OFFset.SOURce.FREQuency.OFFSet = 1e9

Related Commands

SCPI.SENSe(Ch).OFFset.STATe
SCPI.SENSe(Ch).OFFset.TYPE

Equivalent Softkeys

Stimulus > Frequency Offset > Source > Offset
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SCPI.SENSe(Ch).OFFSet.SOURce.FREQuency.STARt

Sets/gets the frequency sweep start when the frequency offset

pescripron feature is ON and offset type is "SRCRcv".
Type Double (read/write)
Unit Hz
Target Channel Ch from 1 to 16
Value = app.SCPI.SENSe(Ch).OFFset.SOURce.FREQuency.STARt
Syntax

app.SCPI.SENSe(Ch).OFFset.SOURce.FREQuency.STARt = 1e9

Related Commands

SCPI.SENSe(Ch).OFFset.STATe
SCPI.SENSe(Ch).OFFset.TYPE

Equivalent Softkeys

Stimulus > Frequency Offset > Source > Start

SCPIL.SENSe(Ch).OFFSet.SOURce.FREQuency.STOP

Sets/gets the frequency sweep stop when the frequency offset

Description feature is ON and offset type is " SRCRcv".
Type Double (read/write)
Unit Hz
Target Channel Ch from 1 to 16
Value = app.SCPI.SENSe(Ch).OFFset.SOURce.FREQuency.STOP
Syntax

app.SCPI.SENSe(Ch).OFFset.SOURce.FREQuency.STOP = 1e9

Related Commands

SCPI.SENSe(Ch).OFFset.STATe
SCPI.SENSe(Ch).OFFset. TYPE

Equivalent Softkeys

Stimulus > Frequency Offset > Source > Stop
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SCPI.SENSe(Ch).OFFSet.STATe

Description Turns ON/OFF the state of the frequency offset feature.
Type Boolean (read/write)

True: frequency offset feature is ON
Parameter

False:  frequency offset feature is OFF

Preset Value False
Target Channel Ch from 1 to 16
Status = app.SCPI.SENSe(Ch).OFFSet.STATe
Syntax
app.SCPI.SENSe(Ch).OFFSet.STATe = True
Equivalent Softkeys | Stimulus > Frequency Offset > Frequency Offset

SCPI.SENSe(Ch).OFFSet.TYPE

Sets/gets the frequency offset type when the frequency offset
feature is ON. There are two frequency offset types: "Port1l/Port2"

Description " . i )
and "Source/Receivers”. First offset type offsets ports against each
other. Second offset type offsets source against receivers.

Type String (read/write)

"PORT" : Port1/Port2
Parameter .
"SRCRev" : Source/Receivers
Preset Value "PORT"
Target Channel Ch from 1 to 16
Param = app.SCP1.SENSe(Ch).OFFSet. TYPE
Syntax
app.SCPI.SENSe(Ch).OFFSet.TYPE = "PORT"
Equivalent Softkeys Stimulus > Frequency Offset > Offset Type
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SCPI.SENSe(Ch).ROSCillator.SOURce

Selects the internal or external source of the reference frequency

Description

of 10 MHz.
Type String (read/write)

"INTernal" : Internal source of the reference frequency
Parameter Y "

EXTernal : External source of the reference frequency
Preset Value "INT"

Target Channel Ch from 1 to 16

Param = app.SCPL.SENSe(Ch).ROSCillator.SOURce
Syntax

app.SCPI.SENSe(Ch).ROSCillator.SOURce = "EXT"
Equivalent Softkeys

System > Misc Setup > Ref Source
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SCPI.SENSe(Ch).SEGMent.DATA

The array of the segment sweep table.

The array has the following format:

{ <Buf>, <Flagl>, <Flag2>, <Flag3>, <Flag4>, <Flag5>, <N>,
<Start(1)>, <Stop(1)>, <NOP(1)> [,<IFBW(1)>] [[<Pow(1)>] [,<Del(1)>] [,<Time(1)>],
<Start(2)>, <Stop(2)>, <NOP(2)> [,<IFBW(2)>] [,<Pow(2)>] [,<Del(2)>] [,<Time(2)>],

<Start(N)>, <Stop(N)>, <NOP(N)> [,<IFBV\'/.iN)>] [,<Pow(N)>] [,<Del(N)>] [,<Time(N)>]
}

<Buf> : Always 5,

<Flagl> :Stimulus start setting (0O - start/stop, 1 - center/span),

Description <Flag2> :Setting of the <IFBW> field (0 - disabled, 1 - enabled),
<Flag3> :Setting of the <Pow> field (0 - disabled, 1 - enabled),
<Flag4> :Setting of the <Del> field (0O - disabled, 1 - enabled),
<Flag5> :Setting of the <Time> field (0 - disabled, 1 - enabled),
<N> :Number of segments,
<Start n> :Start value of the n-th segment,
<Stop n> :Stop value of the n-th segment,
<NOP n> :Number of points of the n-th segment,
<IFBW n> : IF bandwidth of the n-th segment (if enabled),
<Pow n> :Power of the n-th segment (if enabled),
<Del n> :Measurement delay of the n—-th segment (if enabled),
<Time n> :Reserved for future use (if enabled).

Type Variant: array of double (read/write)

Target Channel Ch from 1 to 16
Data = app.SCPI.SENSe(Ch).SEGMent.DATA

Syntax
app.SCPL.SENSe(Ch).SEGMent.DATA = Data

Equivalent Softkeys

Stimulus / Segment Table
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SCPI.SENSe(Ch).SWEep.POINt.TIME

Description Sets/gets the va?lue of the delay before measurement in each
measurement point.
Type Double (read/write)
Range from 0to 0.3
Resolution 5E-6
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 0
Unit s (second)
Target Channel Ch from 1 to 16
Value = app.SCPI.SENSe(Ch).SWEep.POINt. TIME
Syntax
app.SCP1.SENSe(Ch).SWEep.POINt.TIME = 5E-6
Equivalent Softkeys | Stimulus > Meas Delay
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SCPI.SENSe(Ch).SWEep.POINts

Description Sets/gets the number of measurement points.
Type Long (read/write)
Rance 2 to 500001
I 2 to 200001 (PLANAR-304, S5048, S7530)
Out of Range Sets the value of the limit, which is closer to the specified value.
Preset Value 201
Target Channel Ch from 1 to 16
Value = app.SCPI.SENSe(Ch).SWEep.POINts
Syntax
app.SCPI.SENSe(Ch).SWEep.POINts = 1001
Equivalent Softkeys | Stimulus > Points
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SCPI.SENSe(Ch).SWEep.TYPE

Description Sets/gets the the sweep type.
Type String (read/write)
"LINear” : Linear frequency sweep

"LOGarithmic” : Logarithmic frequency sweep
Parameter

"SEGMent" : Segment frequency sweep
"POWer " : Power sweep

Preset Value "LIN"

Target Channel Ch from 1 to 16
Param = app.SCPL.SENSe(Ch).SWEep.TYPE

Syntax

app.SCPI.SENSe(Ch).SWEep.TYPE = "LOG"

Equivalent Softkeys | Stimulus > Sweep Type

SCPI.SERVice.CHANnel(1).ACTive

Description Gets the number of the active channel.
Type Long (read only)
Syntax Value = app.SCPL.SERVice.CHANnel. ACTive

Object CHANnel has an index of 1, which can be omitted in Visual Basic
but it cannot be omitted in other programming languages.

Warning

Equivalent Softkeys None
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SCPI.SERVice.CHANnel(1).COUNt

Description Gets the maximum number of the channels.

Type Long (read only)

Syntax Value = app.SCPI.SERVice.CHANnel.COUNt

Warning Object CHANnel has an index of 1, which can be omitted in Visual Basic
but it cannot be omitted in other programming languages.

Equivalent Softkeys None

SCPI.SERVice.CHANnel(Ch).TRACe(1).ACTive

Description Gets the active trace number of the specified channel.

Type Long (read only)

Target Channel Ch from 1 to 16

Syntax Value = app.SCPI1.SERVice.CHANnel(Ch).TRACe.ACTive
Object TRACe has an index. In Visual Basic the index is 1 by default when

Warning it is omitted. The index can not be omitted in other programming
languages.

Equivalent Softkeys None
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SCPI.SERVice.CHANnel(1).TRACe.COUNt

Description Gets the maximum number of the traces in the channel.

Type Long (read only)

Syntax Value = app.SCPI.SERVice.CHANnel. TRACe.COUNt

Warning Object CHANnel has an index of 1, which can be omitted in Visual Basic
but it cannot be omitted in other programming languages.

Equivalent Softkeys None

SCPI.SERVice.CHANnel(Ch).TRACe(Tr).MARKer.ACTive

Gets the active marker number of the specified trace of the

Description g

specified channel.
Type Long (read only)

Trace Tr of channel Ch,
Target Ch:  channel number 1-16

Tr: trace number 1-16

Syntax Value = app.SCPI.SERVice.CHANnel(Ch).TRACe.ACTive
Equivalent Softkeys None
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SCPI.SERVice.PORT.COUNt

Description Gets the number of the ports.
Type Long (read only)

Syntax Value = app.SCPL.SERVice.PORT.COUNt
Equivalent Softkeys None

SCPIL.SERVice.SWEep.FREQency.MAXimum

Description Gets the upper limit of the analyzer frequency range.
Type Double (read only)

Syntax Value = app.SCPI.SERVice.SWEep.FREQency.MAXimum

Equivalent Softkeys None

SCPL.SERVice.SWEep.FREQency.MINimum

Description Gets the lower limit of the analyzer frequency range.
Type Double (read only)

Syntax Value = app.SCPI.SERVice.SWEep.FREQency.MINimum

Equivalent Softkeys None
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SCPI.SERVice.SWEep.POINts

Description Gets the maximum number of the measurement points.
Type Double (read only)

Syntax Value = app.SCPI.SERVice.SWEep.POINts

Equivalent Softkeys None

SCPIL.SOURce(Ch).POWer.CENTer

Sets/gets the center value of the power sweep range when sweep

Description ;
type is Power.

Type Double (read/write)

Range From the minimum value to the maximum value of the analyzer power
range.

Resolution 0.025

Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Center value of the analyzer power range.

Unit dBm (decibels above 1 milliwatt)
Target Channel Ch from 1 to 16

Value = app.SCPL.SOURce(Ch).POWer.CENTer
Syntax

app.SCP1.SOURce(Ch).POWer.CENTer = 5
Equivalent Softkeys Stimulus > Center
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SCPI1.SOURce(Ch).POWer.LEVel.IMMediate.AMPLitude

Sets/gets the power level for the frequency sweep when port

Description couple feature is set to ON by the command
SCPI.SOURce(Ch).POWer.PORT(Pt).COUPLe..
Type Double (read/write)
Rance From the minimum value to the maximum value of the analyzer power
I range.
Resolution 0.05
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Unit dBm (decibels above 1 milliwatt)
Target Channel Ch from 1 to 16

Value = app.SCPI.SOURce(Ch).POWer.LEVel.IMMediate. AMPLitude
Syntax

app.SCP1.SOURce(Ch).POWer.LEVel.IMMediate.AMPLitude = 10

Related commands

SCPI.SOURce(Ch).POWer.PORT(Pt).COUPle

Equivalent Softkeys

Stimulus > Power > Power
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SCPI1.SOURce(Ch).POWer.LEVel.SLOPe.DATA

Description Sets/gets the power slope value for the frequency sweep.
Type Double (read/write)

Range from -2 to 2

Resolution 0.1

Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Unit dB/GHz (decibel/gigahertz)
Target Channel Ch from 1 to 16

Value = app.SCP1.SOURce(Ch).POWer.LEVel.SLOPe.DATA
e app.SCP1.SOURce(Ch).POWer.LEVel.SLOPe.DATA = 0.2
Equivalent Softkeys Stimulus > Power > Slope [dB/GHz]

SCPI1.SOURce(Ch).POWer.LEVel.SLOPe.STATe

Description

Turns ON/OFF the state of the power slope for the frequency
sweep.

Type

Boolean (read/write)

Parameter

True: Power slope ON
False:  Power slope OFF

Preset Value

False

Target Channel Ch from 1 to 16

Status = app.SCPI.SOURce(Ch).POWer.LEVel.SLOPe.STATe
Syntax

app.SCP1.SOURce(Ch).POWer.LEVel.SLOPe.STATe = True
Equivalent Softkeys Stimulus > Power > Slope [ON/OFF]
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SCPI1.SOURce(Ch).POWer.PORT(Pt).CORRection.COLLect.ACQuire

Measures the power calibration data for the specified port using
the power meter controlled via USB or USB/GPIB. Calculates

Description . . . .
calibration coefficients on completion of the measurement, and
turns ON the power correction for the port.
Type Method
Port Pt of channel Ch,
Target Ch:  channel number 1-16
Pt: port number 1-2 (4 for S4VNA)
Syntax app.SCP1.SOURce(Ch).POWer.PORT(Pt).CORRection.COLLect.ACQuire
Equivalent Softkeys Calibration > Power Calibration > Calibrate
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SCPL.SOURce( /).POWer.PORT(P).CORRection.COLLect.TABLe.LOSS.DATA

Description

Sets/gets the loss compensation table used during the power
calibration.

The array size is 1+2N, where N is the number of the table rows.
For the n—th point, where n from 1 to N:

Data(0) the number of the table rows N integer from 0
to 100;

Data(2n-1) the frequency of the n-th row of the table from
300 kHz to 8.0 GHz;

Data(Zn) the loss value of the n-th table row in dB.

Type

Variant: array of double (read/write)

Target

Port Pt of channel Ch,
Ch:  channel number 1-16
Pt: port number 1-2 (4 for S4VNA)

Syntax

Data =
app.SCPL.SOURce(Ch).POWer.PORT(Pt).CORRection.COLLect. TABLe.LOSS.DATA

app.SCPL.SOURce(Ch).POWer.PORT(Pt).CORRection.COLLect. TABLe.LOSS.DATA =
Data

Related Commands

SCPL.SOURce(Ch).POWer.PORT(Pt).CORRection.COLLect. ACQuire

Equivalent Softkeys

Calibration > Power Calibration > Loss Compen
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SCPL.SOURce( /).POWer.PORT(P).CORRection.COLLect.TABLe.LOSS.STATe

Description

Turns ON/OFF the state of the loss compensation function used
during the power calibration.

Type

Boolean (read/write)

Parameter

True: Loss compensation ON
False:  Loss compensation OFF

Preset Value False
Port Pt of channel Ch,
Target Ch: channel number 1-16
Pt: port number 1-2 (4 for S4VNA)
Status =
app.SCPI.SOURce(Ch).POWer.PORT(Pt).CORRection.COLLect. TABLe.LOSS.STATe
Syntax

app.SCPI.SOURce(Ch).POWer.PORT(Pt).CORRection.COLLect. TABLe.LOSS.STATe =
True

Related Commands

SCPL.SOURce(Ch).POWer.PORT(Pt).CORRection.COLLect. TABLe.LOSS.DATA

Equivalent Softkeys

Calibration > Power Calibration > Loss Compen > Compensation
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SCPI1.SOURce(Ch).POWer.PORT(Pt).CORRection.DATA

Description

Sets/gets the power correction table.
The array size is 1+2N, where N is the number of the table rows.
For the n—th point, where n from 1 to N:

Data(0) the number of the table rows N integer from 0
to 10001;

Data(2n-1) the frequency of the n—th row of the table;

Data(2n) power correction value of the n-th row of the
table from -10 to +10 dB.

Type

Variant: array of double (read/write)

Target

Port Pt of channel Ch,
Ch: channel number 1-16
pt: port number 1-2 (4 for S4VNA)

Syntax

Data = app.SCP1.SOURce(Ch).POWer.PORT(Pf).CORRection.DATA
app.SCP1.SOURce(Ch).POWer.PORT(Pt).CORRection.DATA = Data

Related Commands

SCPI1.SOURce(Ch).POWer.PORT(Pt).CORRection.COLLect. ACQuire

Equivalent Softkeys

None
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SCPI1.SOURce(Ch).POWer.PORT(Pt).CORRection.STATe

Description Turns ON/OFF the state of the power correction function.
Type Boolean (read/write)

True: Power correction ON
Parameter

False:  Power correction OFF

Preset Value False
Port Pt of channel Ch,
Target Ch:  channel number 1-16
Pt: port number 1-2 (4 for S4VNA)
Status = app.SCP1.SOURce(Ch).POWer.PORT(Pt).CORRection.STATe
Syntax

app.SCP1.SOURce(Ch).POWer.PORT(Pt).CORRection.STATe = True

Related Commands

SCPL.SOURce(Ch).POWer.PORT(Pt).CORRection.COLLect. ACQuire

Equivalent Softkeys

Calibration > Power Calibration > Correction
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SCPI1.SOURce(Ch).POWer.PORT (Pt).LEVel.IMMediate.AMPLitude

Sets/gets the power level of each port for the frequency sweep

Description when port couple feature is set to OFF by the command
SCPI.SOURce(Ch).POWer.PORT(Pt).COUPLe.
Type Double (read/write)
Rance From the minimum value to the maximum value of the analyzer power
I range.
Resolution 0.05
Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

Unit dBm (decibels above 1 milliwatt)
Port Pt of channel Ch,
Target Ch:  channel number 1-16
Pt: port number 1-2 (4 for S4VNA)
Value = app.SCPL.SOURce(Ch).POWer.PORT (Pt).LEVel.IMMediate. AMPLitude
Syntax

app.SCP1.SOURce(Ch).POWer.PORT (Pt).LEVel.IMMediate AMPLitude = 10

Related Commands

SCPI.SOURce(Ch).POWer.PORT(Pt).COUPLe

Equivalent Softkeys

Stimulus > Power > Port Power > Port x
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SCPI1.SOURce(Ch).POWer.PORT(1).COUPLe

Turns ON/OFF the state of the port power couple function. Setting

Description the port power couple feature to OFF allows independent power
level setting for each port.
Type Boolean (read/write)

Parameter

True: port power couple ON
False:  port power couple OFF

Preset Value

True

Target Channel Ch from 1 to 16
Status = app.SCPI.SOURce(Ch).POWer.PORT.COUPLe
Syntax
app.SCP1.SOURce(Ch).POWer.PORT.COUPLe = True
Warning Object PORT has an index of 1, which can be omitted in Visual Basic but

it cannot be omitted in other programming languages.

Related Commands

SCP1.SOURce(Ch).POWer.PORT(Pt).LEVel.IMMediate. AMPLitude

Equivalent Softkeys

Stimulus > Power > Port Couple
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SCPI1.SOURce(Ch).POWer.SPAN

Description Sets/gets the power span for the power sweep.

Type Double (read/write)

Range From 0 to the maximum span of the analyzer power range
Resolution 0.05

Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

The maximum span of the analyzer power range.

Unit dBm (decibels above 1 milliwatt)
Target Channel Ch from 1 to 16

Value = app.SCP1.SOURce(Ch).POWer.SPAN
Syntax

app.SCPL.SOURce(Ch).POWer.SPAN = 50
Equivalent Softkeys Stimulus > Span
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SCPI1.SOURce(Ch).POWer.STARt

Description Sets/gets the power sweep start for the power sweep.

Type Double (read/write)

Range From the minimum value to the maximum value of the analyzer power
range.

Resolution 0.05

Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

The minimum value of the analyzer power range.

Unit dBm (decibels above 1 milliwatt)
Target Channel Ch from 1 to 16

Value = app.SCPL.SOURce(Ch).POWer.STARt
Syntax

app.SCPL.SOURce(Ch).POWer.STARt = 5
Equivalent Softkeys Stimulus > Start
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SCPI1.SOURce(Ch).POWer.STOP

Description Sets/gets the power sweep stop for the power sweep.

Type Double (read/write)

Range From the minimum value to the maximum value of the analyzer power
range.

Resolution 0.05

Out of Range Sets the value of the limit, which is closer to the specified value.

Preset Value

The maximum value of the analyzer power range

Unit dBm (decibels above 1 milliwatt)
Target Channel Ch from 1 to 16

Value = app.SCPL.SOURce(Ch).POWer.STOP
Syntax

app.SCPI.SOURce(Ch).POWer.STOP = 5
Equivalent Softkeys Stimulus > Stop

SCPI.STATus.OPERation.CONDition

Description Reads out the Operation Status Condition Register.
Type Long (read only)

Target IEE488.2 Status Reporting System (Appendix 1)

Syntax Value = app.SCPL.STATus.OPERation.CONDition

Equivalent Softkeys None
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SCPI.STATus.OPERation.ENABLe

Description Sets/gets the Operation Status Enable Register.
Type Long (read/write)
Range from O to 65535

Preset Value

Target IEE488.2 Status Reporting System (Appendix 1)
Value = app.SCPI.STATus.OPERation.ENABLe
Syntax
app.SCPI.STATus.OPERation.ENABLe = Value
Equivalent Softkeys None

SCPI.STATus.OPERation.EVENt

Description Reads out the Operation Status Event Register.
Type Long (read only)

Target IEE488.2 Status Reporting System (Appendix 1)
Syntax Value = app.SCPL.STATus.OPERation.EVENt

Equivalent Softkeys None
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SCPI.STATus.OPERation.NTRansition

Sets/gets the Negative Transition Filter of the Operation Status

Description .

Register.
Type Long (read/write)
Range from O to 65535

Preset Value 0
Target IEE488.2 Status Reporting System (Appendix 1)
Value = app.SCPI.STATus.OPERation.NTRansition
Syntax
app.SCPI.STATus.OPERation.NTRansition = Value
Equivalent Softkeys None

SCPI.STATus.OPERation.PTRansition

Sets/gets the Positive Transition Filter of the Operation Status

Description )

Register.
Type Long (read/write)
Range from O to 65535

Preset Value

65535

Target IEE488.2 Status Reporting System (Appendix 1)
Value = app.SCPI.STATus.OPERation.PTRansition
Syntax
app.SCPI.STATus.OPERation.PTRansition = Value
Equivalent Softkeys None
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SCPI.STATus.PRESet

Description Initialization of all registers.

Type Method

Target IEE488.2 Status Reporting System (Appendix 1)
Syntax app.SCPI.STATus.PRESet

Equivalent Softkeys | None

SCPIL.STATus.QUEStionable.CONDition

Description Reads out the Questionable Status Condition Register.
Type Long (read only)

Target IEE488.2 Status Reporting System (Appendix 1)

Syntax Value = app.SCPL.STATus.QUEStionable.CONDition

Equivalent Softkeys None
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SCPI.STATus.QUEStionable.ENABle

Description Sets/gets the Questionable Status Enable Register.
Type Long (read/write)
Range from O to 65535

Preset Value

Target IEE488.2 Status Reporting System (Appendix 1)
Value = app.SCPI.STATus.QUEStionable.ENABLe
Syntax
app.SCPI.STATus.QUEStionable.ENABLe = Value
Equivalent Softkeys None

SCPIL.STATus.QUEStionable.EVENt

Description Reads out the Questionable Status Event Register.
Type Long (read only)

Target IEE488.2 Status Reporting System (Appendix 1)

Syntax Value = app.SCPL.STATus.QUEStionable.EVENt

Equivalent Softkeys None

336




SCPI.STATus.QUEStionable.LIMit.CHANnel(Ch).CONDition

Reads out the Questionable Limit Channel Status Condition

Description Register for channel Ch,
Ch:  channel number 1-16
Type Long (read only)
Target IEE488.2 Status Reporting System (Appendix 1)
Syntax Value = app.SCPL.STATus.QUEStionable.LIMit. CHANnel(Ch).CONDition
Equivalent Softkeys None

SCPI.STATus.QUEStionable.LIMit.CHANnel(Ch).ENABLe

Sets/gets the Questionable Limit Channel Status Enable Register

Description for channel Ch,

Ch:  channel number 1-16
Type Long (read/write)
Range from O to 65535

Preset Value

Target IEE488.2 Status Reporting System (Appendix 1)

Value = app.SCPL.STATus.QUEStionable.LIMit. CHANnel(Ch).ENABLe
Syntax

app.SCPI.STATus.QUEStionable.LIMit.CHANnel(Ch).ENABLe = Value
Equivalent Softkeys | None
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SCPI.STATus.QUEStionable.LIMit.CHANnel(Ch).EVENt

Reads out the Questionable Limit Channel Status Event Register
Description for channel Ch,
Ch:  channel number 1-16

Type Long (read only)
Target IEE488.2 Status Reporting System (Appendix 1)
Syntax Value = app. SCPL.STATus.QUEStionable.LIMit. CHANnel(Ch).EVENt

Equivalent Softkeys | None

SCPL.STATus.QUEStionable.LIMit.CHANnel(Ch).NTRansition

Sets/gets the Negative Transition Filter of the Questionable Limit
Description Channel Status Register for channel Ch,
Ch:  channel number 1-16

Type Long (read/write)

Range from O to 65535

Preset Value 0

Target IEE488.2 Status Reporting System (Appendix 1)

Value = app.SCPL.STATus.QUEStionable.LIMit.CHANnel(Ch).NTRansition
app.SCPI.STATus.QUEStionable.LIMit.CHANnel(Ch).NTRansition = Value

Syntax

Equivalent Softkeys None
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SCPI.STATus.QUEStionable.LIMit.CHANnel(Ch).PTRansition

Description Channel Status Register for channel Ch,
Ch:  channel number 1-16

Sets/gets the Positive Transition Filter of the Questionable Limit

Type Long (read/write)

Range from O to 65535

Preset Value 65535

Target IEE488.2 Status Reporting System (Appendix 1)

Syntax

Value = app.SCPL.STATus.QUEStionable.LIMit.CHANnel(Ch).PTRansition
app.SCPI.STATus.QUEStionable.LIMit.CHANnel(Ch).PTRansition = Value

Equivalent Softkeys None

SCPI.STATus.QUEStionable.LIMit.CONDition

Description Reads out the Questionable Limit Status Condition Register.
Type Long (read only)

Target IEE488.2 Status Reporting System (Appendix 1).

Syntax Value = app.SCPL.STATus.QUEStionable.LIMit.CONDition

Equivalent Softkeys None
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SCPI.STATus.QUEStionable.LIMit.ENABle

Description Sets/gets the Questionable Limit Status Enable Register.
Type Long (read/write)
Range from O to 65535

Preset Value

Target IEE488.2 Status Reporting System (Appendix 1)
Value = app.SCPI.STATus.QUEStionable.LIMit.ENABLe
Syntax
app.SCPI.STATus.QUEStionable.LIMit.ENABLle = Value
Equivalent Softkeys None

SCPIL.STATus.QUEStionable.LIMit.EVENt

Description Reads out the Questionable Limit Status Event Register.
Type Long (read only)

Target IEE488.2 Status Reporting System (Appendix 1)

Syntax Value = app.SCPL.STATus.QUEStionable.LIMit.EVENt

Equivalent Softkeys None
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SCPI.STATus.QUEStionable.LIMit.NTRansition

Sets/gets the Negative Transition Filter of the Questionable Limit

Description .
Status Register.

Type Long (read/write)

Range from O to 65535

Preset Value 0

Target IEE488.2 Status Reporting System (Appendix 1)
Value = app.SCPI.STATus.QUEStionable.LIMit.NTRansition

yniax app.SCPI.STATus.QUEStionable.LIMit.NTRansition = Value

Equivalent Softkeys None

SCPL.STATus.QUEStionable.LIMit.PTRansition

Sets/gets the Positive Transition Filter of the Questionable Limit

Description .
Status Register.

Type Long (read/write)

Range from O to 65535

Preset Value

65535

Target IEE488.2 Status Reporting System (Appendix 1)
Value = app.SCPI.STATus.QUEStionable.LIMit.PTRansition
Syntax
app.SCPI.STATus.QUEStionable.LIMit.PTRansition = Value
Equivalent Softkeys None
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SCPL.STATus.QUEStionable.NTRansition

Sets/gets the Negative Transition Filter of the Questionable Status

Description .

Register.
Type Long (read/write)
Range from O to 65535

Preset Value

Target IEE488.2 Status Reporting System (Appendix 1)
Value = app.SCPI.STATus.QUEStionable.NTRansition
Syntax
app.SCPI.STATus.QUEStionable.NTRansition = Value
Equivalent Softkeys None

SCPIL.STATus.QUEStionable.PTRansition

Sets/gets the Positive Transition Filter of the Questionable Status

Description )

Register.
Type Long (read/write)
Range from O to 65535

Preset Value

65535

Target IEE488.2 Status Reporting System (Appendix 1)
Value = app.SCPI.STATus.QUEStionable.PTRansition
Syntax
app.SCPI.STATus.QUEStionable.PTRansition = Value
Equivalent Softkeys None
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SCPI.STATus.QUEStionable.RLIMit.CHANnel(Ch).CONDition

Description Register for channel Ch,
Ch:  channel number 1-16

Reads out the Questionable Ripple Limit Channel Status Condition

Type Long (read only)
Target IEE488.2 Status Reporting System (Appendix 1)
Syntax Value = app.SCPL.STATus.QUEStionable.RLIMit.CHANnel(Ch).CONDition

Equivalent Softkeys None

SCPI.STATus.QUEStionable.RLIMit.CHANnel(Ch).ENABLe

Description Register for channel Ch,
Ch:  channel number 1-16

Sets/gets the Questionable Ripple Limit Channel Status Enable

Type Long (read/write)

Range from O to 65535

Preset Value 0

Target IEE488.2 Status Reporting System (Appendix 1)

Syntax

Value = app.SCPI.STATus.QUEStionable.RLIMit.CHANnel(Ch).ENABLe
app.SCPI.STATus.QUEStionable.RLIMit.CHANnel(Ch).ENABLe = Value

Equivalent Softkeys None
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SCPI.STATus.QUEStionable.RLIMit.CHANnel(Ch).EVENt

Reads out the Questionable Ripple Limit Channel Status Event

Description Register for channel Ch,
Ch:  channel number 1-16
Type Long (read only)
Target IEE488.2 Status Reporting System (Appendix 1)
Syntax Value = app.SCPL.STATus.QUEStionable.RLIMit.CHANnel(Ch).EVENt
Equivalent Softkeys None

SCPL.STATus.QUEStionable.RLIMit.CHANnel(Ch).NTRansition

Sets/gets the Negative Transition Filter of the Questionable Ripple

Description Limit Channel Status Register for channel Ch,
Ch:  channel number 1-16

Type Long (read/write)

Range from O to 65535

Preset Value

Target IEE488.2 Status Reporting System (Appendix 1)

Value = app.SCPL.STATus.QUEStionable.RLIMit.CHANnel(Ch). NTRansition
Syntax

app.SCPI.STATus.QUEStionable.RLIMit.CHANnel(Ch). NTRansition = Value
Equivalent Softkeys None
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SCPI.STATus.QUEStionable.RLIMit.CHANnel(Ch).PTRansition

Sets/gets the Positive Transition Filter of the Questionable Ripple

Description Limit Channel Status Register for channel Ch,
Ch:  channel number 1-16

Type Long (read/write)

Range from O to 65535

Preset Value

65535

Target IEE488.2 Status Reporting System (Appendix 1)

Value = app.SCPL.STATus.QUEStionable.RLIMit.CHANnel(Ch). PTRansition
Syntax

app.SCPI.STATus.QUEStionable.RLIMit.CHANnel(Ch). PTRansition = Value
Equivalent Softkeys None

SCPI.STATus.QUEStionable.RLIMit.CONDition

Description Reads out the Questionable Ripple Limit Status Condition Register.
Type Long (read only)

Target IEE488.2 Status Reporting System (Appendix 1)

Syntax Value = app.SCPL.STATus.QUEStionable.RLIMit.CONDition

Equivalent Softkeys None
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SCPI.STATus.QUEStionable.RLIMit.ENABle

Description Sets/gets the Questionable Ripple Limit Status Enable Register.
Type Long (read/write)
Range from O to 65535

Preset Value

Target IEE488.2 Status Reporting System (Appendix 1)
Value = app.SCPI.STATus.QUEStionable.RLIMit.ENABLe
Syntax
app.SCPI.STATus.QUEStionable.RLIMit.ENABLe = Value
Equivalent Softkeys None

SCPIL.STATus.QUEStionable.RLIMit.EVENt

Description Reads out the Questionable Ripple Limit Status Event Register.
Type Long (read only)

Target IEE488.2 Status Reporting System (Appendix 1)

Syntax Value = app.SCPL.STATus.QUEStionable.RLIMit.EVENt

Equivalent Softkeys None
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SCPI.STATus.QUEStionable.RLIMit.NTRansition

Sets/gets the Negative Transition Filter of the Questionable Ripple

Description L. ;
Limit Status Register.

Type Long (read/write)

Range from O to 65535

Preset Value 0
Target IEE488.2 Status Reporting System (Appendix 1)

Value = app.SCPI.STATus.QUEStionable.RLIMit.NTRansition
yniax app.SCPI.STATus.QUEStionable.RLIMit.NTRansition = Value
Equivalent Softkeys None

SCPL.STATus.QUEStionable.RLIMit.PTRansition

Sets/gets the Positive Transition Filter of the Questionable Ripple

Description L. .
Limit Status Register.

Type Long (read/write)

Range from O to 65535

Preset Value

65535

Target IEE488.2 Status Reporting System (Appendix 1)

Value = app.SCPI.STATus.QUEStionable.RLIMit.PTRansition
Syntax

app.SCPI.STATus.QUEStionable.RLIMit.PTRansition = Value
Equivalent Softkeys None
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SCP1.SYSTem.BEEPer.COMPlete.IMMediate

Description Generates a beep to notify of the completion of the operation.
Type Method

Target Analyzer

Syntax app.SCP1.SYSTem.BEEPer.COMPlete.IMMediate

Equivalent Softkeys | System > Misc Setup > Beeper > Test Beep Complete

SCPIL.SYSTem.BEEPer.COMPlete.STATe

Description

Turns ON/OFF the state of the beeper notifying of the completion
of the operation.

Type

Boolean (read/write)

Parameter

True: Completion beeper ON
False:  Completion beeper OFF

Preset Value True
Target Analyzer

Status = app.SCPL.SYSTem.BEEPer.COMPlete.STATe
e app.SCPL.SYSTem.BEEPer.COMPlete.STATe = False
Equivalent Softkeys System > Misc Setup > Beeper > Beep complete
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SCP1.SYSTem.BEEPer.WARNing.IMMediate

Description Generates a beep to notify of warning.

Type Method

Target Analyzer

Syntax app.SCP1.SYSTem.BEEPer. WARNing.IMMediate

Equivalent Softkeys | System > Misc Setup > Beeper > Test Beep Warning

SCPL.SYSTem.BEEPer. WARNing.STATe

Description Turns ON/OFF the state of the beeper notifying of warning.
Type Boolean (read/write)

True: Warning beeper ON
Parameter

False:  Warning beeper OFF

Preset Value True
Target Analyzer

Status = app.SCP1.SYSTem.BEEPer. WARNing.STATe
e app.SCP1.SYSTem.BEEPer. WARNing.STATe = False
Equivalent Softkeys System > Misc Setup > Beeper > Beep Warning
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SCP1.SYSTem.COMMunicate.ECAL.TEMPerature.SENSor

Reads out the temperature of the AutoCal module connected to

Descrption the analyzer.

Type Double (read only)

Unit °C (Celsius)

Target AutoCal module

Syntax Value = app.SCP1.SYSTem.COMMunicate.ECAL.TEMPerature.SENSor
Equivalent Softkeys None

SCPL.SYSTem.COMMunicate.ECAL.IMPedance(Pt)

Description

Sets or reads out the impedance state of the specified port (Pt) of
AutoCal module connected to the analyzer.

Type

String (read/write)

Parameter

"opEN" : OPEN impedance state
"sHort" : SHORT impedance state
"Loap" : LOAD impedance state

"Loan2" : LOAD2 impedance state

"opEN2" : OPEN2 impedance state

Preset Value

"LOAD"

Target AutoCal module

Param = app.SCPI.SYSTem.COMMunicate.ECAL.IMPedance(Pt)
Syntax

app.SCP1.SYSTem.COMMunicate.ECAL.IMPedance(Pt) = "OPEN"
Equivalent Softkeys None
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SCP1.SYSTem.COMMunicate.ECAL.CHECk

Description Sets the check state of AutoCal module connected to the analyzer.
Type Method

Target AutoCal module

Syntax app.SCP1.SYSTem.COMMunicate.ECAL.CHECk

Equivalent Softkeys | None

SCPL.SYSTem.COMMunicate.ECAL.THRU(Pt1, Pt2)

Description Sets the thru state between the specified 2 ports (Pt1, Ptr2) of
AutoCal module connected to the analyzer.

Type Method

Target AutoCal module

Syntax app.SCP1.SYSTem.COMMunicate.ECAL.THRU(Z, 2)

Equivalent Softkeys | None
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SCPIL.SYSTem.CORRection.STATe

Description

Turns ON/OFF the state of the system error correction (factory
calibration at the RF port connector).

Type

Boolean (read/write)

Parameter

True: System error correction ON
False:  System error correction OFF

Preset Value True
Target Analyzer

Status = app.SCPL.SYSTem.CORRection.STATe
Syntax

app.SCP1.SYSTem.CORRection.STATe = False
Equivalent Softkeys System > Misc Setup > System Correction

SCPL.SYSTem.CYCLe.TIME.MEASurement

Reads out the measured cycle time. The cycle time is the interval
between the start of two adjacent sweeps. The cycle time is

Description averaged by an exponential window with a time constant of about
0.5 sec. If the cycle time is changed more than 100 usec in
comparison with the averaged time, the averaging starts anew.

Type Double (read only)

Unit second

Target Ana Lyzer

Syntax Value = app.SCPL.SYSTem.CYCle.TIME.MEASurement

Equivalent Softkeys | Display > Properies > Cycle Time
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SCPIL.SYSTem.DATE

Sets/gets the current date.
The array consists of three elements:
Description Data(0) year from 1900 to 2100;
Data(1) month from 1 to 12;
Data(2) day from 1 to 31.
Type Variant: array of long (read/write)
Data = app.SCPI1.SYSTem.DATE
Syntax
app.SCP1.SYSTem.DATE = Array(2009, 9, 9)
Equivalent Softkeys None
SCPL.SYSTem.HIDE
Description Minimizes the analyzer main window removing it from desktop.
Type Method
Target Analyzer GUI
Syntax app.SCP1.SYSTem.HIDE

Related Commands

SCPL.SYSTem.SHOW

Equivalent Softkeys

None
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SCP1.SYSTem.LOCal

Sets the analyzer to the local operation mode, when all the keys

pescripron on the front panel, mouse and the touch screen are active.
Type Method

Target Analyzer GUI

Syntax app.SCP1.SYSTem.LOCal

Related Commands

SCPL.SYSTem.REMote
SCPL.SYSTem.RWLock

Equivalent Softkeys None

SCPL.SYSTem.PRESet
Resets the analyzer to the factory settings. The difference from the

Description SCPI.IEEE4882.RST: method is that the trigger is set to the
Continuous trigger mode.

Type Method

Target Analyzer GUI

Syntax app.SCP1.SYSTem.PRESet

Equivalent Softkeys SyStem > Preset > OK

354




SCPIL.SYSTem.PORT.SWITchover.Delay.STATe

Turns ON/OFF the state of the port switchover delay feature.

Turn off the port switchover delay allows decreasing sweep time

Description
approximately by 10 ms providing that stimulus direction is
changing.

Type Boolean (read/write)

Parameter

True: port switchover delay feature ON
False:  port switchover delay feature OFF

Preset Value True
Target Analyzer
Status = app.SCP1.SYSTem.PORT.SWITchover.Delay.STATe
Syntax
app.SCP1.SYSTem.PORT.SWITchover.Delay.STATe = False
Equivalent Softkeys System > Misc Setup > Port Switchover Delay { On | OFF }
SCPL.SYSTem.REMote
Sets the analyzer to the remote operation mode, when all the keys
Description on the front panel, mouse and the touch screen are not active,
except for one key labeled Return to Local. Pushing this button will
reset the analyzer to the local operation mode.
Type Method
Target Analyzer GUI
Syntax app.SCP1.SYSTem.REMote
SCPL.SYSTem.LOCal
Retated Commands | 5 p) SySTem.RWLock
Equivalent Softkeys None
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SCPIL.SYSTem.RWLock

Sets the analyzer to the remote operation mode, when all the keys
on the front panel, mouse and the touch screen are not active.

pescrption Only SCPIL.SYSTem.LOCal or SCPIL.SYSTem.REMote command can
release this remote operation mode.

Type Method

Target Analyzer GUI

Syntax app.SCP1.SYSTem.RWLock

Related Commands

SCPL.SYSTem.LOCal
SCPL.SYSTem.REMote

Equivalent Softkeys

None

SCPL.SYSTem.TEMPerature.SENSor(/dx)

Reads out the specified sensor (/dx) temperature inside the

Deseripton analyzer.

Type Double (read only)

Unit °C (Celsius)

Target Analyzer GUI

Syntax Value = app.SCPL.SYSTem.TEMPerature.SENSor(1)
Equivalent Softkeys None
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SCPIL.SYSTem.SHOW

Description Restores the analyzer main window hidden by the
SCPL.SYSTem.HIDE command.

Type Method

Target Analyzer GUI

Syntax app.SCP1.SYSTem.SHOW

Related Commands

SCPL.SYSTem.HIDE

Equivalent Softkeys

None

SCPL.SYSTem.TERMinate

Description Terminates the application.
Type Method

Target AnalyzerGUI

Syntax app.SCP1.SYSTem.TERMinate
Equivalent Softkeys | None
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SCP1.SYSTem.TIME

Sets/gets the current time.

The array consists of three elements:

Description Data(0) hours from 0 to 23;
Data(1) minutes from O to 59;
Data(2) seconds from O to 59.
Type Variant: array of long (read/write)

Data = app.SCPL.SYSTem.TIME
app. app.SCPL.SYSTem.TIME = Array(15, 20, 30)

Syntax

Equivalent Softkeys | None
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SCPL.TRIGger.SEQuence.AVERage

Description

Turns ON/OFF the averaging trigger function. The function
executes a sweep the number of times specified by the averaging
factor with a single trigger for the channels with the averaging
enabled.

The averaging process begins again with each trigger.

Note: The point trigger function has priority against this command.
When the point trigger is enabled the number of pulses equal to
(number of points) x (averaging factor) is needed to complete the
averaging.

Type

Boolean (read/write)

Parameter

True: averaging trigger function ON
False:  averaging trigger function OFF

Preset Value

False

Syntax

Status = app.SCPI.TRIGger.SEQuence.AVERage
app.SCPI.TRIGger.SEQuence.AVERage = True

Related Commands

SCPL.SENSe(Ch).AVERage.STATe

Equivalent Softkeys

Average > Avg Trigger { On | Off }

359




SCPL.TRIGger.SEQuence.EXTernal.Delay

Sets/gets the response delay with respect to the external trigger

pescripron signal.

Type Double (read/write)

Range from 0 to 100 sec

Resolution 0.1 psec

Out of Range Sets to the nearest bound.

Preset Value

Target

Trigger input

Syntax

Param = app.SCPI.TRIGger.EXTernal.Delay
app.SCPL.TRIGger.INPut.EXTernal.Delay = 0

Related Commands

SCPI.TRIGger.SEQuence.SOURce

Equivalent Softkeys

Stimulus > Trigger > Ext Trigger > Delay
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SCPL.TRIGger.SEQuence.EXTernal.POSition

Description

Selects the position of the external trigger. The Analyzer waits for
external trigger:

e Before sampling, when the frequency of the stimulus port
have been set.

e Before the frequency setup and subsequent measurement.
The frequency change of the stimulus port begins when the
external trigger arrives.

Depending on the command SCPI.TRIGger.SEQuence.POINt the
external trigger wait occurs before each point or before the first
point of the full sweep cycle.

Type

String (read/write)

Parameter

"BSAM" : Before sampling
"BSET" : Before frequency setup

Preset Value

"BSAM"

Target

Trigger input

Syntax

Param = app.SCPI.TRIGger.EXTernal.POSition
app.SCPL.TRIGger.INPut.EXTernal.POSition = "BSAM"

Related Commands

SCPIL.TRIGger.SEQuence.SOURce

Equivalent Softkeys

Stimulus > Trigger > Ext Trigger > POSition > { Before Samp | Before
Setup }
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SCPL.TRIGger.SEQuence.EXTernal.SLOPe

Description Selects the edge polarity of the external trigger.
Type String (read/write)
"POSitive” : Positive edge
Parameter . .
"NEGative" : Negative edge
Preset Value "NEG"
Target Trigger input
Param = app.SCPI.TRIGger.EXTernal.SLOPe
Syntax

app.SCPL.TRIGger.INPut.EXTernal.SLOPe = "POS"

Related Commands

SCPI.TRIGger.SEQuence.SOURce

Equivalent Softkeys

Stimulus > Trigger > Ext Trigger > Polarity
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SCPL.TRIGger.SEQuence.IMMediate

Generates a trigger signal and initiates a sweep under the
following conditions.

e Trigger source is set to the BUS (set by the command
SCPL.TRIGger.SEQuence.SOURce = "BUS"), otherwise an
error occurs and the command is ignored.

Description
e Analyzer must be in the trigger waiting state, otherwise (the
analyzer is in the measurement state or in the hold state) an
error occurs and the command is ignored.
The command is completed immediately after the generation of
the trigger signal (does not wait the end of a sweep).
Type Method
Target Analyzer
Syntax app.SCP1.TRIGger.SEQuence.IMMediate

Related Commands

SCPI.TRIGger.SEQuence.SOURce
SCPLINITiate(Ch).CONTinuous
SCPLINITiate(Ch).IMMediate

Equivalent Softkeys

None
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SCPL.TRIGger.SEQuence.POINt

Turns ON/OFF the point trigger feature.

Description When the point trigger is turned ON, the external trigger response
is the single point. When the point trigger feature is turned OFF,
the external trigger response is the entire sweep.

Type Boolean (read/write)

Parameter True: point trigger feature ON

False:  point trigger feature OFF

Preset Value

False

Target

Trigger input

Syntax

Status = app.SCPI.TRIGger.SEQuence.POINt
app.SCPI.TRIGger.SEQuence.POINt = True

Related Commands

SCPI.TRIGger.SEQuence.SOURce

Equivalent Softkeys

Stimulus > Trigger > Ext Trig Event > { On Sweep | On Point }
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SCPL.TRIGger.SEQuence.SINGle

Generates a trigger signal and initiates a sweep under the
following conditions.

e Trigger source is set to the BUS (set by the command
SCPL.TRIGger.SEQuence.SOURce = "BUS"), otherwise an
error occurs and the command is ignored.

e Analyzer must be in the trigger waiting state, otherwise (the

Description
analyzer is in the measurement state or in the hold state) an
error occurs and the command is ignored.
As opposed to the SCPLTRIGger.SEQuence.IMMediate command
this command waits the end of the sweep. The method returns
control after the end of the sweep caused by the command in one
or more channels.
Type Method
Target Analyzer
Syntax app.SCPL.TRIGger.SEQuence.SINGle

Related Commands

SCPIL.TRIGger.SEQuence.SOURce
SCPLINITiate(Ch).CONTinuous
SCPLINITiate(Ch).IMMediate

Equivalent Softkeys

None
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SCPL.TRIGger.SEQuence.SCOPe

Sets or reads out the trigger scope. The trigger scope determines
the response on the trigger signal arrival: either starts a sweep of

Description L . . .
all waiting channels in turn or starts a sweep in the active channel
only.

Type String (read/write)
"ALL" : All Channels

Parameter

"ACTive" : Active Channel

Preset Value "ALL"
Target Analyzer

Param = app.SCPI.TRIGger.SEQuence.SCOPe
Syntax

app.SCPI.TRIGger.SEQuence.SCOPe = "ACT"

Related Commands

SCPI.TRIGger.SEQuence.IMMediate
SCPI.TRIGger.SEQuence.SINGle
SCPI.IEEE4882.TRG

Equivalent Softkeys

Stimulus > Trigger > Trigger Scope > { All Channels | Active Channel }
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SCPL.TRIGger.SEQuence.SOURce

Description

Selects the trigger source (see options below).

If the the continuous trigger initiation mode is enabled with the
command SCPLINITiate(Ch).CONTinuous = true, the INTernal
choice leads to continuous sweep. The choice of another option
switches the analyzer to the trigger waiting state from the
corresponding source.

If the the continuous trigger initiation mode is disabled with the
command SCPLINITiate(Ch).CONTinuous = false, the reaction to
SCPLINITiate(Ch).IMMediate command is different. Selecting
INTernal leads to a single sweep in response to the command
SCPLINITiate(Ch).IMMediate, selection another option puts the
analyzer in a single trigger waiting state in response to the
SCPLINITiate(Ch).IMMediate command.

Type

String (read/write)

"INTernal" : Internal
"EXTernal" : External
Parameter
"MANual" : Manual
"BUS" : Bus
Preset Value "INT"
Target Analyzer
Param = app.SCPL.TRIGger.SEQuence.SOURce
Syntax

app.SCPL.TRIGger.SEQuence.SOURce = "BUS"

Related Commands

SCPIL.TRIGger.SEQuence.IMMediate
SCPIL.TRIGger.SEQuence.SINGle
SCPI.IEEE4882.TRG

Equivalent Softkeys

Stimulus > Trigger > Trigger Source > Internal | External | Manual | Bus
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SCPL.TRIGger.SEQunce.STATus

Description

Reads out the the current state of the analyzer.

Type

String (read only)

Return value

"HOLD" : Hold
"WAIT" : Waiting for trigger

"MEAS" : Measure (sweep in progress)

Syntax

Param = app.SCPI.TRIGger.SEQuence.STATus

Equivalent Softkeys

None

SCPL.TRIGger.SEQuence.WAIT(STATus)

Waits for the specified status of the trigger system. Blocks the
programm execution until the specified status of the analyzer has
been reached (see options below).

The command can be used to wait for the end of the sweep

Descripti o i

eseription initianed by the commands SCPLTRIGger.SEQuence.IMMediate,
SCPI.IEEE4882.TRG or initiated by the external trigger signal. If the
continuous initiation mode is turned ON by the command
SCPLINITiate(Ch).CONTinuous = true, then the parameter of the
command must be WAIT, otherwise HOLD.

Type Method
Status of String type:
"HOLD" : Hold

Parameter X .
"WAIT"  : Wait for Trigger
"MEAS" : Measurement

Target Analyzer

Syntax app.SCPL.TRIGger.SEQuence WAIT(*HOLD”)

Equivalent Softkeys None
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SCPIL.TRIGger.OUTPut.FUNCtion

Selects the trigger output function. The trigger output outputs

Description various waveforms depending on the setting of the Output Trigger
Function (see the operating manual).
Type String (read/write)

Parameter

"BSET" : Before frequency setup pulse
"BSAM" . Before sampling pulse
"ASAM" : After sampling pulse

"RTRG" : Ready for trigger signal
"ESWP" . End of sweep pulse

"MEAS" . Measurement sweep signal

Preset Value

"RTRG"

Target

Trigger output

Syntax

Param = app.SCPI.TRIGger.OUTPut.FUNCtion
app.SCPL.TRIGger.INPut.OUTPut.FUNCtion = "ESWP"

Related Commands

SCPI.TRIGger.OUTPut.POLarity
SCPI.TRIGger.OUTPut.STATe

Equivalent Softkeys

Stimulus > Trigger > Trigger Output > Function >{ Before Setup | Before
Sampling | After Sampling | Ready for Trig | Sweep End | Measurement }
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SCPIL.TRIGger.OUTPut.POLarity

Selects the polarity of the trigger output set

by the

Description .
SCPIL.TRIGger.OUTPut.FUNCtion command.
Type String (read/write)
"POSitive” : Positive polarity
Parameter . . .
"NEGative" : Negative polarity
Preset Value "NEG"
Target Trigger output
Param = app.SCPI.TRIGger.OUTPut.POLarity
Syntax

app.SCPI.TRIGger.INPut.OUTPut.POLarity = "NEG"

Related Commands

SCPL.TRIGger.OUTPut.FUNCtion
SCPL.TRIGger.OUTPut.STATe

Equivalent Softkeys

Stimulus > Trigger > Trigger Output > Polarity
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SCPIL.TRIGger.OUTPut.STATe

Description Turns ON/OFF the state of the trigger output.
Type Boolean (read/write)
Parameter True: trigger output ON

False:  trigger output OFF

Preset Value

False

Target

Trigger output

Syntax

Status = app.SCPI.TRIGger.OUTPut.STATe
app.SCPI.TRIGger.OUTPut.STATe = True

Related Commands

SCPI.TRIGger.OUTPut.FUNCtion
SCPI.TRIGger.OUTPut.POLarity

Equivalent Softkeys

Stimulus > Trigger > Trigger Output > Trigger Output
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Questionable Ripple Limit Channel 1
Status Enable Register
STAT:QUES:RLIM:CHAN1:ENAB
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Status Event Register
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Positive Transition Filter
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Negative Transition Filter
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114 "Header suffix out of range"

200 "Execution error"

211 "Trigger ignored"

213 "Init ignored"

220 "Parameter Error"

222 "Data out of range"

224 "Illegal parameter value"

201 "Invalid channel index"

202 "Invalid trace index"

203 "Invalid marker index"

204 "Marker is not active"

205 "Invalid save type specifier"

206 "Invalid sweep type specifier"
207 "Invalid trigger source specifier"
208 "Invalid measurement parameter specifier"
209 "Invalid format specifier"

210 "Invalid data math specifier"

214 "Invalid limit data"

215 "Invalid segment data"

216 "Invalid standard type specifier"
217 "Invalid conversion specifier"
218 "Invalid gating shape specifier"
219 "Invalid gating type specifier"
300 "Device-specific error"

302 "Status reporting system error"
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